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Preface

The Sun Enterprise SyMON 2.0 User’s Guide provides instructions on how to use the

Sun Enterprise SyMON™ system management solution. These instructions are

designed for a system administrator with networking knowledge.

Note – In the Sun Enterprise SyMON software, all alarm messages are displayed in

English.

Using UNIX Commands

This document may not contain information on basic UNIX® commands and

procedures such as shutting down the system, booting the system, and configuring

devices.

See one or more of the following for this information:

■ Solaris Handbook for Sun Peripherals

■ AnswerBook™ online documentation for the Solaris™ software environment

■ Other software documentation that you received with your system
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Typographic Conventions

Shell Prompts

TABLE P-1 Typographic Conventions

Typeface Meaning Examples

AaBbCc123 The names of commands, files,

and directories; on-screen

computer output

Edit your .login file.

Use ls -a to list all files.

% You have mail .

AaBbCc123 What you type, when

contrasted with on-screen

computer output

% su
Password:

AaBbCc123 Book titles, new words or terms,

words to be emphasized

Command-line variable; replace

with a real name or value

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be superuser to do this.

To delete a file, type rm filename.

TABLE P-2 Shell Prompts

Shell Prompt

C shell machine_name%

C shell superuser machine_name#

Bourne shell and Korn shell $

Bourne shell and Korn shell superuser #
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Sun Documentation on the Web
The docs.sun.com sm web site enables you to access Sun technical documentation

on the Web. You can browse the docs.sun.com archive or search for a specific book

title or subject at:

http://docs.sun.com

Sun Welcomes Your Comments

We are interested in improving our documentation and welcome your comments

and suggestions. You can email your comments to us at:

docfeedback@sun.com

Please include the part number of your document in the subject line of your email.
xxxi
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CHAPTER 1

Introduction

This chapter provides an overview of the Sun Enterprise SyMON™ version 2.0

product, its components and how they interact with one another.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

This chapter includes the following topics:

■ SyMON Overview

■ SyMON Architecture

■ SyMON Concepts

■ SyMON Monitoring Features

SyMON Overview

Sun Enterprise SyMON software is an open, extensible system monitoring and

management solution that uses Java™ software protocol and Simple Network

Management Protocol (SNMP) to provide an integrated and comprehensive

enterprise-wide management of Sun products and their subsystems, components,

and peripheral devices.
1



SyMON technology provides a solution to extend and enhance the management

capability of Sun’s hardware and software solutions.

SyMON Architecture

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

SyMON software comprises three component layers: console, server, and agent. It is

based on the manager/agent architecture, in which:

■ The console is the user interface which interacts with you to initiate management

tasks.

■ The server (manager) executes management applications and sends requests to

agents in order to perform management tasks on your behalf.

■ The agents (that are executing on the managed nodes) access the management

information, monitor local resources, and respond to manager requests.

The three component layers are depicted in FIGURE 1-1.

TABLE 1-1 SyMON Technology

Feature Description

System Management Monitors and manages the system at the hardware and operating

system levels. Monitored hardware includes boards, tapes, power

supplies, and disks.

Operating System

Management

Monitors and manages operating system parameters including load,

resource usage, disk space, and network statistics.

Application and

Business System

Management

Provides enabling technology to monitor business applications such

as trading systems, accounting systems, inventory systems, and

real-time control systems.

Scalability Provides an open, scalable, and flexible solution to configure and

manage multiple management domains (consisting of many

systems) spanning across an enterprise. SyMON software can be

configured and used in a centralized or distributed fashion by

multiple users.
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FIGURE 1-1 SyMON Component Layers

The major SyMON layers and their functionality and components are described

below.

SyMON Console Layer

You may have multiple consoles, serving multiple users, for the same SyMON

server. The consoles provide you with:

■ Visual representations of the managed objects (for example, hosts and networks)

■ The ability to manipulate attributes and properties associated with the managed

objects (for example, create alarm thresholds)

■ The ability to initiate management tasks (for example, dynamic reconfiguration)

The SyMON console layer is the interface between you and the other components of

SyMON software.

SyMON Server Layer

The server layer accepts requests from you through the console and passes these

requests to the appropriate SyMON agent. It then relays the response from the agent

back to you.

SyMON
console

SyMON
console

SyMON server

SyMON
agent

SyMON
agent

SyMON
agent
Chapter 1 Introduction 3



For example, if you want information on the number of users accessing a host, the

server layer receives this request from the console, and sends it to the SyMON agent

on that host. The SyMON agent finds the answer, sends it back to the server, which

passes on the information to you (through the console).

Similarly, if an error condition is created on one of the hosts, the agent on that host

sends notification of this error (an event) to the server, which forwards the

information to you (through the console) as an alarm.

In addition, this layer provides the SyMON console with a secure entry point to

interface with the SyMON agents.

The SyMON server layer includes five components (FIGURE 1-2):

■ SyMON server

■ Topology manager

■ Trap handler

■ Configuration manager

■ Event manager

FIGURE 1-2 SyMON Server Layer

The SyMON server component is the core of the SyMON server layer. It is based on

Java technology and is multithreaded, and it handles multiple data requests from

various SyMON users.

SyMON server layer SyMON
console

RMI

Configuration
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Topology
manager

Event
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Trap
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Remote
SNMP
agent

Local
SNMP
agent

SNMP SNMP

SNMP SNMP
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SyMON Topology manager provides services including the management of user

domains and the topology layout of managed objects.

The Trap handler is a centralized SNMP trap receptor that performs logging and

forwarding of traps to interested components. It is this server layer component that

is responsible for receiving all alarm notifications.

The SyMON Configuration manager provides security services to the SyMON server

and the SyMON agents.

The Event manager sends and receives event information from the SyMON agents.

These events can trigger alarms, which are forwarded to the console.

SyMON Agent Layer

The SyMON agent layer performs the actual information gathering, monitoring, and

management of objects on the nodes managed by the SyMON software. The SyMON

server layer interacts with the agent layer to gain access to the managed objects by

using SNMP.

SyMON agents are scalable, extensible, and SNMP-based. They monitor and manage

objects including hardware, operating systems, and applications by loading modules

that focus on a specific aspect of the system, as well as application health and

performance.

The SyMON agents use rules to determine the status of the managed objects. When

the conditions specified by a rule become true, the SyMON software then

automatically generates alarms or performs actions as specified in the rules.

SyMON Server Context

A SyMON server context is defined as the SyMON server layer and the agent layers.

When starting the console, you log into a particular SyMON server context. The

managed objects whose agents send information to that same SyMON server also

belong to the same SyMON server context.

A managed object can belong to the same SyMON server context or a remote

SyMON server context. (A managed object in a remote server context sends

information to a different SyMON server while a managed object in the same server

context sends information to the server host that is connected to your console.)

By default, the SyMON software manages an object in the same server context but

only monitors an object in a remote server context. For a precise definition of manage

and monitor, see the Glossary. For more information on the SyMON server context,

see Chapter 11.
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FIGURE 1-3 Console Logs Into a Server Context

SyMON Concepts

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The following concepts are fundamental to understanding Sun Enterprise SyMON

software:

■ Domains

■ Modules

■ Alarms and Rules

Domains

A domain is a hierarchical collection of resources that you want to monitor and

manage. The resources can include a complete campus, individual buildings, hosts,

networks, subnets, links, and so on. Each domain may consist of these resources,

which can be combined with other resources to form groups within a domain. Each

of these groups may contain additional groups of resources, providing a multilevel,

hierarchical domain.

SyMON
console

SyMON server

SyMON
agent

SyMON
agent

SyMON
agent

SyMON server

Server context 1 Server context 2
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You should create domains based on your business needs. You can create one or

more domains. For example, you may create a lab domain that contains all the lab

machines. Similarly, you may create an accounting domain that contains all the

machines used for accounting.

The SyMON software displays the domain and its members in a visual

representation (FIGURE 1-4).

The host, Payroll2 , belongs to the Building B group, which belongs to the

Payroll Servers 1 domain.

FIGURE 1-4 SyMON Main Console Window Showing a Domain and Its Members

Modules

Unlike most agents, the Management Information Base (MIB) provided by SyMON

agents is not implemented in a monolithic code that contains a wide variety of

functionality in a single program. Instead, SyMON software uses several

components, called modules, for each agent. Each module implements its own MIB.

Therefore, the SyMON agent MIB is the cumulative total of all the modules and their

individual MIBs (FIGURE 1-5).
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FIGURE 1-5 SyMON Agent MIB

SyMON modules monitor and manage the resources of systems, applications, and

network devices.

SyMON modules serve two purposes:

■ To monitor and notify you (through alarms) when error conditions occur

■ To monitor and notify you (through alarms) when performance tuning is required

For more information on alarms, see“Alarms and Rules” on page 8.

Each module consists of one or more properties that can be monitored on your

system. For example, one of the default modules loaded during SyMON installation

is the Kernel Reader. This module monitors kernel properties. These properties

include user statistics, disk statistics, file system usage, and so on.

Note – You can add or remove modules dynamically. This feature enables you to

customize the modules loaded on each agent (object), based on your need.

Alarms and Rules

SyMON software enables you to monitor your system with alarms of differing

severities. The thresholds that generate these alarms are defined in the modules.

SyMON software enables you to set the thresholds that trigger simple alarms.
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For example, one of the properties of the Kernel Reader module is the number of

user sessions. SyMON software enables you to set the threshold that generates the

alarm. For example, you may tell SyMON software to generate a critical alarm when

there are seven or greater user sessions. Similarly, you may also tell SyMON

software to generate only a cautionary alarm when there are five to six user sessions.

Although SyMON software is configured with default alarm conditions, you can set

and define your own alarm thresholds for simple alarms such as those based on the

simple rCompare (comparison) rule.

Complex rules also generate alarms. For example, one complex rule states that when

a disk is over 75 percent busy, the average queue length is over 10 entries and the

wait queue is increasing, then an alert alarm is generated. This rule combines three

conditions:

■ Percentage of the disk that is busy

■ Average queue length

■ Wait queue

Unlike simple rules, these complex rules are predefined and cannot be modified.

Consequently, you cannot set thresholds for complex alarms.

When an alarm is generated, SyMON software notifies you through the main

console window.

For more information on alarms, see Chapter 9. For more information on rules, see

Appendix D.

SyMON Monitoring Features

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Sun Enterprise SyMON software includes the following monitoring features:

■ Autonomous Agents

■ Main Console Window

■ Hierarchy and Topology Views

■ Process Viewer

■ Log Viewer

■ Physical View

■ Logical View

■ Graph

■ Security
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These are GUI-based features, except for autonomous agents. Security is both a

GUI-based and command-line feature.

Autonomous Agents

SyMON agents work autonomously by actively sampling key data on host systems.

These agents can be polled through SNMP get requests for the current status of the

monitored data.

When an agent gathers data for a monitored resource, it checks the data against the

alarm threshold set for the resource and determines whether the data values

constitute an alarm condition. If the monitored data meets the alarm threshold, the

agent performs the action associated with the alarm condition. Agents send

asynchronous messages (SNMP traps) to the SyMON server, which delivers

notification of the change in the status of the monitored data.

Main Console Window

SyMON software provides a main console window to depict, monitor, and interact

with your system. You can monitor multiple domains, spanning different locations,

through multiple console windows.

Hierarchy and Topology Views

SyMON software offers both hierarchy and topology views (for every domain) or

contents views (for every host). The hierarchy enables you to navigate through the

domain or host to find the object of interest. The topology view or contents view

displays the members of the object that is selected in the hierarchy. You may also

customize the topology view by adding a background or creating a connection

between objects.

Process Viewer

The process viewer enables you to view and select detailed information about

processes running on the selected host or node.
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Log Viewer

The log viewer enables you to view informational messages, including error

messages, about your host.

Physical View

The physical view provides you with photo-realistic front, back, and side views of

the host. With your mouse button, you can click on the individual components of the

host and see detailed information about that component. For example, you can click

on a board in a server, and see detailed information about that board, such as CPUs,

memory, and board temperature.

Note – Physical views are not available for all systems.

Logical View

SyMON software provides a logical view of the overall hardware configuration of

the host. Similar to the physical view, you can click on a single component and

obtain detailed information about that hardware component.

Note – Logical views are not available for all systems.

Graph

SyMON software enables you to create a two-dimensional graph of monitored

properties.

Security

The SyMON security feature authenticates user login and access control privileges

for SyMON users and groups. It offers security at the following levels:

■ Only valid SyMON users can use SyMON features.

■ It enables SyMON users to set security permissions at the domain, group, host,

and module levels.
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You can restrict access by setting different permissions. For example, one group of

users can see and modify properties on a host while a second group of users can

only see the host (with no modification privileges).

You can access SyMON security features from the Attribute Editor within the

SyMON software.

Getting Started With the SyMON
Software

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

After installing SyMON software, spend some time navigating through the various

windows and testing their functionality. By exploring and testing the software, you

will have a better understanding of how you can customize SyMON software to aid

in your system monitoring. See Appendix A.

If you prefer to set up your monitoring environment now, see Chapter 11 for

information on SyMON security.
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CHAPTER 2

Installing the SyMON 2.0 Software

This chapter describes the requirements your system must meet prior to installation

and explains how to install the Sun Enterprise SyMON™ version 2.0 product on

your system.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The following topics are discussed in this chapter:

■ System Requirements

■ SyMON Agent Supported Systems

■ Supported Operating Environments

■ SyMON Compatibility

■ Installation Packages

■ Pre-Install Information

■ To Install the SyMON Packages From the CD

■ To Install the SyMON Packages From the Web

■ To Set Up SyMON Components

■ Starting the SyMON Software

■ Exiting and Stopping the SyMON Software

■ Uninstalling the SyMON Software

System Requirements

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.
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The SyMON installation script enables you to install the console layer, the server

layer, and the agent layer separately or together. TABLE 2-1 lists the minimum disk

space requirements for the three SyMON layers.

Note – If you are installing all three SyMON layers on one machine, you must have

a minimum of 50 Mbytes of disk space available. This is not the sum total of the disk

space requirements for the individual SyMON layers, as the layers share some

common packages.

Note – Depending upon your system, disk space requirements may be different. Go

to the following web site for more information on SyMON disk space requirements:

http://www.sun.com/symon/ .

SyMON Agent Supported Systems

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

For the latest information on supported hardware platforms, go to the following web

site: http://www.sun.com/symon/ . The Config-Reader module is required for

hardware configuration information.

The Config-Reader and the Dynamic Reconfiguration modules are not supported on

all Sun platforms. All the other core SyMON modules are supported on Sun

platforms. For more information on supported platforms on SyMON core modules,

see Appendix C. For more information, go to the SyMON web site.

TABLE 2-1 Minimum Disk Space Required for the SyMON Installation

SyMON Layer Minimum Disk Space Required (Mbytes)

Server 45

Agent 25

Console 25
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Supported Operating Environments

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The following Solaris operating environments are supported with the SyMON 2.0

product:

■ Solaris 2.5.1 or subsequent compatible versions

■ Solaris 2.6 or subsequent compatible versions

■ Solaris 7 (32-bit and 64-bit versions)

Note – SyMON is only supported on SPARC platforms, not on X86 platforms.

SyMON Compatibility

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

SyMON software is compatible with:

■ Any simple network management protocol SNMP V1, V2c, and V2usec entities,

regardless of the operating environment and architecture

■ Solstice Enterprise Agents™ of Solaris 2.6 and 7 can be converted to subagents of

the SyMON agent

SyMON software does not offer:

■ Backward compatibility with the SyMON 1.x software

■ SunVTS™ support in the SyMON 2.0 software
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Installation Packages

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

TABLE 2-2 describes the core packages provided with the SyMON 2.0 software. Your

system may require more packages. Go to the web site: http://www.sun.com/
symon/ for more information.

These packages are located on the SyMON 2.0 Software CD or the SyMON web site

(http://www.sun.com/symon ). To install these packages, see the next section.

TABLE 2-2 SyMON 2.0 Core Packages

Package Name Description

SUNWescon SyMON Console package

SUNWesagt SyMON Agents package

SUNWesmod SyMON Agent modules

SUNWsycfd SyMON Config-Reader module for the core SyMON product1

1. The Config-Reader module for the core SyMON product supports the SPARCserver™ 1000 and 1000E, the
SPARCcenter™ 2000 and 2000E, and the Sun Enterprise™ 6x00/5x00/4x00/3x00.

SUNWesdb SyMON Database

SUNWescom SyMON Common Components

SUNWeshlp SyMON Help

SUNWesjp SyMON Additional Components

SUNWessrv SyMON Server

SUNWessa SyMON Server/Agent

SUNWesae /etc files needed by the Agent

SUNWesse /etc files needed by the Server
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Pre-Install Information

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The following table briefly lists some of the pre-requisite information that you

should have available before you install the SyMON software.

TABLE 2-3 Information Needed on SyMON Components Prior to Installing

Component Description

Install Make sure to remove all the Symon 1.x packages. For example, the

following packages must be removed: SUNWsye, SUNWsym,
SUNWsyrt , SUNWsys, SUNWsyu, SUNWsyua, SUNWsyub,
SUNWsyuc, SUNWsyud, SUNWsyue, and SUNWsyuf.

Components you

want to install

Server, Agent, Console, Help

Space needed in

/opt
Make sure you have enough space available in /opt . If not, make

more space or make a soft link to an area with more space from

/opt/SUNWsymon .

Permissions Make sure you have permissions to write into the /opt (or

/opt/SUNWsymon ) directory as root . You also need privileges to

run commands, such as chmod, in that directory.

Set up Component(s) you want to set up are: Server, Agent, Console.

Only components that have been installed can be set up.

Information needed

for server

Note that when you install the server, you do not need to have the

console on the same machine. Also, it helps if you have

information on the following: license key for the software, ports to

be used, seed to be used, and SyMON console help configuration.

Information needed

for Agent

Seed to be used. SyMON server host if server is not installed on

agent machine.

Information needed

for Console

None.

Information needed

for Addon

components

Add-on dependent data.
Chapter 2 Installing the SyMON 2.0 Software 17



SNMP Subagents

SyMON may conflict with port numbers that are used by legacy subagents. Systems

with Solaris 2.6 or Solaris 7 operating environments have two potential conflicting

processes in the following areas: snmpdx and mibiisa .

If you install the SyMON software using standard defaults, you may run into port

conflicts with these processes and you are not able to start the agent. To understand

the problem, refer to the agent.log file that displays error messages similar to the

following:

Note – View the log file with the command:

/opt/SUNWsymon/sbin/es-run ccat /var/opt/SUNWsymon/log/agent.log .

To resolve the problem, make one of the following changes:

■ Change the port numbers used by SyMON or turn off snmpdx and mibiisa . For

example, you can turn off snmpdx by using the following command:

■ Prevent snmpdx and mibiisa from starting the next time the machine is booted

to avoid conflicts at installation. To do this, rename the start-up script with the

following command to prevent the snmpdx daemon from starting the next time

the machine is rebooted:

SyMON Add-on Components

The SyMON install and setup scripts automatically install and set up any add-on

components that you may have available. However, note the following:

■ The core components must be installed before you can install a corresponding

add-on component.

error Nov 05 13:24:59 agent parsing error in base-agent.x(132):
error creating intraface: inet://:161/udp: address already in use
error Nov 05 13:24:59 agent *** aborting execution ***

# /etc/rc3.d/S76snmpdx stop

# mv /etc/rc3.d/S76snmpdx /etc/rc3.d/s76snmpdx
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■ The install script looks for add-on components in a sibling directory from the

directory you specified. If you are installing core components, make sure that they

are present in the directory you specified when you execute the inst-es
command. After the core components are installed, the inst-es script goes up

one directory and installs any package found in any subdirectory. These packages

must be set to include the SyMON software.

Note – You can get a listing of all packages related to SyMON that is currently

installed with the following command: pkginfo -c symon .

■ If an add-on package is already installed when found by the inst-es script, it is

skipped automatically. To re-install a package that is already installed, do the

following:

■ Remove the package manually using the pkgrm command.

■ Rerun the inst-es script to install the package.

■ The setup script calls any setup.sh scripts found in the

/opt/SUNWsymon/addons/*/sbin directory. Some of these scripts may require

confirmation to help identify the appropriate hardware platform. Your responses

determine if these add-on components are set up.

The uninstall program (es-uninst ) removes all packages that are part of the

SyMON software, including the add-on packages.

Note – To verify the packages that are removed, run the following command:

pkginfo -c symon . For more information on uninstalling SyMON, see

“Uninstalling the SyMON Software” on page 31.

Note – For more information, see ““Configuring a Legacy SNMP Agent as a

Subagent of a SyMON Agent” on page 270 and ““Configuring SyMON to Use

Different Port Addresses” on page 272.

Installing SyMON 2.0 Software

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.
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This section describes how to install, set up, and run your SyMON 2.0 software.

Follow the steps in the appropriate section, based on your installation platform.

The SyMON installation script enables you to install the SyMON console, server, and

agent layers separately, or in combination, depending on your system configuration.

Note – The coexistence of the SyMON 1.x and 2.0 software is not supported on the

same server. But you may have SyMON sessions running on different servers or

server contexts. For more information on server context, see Chapter 1 and

Chapter 11.

If you have SyMON 1.x packages installed on your system, the installation script

fails. You must remove all SyMON 1.x packages before installing SyMON 2.0

software.

Caution – The SyMON 2.0 installation script may overwrite SyMON 1.x files.

Consequently, you may lose your customized event rules. If you have modified

SyMON 1.x rules, then you must back up these rules before installing SyMON 2.0

software. Depending on where you modified your event rules, back up the

/etc/opt/SUNWsymon or /opt/SUNWsymon/etc directories.

If you have SyMON 2.0 components already installed on your system and they are

out of date with the new version of the installation package and files that you are

trying to install, then the install script prompts you to uninstall the previously

installed packages. You may do so by either confirming the prompt to uninstall

immediately and proceed with a fresh installation or quitting the current session and

uninstalling the necessary packages manually by using the es-uninst command,

and then proceeding with the installation.

Caution – After uninstalling the previous version of SyMON 2.0, be sure that the

/opt/SUNWsymon directory does not exist. If this directory exists, remove the

directory and all its contents before proceeding with the new installation.

If you are reinstalling SyMON and would like to restore to a clean state, do the

following:

- Make sure to move any custom configuration files that may have been created

within this directory during the previous sessions.

- Remove all subdirectories and files within the /var/opt/SUNWsymon directory by

using the following command: rm -rf /var/opt/SUNWsymon .

- Complete the installation and setup as described in this chapter.

- Then restore the moved files back to this location.

SyMON packages are automatically installed in /opt/SUNWsymon .

!
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If there is not enough disk space in the /opt/SUNWsymon directory to accommodate

the SyMON packages, then do the following:

● Create a symbolic link to any other file systems in which enough space is
available.

Caution – Install the SyMON agent on every monitored or managed host. In

addition, you must install a SyMON agent on your SyMON server host (even if you

choose not to run this agent). In the case where the agent is automatically installed

when installing the server, SyMON prompts you with a note stating that the agent is

also being installed.

▼ To Install the SyMON Packages From the CD

Note – Familiarize yourself with the following file on the CD before beginning your

installation: cdrom/cdrom0/ operating_environment/Core/INSTALL.README .

In addition to the Sun Enterprise SyMON 2.0 Release Notes, any late-breaking news

that develops concerning this software installation procedure will be placed at the

Sun Enterprise SyMON 2.0 web site: http://www.sun.com/symon .

1. Place the Sun Enterprise SyMON 2.0 CD into the CD-ROM drive.

2. Open a command window and (if you are not already superuser) become
superuser by using the su command.

3. Mount the CD-ROM.
■ If the CD-ROM drive is not already mounted, mount the drive and change to the

CD-ROM directory by typing:

■ If you are using the Volume Manager (vold ), type:

# ln -s / directory/SUNWsymon /opt/SUNWsymon

# mount -o ro -F hsfs /dev/dsk/c0t6d0s0 /cdrom
# cd /cdrom/

# cd /cdrom/symon_2.0
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4. Run the Sun Enterprise SyMON installation script.

An interactive menu is displayed that guides you through the installation procedure.

Then select the Sun Enterprise SyMON components (agent, server, or console) you

want to install.

Sun Enterprise SyMON packages are automatically installed in

/opt/SUNWsymon .

Note – The installation script automatically installs the Sun Enterprise SyMON

packages applicable for your system.

▼ To Install the SyMON Packages From the Web

Note – Before installing SyMON on your system, read the INSTALL.READMEfile on

the web site. These files provide additional information that help you during the

installation process.

1. Using your web browser, go to the SyMON 2.0 web site.

2. Type the user name and the password.

3. Click the mouse button on Download SyMON.

4. Follow the instructions on this web page and download your SyMON packages.

# ./inst-es

http://www.sun.com/symon/

Username:
Password:
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5. Become root , if you are not already, and run the SyMON installation script.

An interactive menu is displayed that guides you through the SyMON installation

procedure. You may now select the SyMON components you want to install.

▼ To Set Up SyMON Components

Note – If you use inst-es to install the SyMON software, the es-setup script is

run automatically for you. In this case, only execute Step 2 to edit the

/etc/nsswitch.conf file directly.

Complete the following steps after a successful installation of SyMON. If your

installation was unsuccessful, see “Uninstalling the SyMON Software” on page 31.

Note – If there is a potential conflict for port addresses, see “Configuring SyMON to

Use Different Port Addresses” on page 272 before completing the steps in this

section.

1. Open a command window and (if you are not already root ) become superuser.

2. If you are running the SyMON server for the first time, edit the
/etc/nsswitch.conf file. Be sure the groups entry has files as the first token.

3. Change to the directory that contains the SyMON setup script.

4. Run the setup script to set up the SyMON components.

# ./inst-es

groups:files nis

# cd /opt/SUNWsymon/sbin

# ./es-setup
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A set of questions guides you through the SyMON setup procedure. The setup script

finds the installed SyMON components on your system and enables you to set up

these components.

The setup script enables you to specify an existing user to be the SyMON

administrator. This user is added to the esadm and esdomadm groups.

SyMON Directories

After a successful SyMON installation, the following directories are created.

SyMON Licensing

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

SyMON software is free-of-charge to manage or monitor an individual object or

host.

SyMON software automatically creates a default domain consisting of one managed

object, the host where the SyMON server resides. You may manually configure the

SyMON software to make the managed host be another system; however, this is the

limit of free-of-charge use.

TABLE 2-4 SyMON Directories

Directory Description

/opt/SUNWsymon Root directory which contains the infrastructure and

applications of SyMON

/etc/opt/SUNWsymon Contains the init scripts for SyMON applications

/var/opt/SUNWsymon/LS Contains the log viewer run time information files

/var/opt/SUNWsymon/cfg Contains the snmpd.conf file which specifies the SNMP

MIB2 system

/opt/SUNWsymon/sbin Directory that stores command files
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A SyMON right-to-use license is required to create more than one domain and to

manage or monitor more than one host object. If you do not purchase a license, you

will not be able to manage or monitor any additional objects. For information on

purchasing a SyMON license, see the web site, http://www.sun.com/symon/ .

During the setup of the server component, you are given the opportunity to specify

a license token.

■ If you have a license token, you may enter it during setup.

■ If you do not have a license token, you may run the SyMON software without one

as described above. When you get a license token, you can install it using the

es-lic script.

Starting the SyMON Software

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

SyMON is started with the es-start utility. The syntax for this utility is:

Note – The SyMON processes are generally started in the background unless you

specify the -i option (valid for only one process in the interactive mode). The

console process is run in the foreground so it can be killed easily using Control-C.

# ./es-lic
  --------------------------------
  Enterprise SyMON License Program
  --------------------------------
What is your license token (q to quit) XXXX-XXXX-XXXX-XXXX-XX[X]
decrypt v5.11, Copyright (C) 1990-1997, Globetrotter Software,
Inc.
Licensed to Sun Microsystems
License key installed

# es-start - option(s)
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The choices for option(s) are listed in TABLE 2-5.

Note – You must be root to start any of the SyMON components except the

console.

If you need to pass any arguments to the processes being started, you can do so by

listing those arguments after these options. For example, if you wanted to start the

console and tell it to use port 2090, you would use this command.

▼ To Start the SyMON Software

1. Change directories to the /opt/SUNWsymon directory.

TABLE 2-5 Options for es-start

Option Definition

a Starts SyMON agent

c Starts SyMON console

e Starts SyMON Event manager

f Starts SyMON Configuration manager

h Prints this usage report

i Starts agent in interactive mode; valid only for one of the a, t , f , p,

and e options

p Starts SyMON Topology manager

s Starts SyMON server

t Starts SyMON Trap handler

A Starts All SyMON components except the console. Equivalent to

es-start -aefpst

S Starts SyMON server and all the server subcomponents

Equivalent to es-start -efpst

# es-start -c -- -p 2090

# cd /opt/SUNWsymon/
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2. Start the SyMON server and agents by typing:

3. Type es-start -c at the prompt to start the console.

Note – You do not have to be root to run the SyMON console.

The SyMON login panel (FIGURE 2-1) is displayed. See TABLE 2-6 for more information

on the login panel buttons.

FIGURE 2-1 SyMON Login Panel

4. Log in using a valid UNIX user account. This account must be listed in the
/var/opt/SUNWsymon/cfg/esusers file in the SyMON server machine.

Note – The user accounts, espublic and esmaster , should not be used.

5. Type the host name of the SyMON server in the Server Host field.

TABLE 2-6 lists the buttons in the SyMON login panel.

6. If you are not using the SyMON server default port addresses or want to set
console to SyMON server message security:

a. Click the Options button.

# ./sbin/es-start -A

# ./sbin/es-start -c
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b. Type the SyMON server RMI host port number in the Server Port Number
field.

See“To Reconfigure SyMON RMI Port Address” on page 275 for more

information.

c. Click the circle next to the appropriate security message option (FIGURE 2-2).

FIGURE 2-2 SyMON Login Options Dialog

These options allow you to choose among the following:

■ No Message Authentication: If you select this, only the user login is

authenticated. Messages between the console and the server are not verified for

authentication.

■ Console-to-Server Message Authentication: If you select this, the server verifies

the authenticity of the messages coming from the console. However, the

console does not verify the messages from the server.

■ Console-Server-Console Message Authentication: If you select this, both the

console and the server authenticate the messages coming from the other.

d. Click the OK button.

7. Check that you typed in all the information correctly in the Sun Enterprise
SyMON Login window (FIGURE 2-1).

8. Click the Login button in the Sun Enterprise SyMON Login window to log into
the SyMON software.

The message is displayed on the Current status line:

“Login successful. Launching console. ”

The SyMON main console window is displayed (FIGURE 2-3).
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FIGURE 2-3 SyMON Main Console Window

TABLE 2-6 lists the buttons in the login panel and their corresponding functions.

Exiting and Stopping the SyMON
Software

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

TABLE 2-6 SyMON Login Panel Buttons

Button Function

Login Enables users to open the SyMON application.

Help Displays the online help for this panel.

Options Displays a dialog box which enables you to specify the port number of the

SyMON server and the security scheme for console to SyMON server

messages.

Exit Exits Sun Enterprise SyMON.
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You exit the SyMON console through the main console window, and the server and

agent components through a shell window.

SyMON server and agent components are stopped with the es-stop utility. The

syntax is:

The choices for option(s) are listed in TABLE 2-7.

Note – You must be root to stop the SyMON server and agents.

▼ To Exit the SyMON Console

1. Select File ➤ Exit from the menu bar on the main console window.

The Exit Sun Enterprise SyMON dialog is displayed (FIGURE 2-4).

2. Click the Exit button to exit the application or the Cancel button to cancel your
request.

# /opt/SUNWsymon/sbin/es-stop  - option(s)

TABLE 2-7 es-stop option Choices

Option Definition

c Stops the SyMON console

s Stops the SyMON server

S Stops the SyMON server and all the server subcomponents (Trap

handler, Topology manager, Configuration manager, and Event

manager)

a Stops the SyMON agent

t Stops the SyMON Trap handler

p Stops the SyMON Topology manager

f Stops the SyMON Configuration manager

e Stops the SyMON Event manager

A Stops all the SyMON components except the console

h Lists the options for the es-stop utility
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FIGURE 2-4 Exit SyMON Dialog

▼ To Stop the SyMON Server and SyMON Agents

● Stop the SyMON agents and the SyMON server subcomponents by typing:

Uninstalling the SyMON Software

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The SyMON 2.0 software currently supports one method of removing software

packages.

Caution – The package removal procedure for the SyMON software is complex,

with packages requiring configuration information in order to function properly. Use

the es-uninst utility for accurate removal of the software.

▼ To Remove SyMON 2.0 Software

1. Type the following command.

# /opt/SUNWsymon/sbin/es-stop -A

# /opt/SUNWsymon/sbin/es-uninst
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2. Type y to uninstall SyMON, or n to cancel your request.

Caution – This utility does not enable you to remove SyMON packages selectively.

Once you type y, all the SyMON packages are removed. There is no additional

warning before package removal begins.

The contents of the /var/opt/SUNWsymon directory remain and are unaltered by

the uninstall script. The state of the SyMON domain configuration is retained for

subsequent installations or upgrades.
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CHAPTER 3

Using Domains

A domain is an arbitrary collection of resources that can include a complete campus,

individual buildings, hosts, networks, subnets, links, and so on. The organization of

a domain collection is in a hierarchy.

This chapter covers the following topics:

■ To Set a Home Domain

■ To Select Domain Manager

■ To Create Domains

■ Populating Domains

■ To Select a Domain

■ To Delete a Domain

■ To Set a Remote Domain

■ To Set Security for a Domain

Sun Enterprise SyMON can monitor a multitude of hosts. To enable you to perform

your monitoring tasks in an efficient manner, SyMON organizes hosts into groups.

The biggest (highest level) grouping is a domain. A domain is an arbitrary grouping

of hosts, subnets, networks, buildings, and so on.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

You can create one or multiple domains, each with an unique name. Each domain

consists of one or more members, arranged in a hierarchy. For example, you may

decide that a domain consists of all the hosts in one building. Or, you may decide

that a domain consists of all the hosts in a campus.

Note – Spend some time and think about how you want to organize your hosts into

different domains.
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Decide if you need additional groups below the domain to organize your hosts. For

example, if there are several hundred hosts, it is impractical to place your hosts

individually in one domain.

You may decide to break the domain into a set of smaller groups; for example,

campuses. The Headquarters domain might consist of several campus locations

(FIGURE 3-1).

FIGURE 3-1 Example Domain

Each of these campus locations may be broken into smaller groups; for example,

buildings. Similarly, each building may be broken into smaller groups; for example,

networks, subnets, and groups. Finally, each group comprises individual hosts.

In this particular example, the hierarchical order, from highest level to lowest level,

is domain, campus, building, network, subnet, group, and individual host. For

detailed information on creating domains, see “To Create Domains” on page 40.
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Starting SyMON

When starting the Sun Enterprise SyMON software for the first time, a dialog is

displayed (FIGURE 3-2) asking you to set a home domain. The home domain is the

domain that is always displayed whenever the SyMON console is started.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

FIGURE 3-2 Set Home Domain Dialog

During installation, a default domain (named after your server host) is automatically

created for you.

● Proceed with one of the following:

■ Select the default domain and click on the Set Home button. Your default domain

is set as your home domain and is displayed. For more information, see “To Set a

Home Domain” on page 36.

■ Select the default domain and click on the Go To button. The main console

window is displayed with this default domain.

The default domain consists of one object, your server host.
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■ If you want to explore the SyMON main console window, see Chapter 6.

■ If you want to explore SyMON monitoring features, see Chapter 7.

■ If you want to create additional domains, see “To Create Domains” on page 40.

■ If you want to create additional objects in your domain, see “Populating

Domains” on page 40.

▼ To Set a Home Domain

1. Proceed with one of the following:

■ Click the Set Home button (FIGURE 3-2) in the Set Home Domain dialog.

■ Select File ➤ Set Home Domain in the SyMON main console window (FIGURE 3-3).

FIGURE 3-3 SyMON File Menu

The Set Home Domain dialog (FIGURE 3-4) is displayed.

File menu
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FIGURE 3-4 Set Home Domain Dialog

2. Select the domain you want to set as your home domain.

The selected domain is highlighted.

3. Click the Set Home button.

You see the following message at the bottom of the Set Home Domain dialog.

When the home domain has been set, the message changes.

4. Click the Close button.

The SyMON main console window is updated and the home domain is displayed

(FIGURE 3-5).

At this time, you may want to populate your domain. See “Populating Domains” on

page 40 for more information.

Setting Home Domain...Please wait

Home domain successfully set.
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FIGURE 3-5 Home Domain

Creating Domains

The Sun Enterprise SyMON software enables you to create domains with the

Domain manager window.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

▼ To Select Domain Manager

● In the SyMON main console window, select File ➤ Domain Manager (FIGURE 3-3).

The Domain Manager is displayed (FIGURE 3-6).
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FIGURE 3-6 Domain Manager

Note – In the Domain Manager, some of the buttons are grayed out until you select

a domain.

TABLE 3-1 Domain Manager Buttons

Button Description

Add Displays the Create Domain dialog.

Security Displays the Attribute Editor with the security tab selected for the

highlighted domain.

Delete Deletes the selected domain and all its members.

Go To Updates the SyMON main console window to display the selected

domain. You may also “go to” a domain by double-clicking on it.

Reference Inserts the selected domain into the current domain.

Set Home Domain Sets the selected domain as the domain that is always displayed

whenever the SyMON console is started. See “To Set a Home

Domain” on page 36 for more information.
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▼ To Create Domains

1. Select File ➤ Domain Manager (FIGURE 3-3) from the SyMON main console
window.

The Domain Manager is displayed (FIGURE 3-6).

2. In the Domain Manager, click the left mouse button on Add.

The Create Domain dialog is displayed (FIGURE 3-7).

FIGURE 3-7 Create Domain Dialog

3. Type in the name of the new domain in the Domain Name field.

4. If you do not want your domain populated now, be sure the Populate Now check
box is turned off.

The default choice is for SyMON to display a dialog enabling you to start the

Discovery Manager immediately after creating a domain. For more information

about the Discovery Manager, see Chapter 5.

5. Click the Create button.

6. Create additional domains or populate your domain manually.

If you do not have the right security permissions to create a domain, an error

message is displayed. See Chapter 11 for more information on security.

Populating Domains

Once you have created your domain(s), you can begin to populate these domains

(and their subordinate groups). There are three methods to add hosts and other

resources to a domain collection:
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■ Populate with the Discovery Manager—see Chapter 5. Discovery Manager

searches the network for resources. This is the default method for populating a

newly created domain. The search can be time-consuming, but you can shorten

the search by setting limits.

■ Populate with the Discovery Manager at scheduled intervals by using the

Scheduling feature—see “Starting the Discovery Requests Window” on page 76.

You can set the search to occur hourly, daily, weekly, or monthly. This feature

enables you to search periodically for new managed objects on the network.

■ Manually populate with the Create New Objects menu—see Chapter 4. This

method enables you to add objects one at a time and is useful for adding a small

number of known resources. For example, if you have installed a new host, you

can use Create New Objects to add the host to the local domain immediately.

Managing Domains

Once you have created domains, you can manage them.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Selecting Domains

You can list domains through the Domain Manager window (FIGURE 3-6) or the Sun

Enterprise SyMON main console window.

▼ To Select a Domain

1. Proceed with one of the following:

■ Select File ➤ Domain Manager in the main console window (FIGURE 3-3).

■ In the SyMON main console window, click the left mouse button on the SyMON

Administrative Domains pull-down menu (FIGURE 3-8).

The current list of domains is displayed.
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FIGURE 3-8 SyMON Main Console Window with a List of Current Domains

2. Click the left mouse button on the domain you want to view.

The main console window is updated and displays the selected domain. The

SyMON Administrative Domains button changes to display the name of the domain

you have selected.

Deleting Domains

You must have the appropriate security permission to delete a domain. For more

information on SyMON security, see Chapter 11.

▼ To Delete a Domain

Caution – Deleting a domain also deletes all the members of that domain.

1. In the Domain Manager window, highlight the name of the domain you want to
delete.

2. Click the Delete button.

The Confirm Domain Deletion dialog (FIGURE 3-9 or FIGURE 3-10) is displayed.
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FIGURE 3-9 Confirm Domain Deletion Dialog

FIGURE 3-10 Confirm Domain Deletion Dialog for Current Domain
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3. Click Delete.

The Confirm Domain Deletion dialog displays the following message.

When the domain has been successfully deleted, the dialog is removed and the

Domain Manager updates the list of domains.

4. Click the Close button in the Domain Manager.

Monitoring Remote Domains

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Remote domains are domains created in a different SyMON server context. See

Chapter 11 for a description of server context.

If you are interested in an object in a different server context, you can still monitor
the remote resource by referencing the remote domain in your local domain.

However, you are not be able to manage the remote resource unless you log out of

your current SyMON server context and log into the remote SyMON server context.

You can manage monitored properties on a resource only if the SyMON agent on that

resource sends event management information to the SyMON server to which your

console is connected. By default, SyMON security gives you “read-only” privileges

for remote domains. For more information on SyMON security, see Chapter 11.

Note – You can reference a remote domain to monitor resources in that domain. You

cannot manage monitored properties on a remote resource.

For example, your current SyMON server context may be based in the Headquarters

domain. A second, remote SyMON server context may be based in Regional Office 1.

When workers are absent from Regional Office 1, system administrators in

Headquarters can monitor the regional office domains by referencing these remote

domains in the Headquarters server context. If an emergency occurs, administrators

in Headquarters can notify a Regional Office 1 administrator immediately.

Note – Remote domains enable you to monitor critical resources continuously.

Deleting domain...Please wait.
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Caution – Do not create a domain with a circular reference (to itself). The remote

domain which is being referenced should be at a lower level (for example, a

subdomain) than the domain which is creating the reference.

For example, do not create a domain (Domain A) which references another domain

(Domain B) which in turn, contains a reference to Domain A. Instead, reference a

subdomain in Domain B. That is, if Domain B contains Subdomain 2, then create a

reference between Domain A and Subdomain 2 (instead of Domain B).

▼ To Set a Remote Domain

1. In the SyMON main console window, select File ➤ Remote Domain Manager
(FIGURE 3-3).

The Remote Domain Manager dialog is displayed (FIGURE 3-11).

FIGURE 3-11 Remote Domain Manager

2. Type the name of the remote SyMON server in the Host field. If applicable, also
type the appropriate number in the Port field.

By default, the Topology manager is installed on the SyMON server on port 164.
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3. Click the List Domains button.

A list of domains on the remote SyMON server is displayed.

4. Click the domain you want to reference.

The selected domain is highlighted.

5. Click the Reference button.

The selected domain is created as a reference domain in the currently selected

domain in the SyMON main console window (FIGURE 3-12).

FIGURE 3-12 Referencing a Remote Domain

Attribute Editor for a Domain

The domain Attribute Editor provides additional information about the selected

domain and the rules governing its behavior. Use the Attribute Editor to edit

security information for the domain.

Note – Each Attribute Editor displays one or more tab buttons, depending on the

type of Attribute Editor. The Attribute Editor that is displayed is dependent on the

selected object.
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▼ To Set Security for a Domain

1. Proceed with one of the following:

■ Open the Attribute Editor for a domain by clicking the right mouse button on the

domain icon and highlight Attribute Editor from the pop-up menu in the

hierarchy view.

■ Select File ➤ Domain Manager in the main console window. Then select a domain

and click the Security button.

2. Click the Security tab (FIGURE 3-13).

3. Type the name(s) of user and administrator groups in the appropriate fields.

See Chapter 11 for more information.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE 3-13 Attribute Editor for a Domain
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CHAPTER 4

Objects

This chapter describes how to create and monitor objects.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

This chapter discusses how:

■ To Create a Group

■ To Create a Node

■ To Create a Module Object

■ To Create a Segment

■ To Connect Objects

■ To Copy an Object

■ To Copy a Group of Objects

■ To Modify an Object

■ To Cut and Paste Objects

■ To Delete Objects

Sun Enterprise SyMON objects represent parts (or nodes) of a network and include

hardware and software components such as hosts (workstations and servers),

printers, routers, modules, and so on. A segment of the network itself can even be an

object.

To monitor or manage an object, you create a node to represent it in a SyMON

domain or group. If the group does not yet exist, you must first create the group.

You can create and monitor or manage one or more domains containing nodes for

multiple objects (such as the workstations and other devices connected to the

server). For information about domains, see Chapter 3.
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Creating Groups

You can create two types of groups, General and IP-based. General groups are based

on geography (campus or building). IP-based groups are based on networks or

subnets.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

▼ To Create a Group

1. In the hierarchy view of the SyMON main console window, click the domain in
which you want the new group.

Select (by clicking) a location in the domain where the new group should be created.

For example, if you want to create a group in a building that is in one of the

campuses of a domain, then click the building icon in the domain.

2. In the SyMON main console window, select Edit ➤ Create an Object (FIGURE 4-1).
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FIGURE 4-1 Creating an Object

The Create Topology Object window is displayed (FIGURE 4-2).
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FIGURE 4-2 Creating a Group in the Create Topology Object Window

3. In the Create Topology Object window:

a. Change the Type field, if desired (General or IP-Based).

b. Select the object type (Building, Campus, or General).

The right side of the window is updated with an icon corresponding to the object

type.

c. Create a new group Label.

d. (Optional) Type a description in the optional Description field.
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e. For an IP-based group, specify the IP address and the subnet mask.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

If you selected OK or Apply, this message is displayed at the bottom of the Create

Topology Object window:

If the request ends successfully, the SyMON main console window is updated and

the group is displayed.

If the request fails, an error message is displayed at the bottom of the Create

Topology Object window. The cause of the error may be that you do not have the

right permission to create this group.

If you want to make any changes to the new group, see “Modifying Objects” on

page 67.

5. Add components to your group:

■ Use the Create Topology Object window. See “To Create a Node” on page 54.

■ Copy and paste objects from other groups into the new group. See “Copying

Objects” on page 65.

Creating a Node

You create nodes through the Edit pull-down menu in the Sun Enterprise SyMON

main console window.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Creating group... Please Wait.
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▼ To Create a Node

Note – A domain must exist before you can create a node. To create a domain, see

“To Create Domains” on page 40.

1. In the hierarchy view of the SyMON main console window, select the domain in
which you want to create the new object.

Select the lowest level group of the domain where the new object should be created.

For example, if you want to create a node in a building that is in one of the

campuses of a domain, then select the building in the domain as the lowest level

group.

2. In the SyMON main console window, select Edit ➤ Create an Object (FIGURE 4-1).

The Create Topology Object window is displayed. By default the tab is set to Group.

3. Click the Node tab in the Create Topology Object window.

The window changes to display settings available for nodes (FIGURE 4-3).
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FIGURE 4-3 Create Topology Object Window—Node Tab
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4. In the upper half of the Create Topology Object menu, set up the new node:

a. Click the Monitor Via button to see the pull-down menu, then select the
software or agent to monitor the new node.

There are six categories of agents and monitors (TABLE 4-1). If an agent is not

available for your selected object, SNMP Ping usually works. If you do not select

an available agent or ping command, the creation fails.

TABLE 4-1 Types of SyMON Monitoring

Type Description Effect

SyMON Agent

– Host

Monitor and manage a host that has an

active SyMON agent that is installed and

running.

The status of the SyMON Agent on the host can

be monitored. The Details window of the

SyMON Agent Host contains tabs such as Info,

Browser, Alarms, and so forth. The Entity

Polling Type in the Info tab is ahost .

SyMON Agent

– Module

Monitor and manage a module that has

an active SyMON agent that is installed

and running.

The status of the SyMON Module on the agent

host can be monitored. The Details window

contains Info and Browser tabs. The Entity

Polling Type in the Info tab is amod.

SNMP Proxy Monitor and manage the device through

a SyMON agent that is running a

SyMON proxy module for that device.

(The proxy module must have been

previously loaded into the SyMON agent

by using the Load Module dialog. See

Chapter 8.) Communication between the

SyMON Topology manager and the

SyMON agent is SNMPv2 usec.

Communication between the SyMON

agent and the remote device is SNMPv1

or SNMPv2, depending on the proxy

module.

The Proxy Monitoring module data can be seen.

The Details window contains the Info and

Browser tabs. The Entity Polling Type in the

Info tab is aprox .
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b. If applicable, select a type from the pull-down menu in the Type field.

The list of choices varies widely according to the type of monitoring you selected

in the previous step.

c. If applicable, scroll and select an object in the Create Topology Object window.

For some types of monitoring, the right side of the Create Topology Object

window displays the set of icons for the object you have selected. The icons are

displayed in the hierarchy and topology views in the SyMON main console

window when the node is created.

d. Create a unique new name in the Node Label field.

e. (Optional) Type a description of the node.

SNMP Ping Monitor the device by using SNMP ping
command. The SyMON Topology

manager communicates with the device

using SNMPv1. (There are no

management capabilities provided for

devices monitored by the SNMP ping
command.)

The availability of the SNMP agent on the

device can be monitored. The Details window

contains only the Info tab. The Entity Polling

Type in the Info tab is snmp.

ICMP Ping Monitor the device by using the Internet

Control Message Protocol (ICMP) ping
command. (There are no management

capabilities provided for devices

monitored by the ICMP ping
command.)

The accessibility of the device can be monitored.

The Details window contains only the Info tab.

The Entity Polling Type in the Info tab is ping .

Non-Monitored Created node is for display only. Its

status is not monitored.

No aspects of the device are monitored. The

Details window contains only the Info tab. The

Entity Polling Type in the Info tab is dummy.

TABLE 4-2 Choices Available in the Type Pull-Down Menu

Monitor by
SyMON Agent -
Host

SyMON Agent -
Module SNMP Proxy SNMP Ping ICMP Ping Non-monitored

Type Workstation,

Server,

Local Module Router,

Concentrator,

Workstation,

Printer,

PC,

Server

Router,

Concentrator,

Workstation,

Printer,

PC,

Server

Router,

Concentrator,

Workstation,

PC,

Server

Printer,

Workstation,

Router,

Concentrator,

Server,

PC

TABLE 4-1 Types of SyMON Monitoring (Continued)

Type Description Effect
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5. In the lower half of the Create Topology Object window, type the requested
information.

The questions in the lower half of the window vary with the agent or monitor that

you selected in Step a, above. The Non-Monitored selection does not require further

information, but most agent or monitor selections ask you to enter:

■ Node host name

■ Node IP address

You can enter either the host name, the IP address, or both. If there is a conflict

between the host name and the IP address, the host name takes precedence.

Other agent or monitor selections may also ask for one or more of the following:

■ SyMON agent port number (the default is 161)

■ Proxy host name and IP address

■ Read/write SNMP communities

■ Module name

6. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

This message is displayed at the bottom of the Create Topology Object window:

■ If the request is completed successfully, the SyMON main console window is

updated and the new node is displayed.

■ If the creation fails, an error message is displayed at the bottom of the Create

Topology Object window. The cause of the error may be that you do not have the

right permission to create this node, or that you must start a SyMON agent on the

node.

Note – If you are connected to one SyMON server context and create a node on

another SyMON server context, ownership of the new node on the second server

context defaults to the espublic identity instead of your login identity. This

situation is normal. The espublic identity is imposed for security of transactions

between SyMON server contexts. For more information, see Chapter 11.

If you want to make any changes to the new node, see “Modifying Objects” on

page 67.

Creating Node... Please Wait.
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Creating a Monitored Module Object

If you want to monitor one or more module objects on a number of hosts, you may

find it useful to create module objects for each host and place all of the modules in a

common location (that is, in the same group or domain). The procedure for creating

a module object is similar to that for creating a node.

▼ To Create a Module Object

1. In the hierarchy view of the SyMON main console window, select the domain in
which you want to create the new object.

2. In the SyMON main console window, select Edit ➤ Create an Object (FIGURE 4-1).

3. Select the Node tab in the Create Topology Object window.

4. Select SyMON Agent – Module in the Monitor Via field (FIGURE 4-4).
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FIGURE 4-4 Create Topology Object Window for SyMON Agent – Module

5. Type a node label.

6. (Optional) Type a description.

7. Type a host name or IP address.

You can enter either the host name, the IP address, or both. If there is a conflict

between the host name and the IP address, the host name takes precedence.

8. If necessary, change the port number.
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9. Click the List Modules button to display a list of modules that are currently
loaded on the host.

If the module that you want to use is not loaded, see “To Load a Module” on

page 184. If the module that you want to use is not enabled, see “To Enable a

Module” on page 195.

The module list is displayed (FIGURE 4-5).

FIGURE 4-5 Module List

10. Select the module that you want to monitor and click OK.

The module list closes.

11. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Cancel to cancel your request.
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Creating Segments

To complete your view of a domain, you can include segments of the networks

linking the nodes in the domain.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

▼ To Create a Segment

1. In the SyMON main console window:

a. In the left window, select a location in the domain where the new segment
should be created.

The segment is created at the selected (highlighted) level.

For example, if you want to create a segment in a building that is in one of the

campuses of a domain, then select the building in the domain.

b. In the SyMON main console window, select Edit ➤ Create an Object
(FIGURE 4-1).

The Create Topology Object window is displayed (FIGURE 4-2).

2. In the Create Topology Object window:

a. Click the Segment Tab (FIGURE 4-6).
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FIGURE 4-6 Segment Tab in the Create Topology Object Window

b. Change the Type field, if desired (Bus or Ring).

c. Select the object type.

The list of choices (Ethernet, IPX, or FDDI) changes with your selection in the

Type field.

At the right in the Create Topology Object window is a window which displays

large and small icons corresponding to the type of object you have selected. The

icons are displayed in the topology view in the SyMON main console window

when the segment is created.
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d. Type a new segment label.

e. (Optional) Type a description in the Description field.

f. Type the IP address for this segment.

g. Type a subnet mask for this segment.

3. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

This message is displayed at the bottom of the Create Topology Object window:

If the request is completed successfully, the Create Topology Object window closes.

The SyMON main console window is updated and the view is displayed.

If the request fails, an error message is displayed in the Create Topology Object

window.

If you want to make any changes to the new segment, see “Modifying Objects” on

page 67.

Connecting Objects

You can connect objects in the topology view.

▼ To Connect Objects

1. Select two objects in the topology view.

2. Select Edit ➤ Create a Connection.

A link is displayed between the objects.

Creating segment... Please Wait
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Copying Objects

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

To move an object from one location in the topology view to another, use the Edit

commands, Cut and Paste .1 To copy an object into other topology views (leaving

the original object in its current location), use Copy instead of Cut .

For example, you can create a domain that contains some of the objects that already

exist in another domain. To do this, create a new domain (see Chapter 3), then copy

existing objects into the new domain as described in the following procedure.

You can also copy a group (an object that contains other objects). In this case, the Sun

Enterprise SyMON software does not create an independent, completely new group.

Rather, it creates a symbolic link to the existing group. Thus every copy is a different

“view” of the same group.

For more information on the SyMON main console window, see Chapter 6.

Note – The copy, cut, and paste functions are available in the topology view. The

copy and cut functions are also available in a pop-up window by clicking with your

right mouse button on the object.

▼ To Copy an Object

This procedure is for a single object. To copy a group, see “To Copy a Group of

Objects” on page 66.

1. In the SyMON main console window, select the existing object in the topology
view.

Note – You can select multiple objects by using the mouse button while holding

down the Shift key.

1. SyMON 2.0 does not support drag and release as an operation for moving objects.
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2. At the top of the SyMON main console window, select Edit ➤ Copy in the
pull-down menu.

This message is displayed at the bottom of the SyMON main console window:

3. Open the destination group or domain.

The destination group is displayed in the topology view.

4. At the top of the SyMON main console window, select Edit ➤ Paste.

The pasted object is displayed in the destination group or domain, and this message

is displayed at the bottom of the SyMON main console window:

▼ To Copy a Group of Objects

To copy objects that are in one group and paste the copies into another group:

1. In the topology view, select the objects to be copied.

To copy all objects in the topology view, select Edit ➤ Select All in the main console

window menu bar.

To copy two or more objects selectively:

a. Click the first object to select it.

b. On the keyboard hold down the Shift key and click one or more additional
objects.

2. Select Edit ➤ Copy in the main console window menu bar.

When the objects are copied, this message is displayed at the bottom of the SyMON

main console window:

3. In the hierarchy view, select (highlight) the new group or domain where the group
is to be copied.

Copy successful

Paste successful

Copy Successful
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4. Select Edit ➤ Paste Into in the main console window menu bar.

Alternatively, you can click with your left mouse button on the destination domain

and select Paste Into from the pop-up menu.

Caution – If you select Edit ➤ Paste (instead of Edit ➤ Paste Into), the objects may

be pasted into the wrong group. If this occurs, highlight the duplicate objects and

select Edit ➤ Delete Object/Connection.

Note – When you copy a group in the SyMON software, the new copy (a symbolic

link) is labelled with italic font. The italic font is a reminder that this is a link. If you

add or remove objects from this group, the original group and all copies of the group

are affected.

Note – An object in the cut (pre-move) state remains visible—and selected with

dashed lines—until it has been successfully pasted. If you change your mind and no

longer want to paste the object, you can remove it from the cut state by clicking on it

a second time.

Modifying Objects

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Once you have created or copied an object, you can change various attributes

through the Modify Object window. The changes affect only the description of the

object (in the Sun Enterprise SyMON server database) and do not modify the object

itself.

▼ To Modify an Object

1. Select the object in the SyMON main console window.
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2. Select Edit ➤ Modify in the SyMON main console window.

The Modify Object window is displayed (FIGURE 4-7). (The appearance of the

window varies widely, depending on whether the object is a group, node, or

segment.)

FIGURE 4-7 Modify Object Window—Example

3. Edit the attributes as needed.

For a group object the available attributes are:

■ Type: General or IP-Based

■ Object: Building, Campus, or General

■ Group Label
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■ Description

■ IP Address (for IP-Based only)

■ Subnet Mask (for IP-Based only)

For a node the available attributes are:

■ Monitor Via: SyMON Agent - Host, SyMON Agent - Module, SNMP Proxy, SNMP

Ping, ICMP Ping, or Non-Monitored

■ Type: Printer, Workstation, Router, Concentrator, Server, PC, or As Is

■ Object: (varies according to Type, above)

■ Node Label

■ Description

■ (Additional attributes may be listed, depending on the type of node.)

For a segment the available attributes are:

■ Type: Bus or Ring

■ Object: Ethernet, IPX, or FDDI

■ Segment Label

■ Description

■ IP Address

■ Subnet Mask

4. Click OK to save your changes, or Cancel to leave the attributes unchanged.
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Cutting and Pasting Objects

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Objects can be cut (to be moved) or deleted (permanently) from the topology view in

the Sun Enterprise SyMON main console window. An object that is cut is

temporarily saved in memory and can be immediately pasted into one or more

areas1. An object that is deleted cannot be recalled. For instructions on deleting

objects, see “Deleting Objects” on page 72. For more information about the SyMON

main console window, see Chapter 6.

Cut and paste functions work the same for all kinds of objects (hosts, modules, and

groups).

Caution – Do not use the cut function to delete objects. This function should only

be used to move objects. To delete an object, use Edit ➤ Delete in the SyMON main

console window. See “Deleting Objects” on page 72.

▼ To Cut and Paste Objects

1. Select an existing object in the topology view.

If you have not selected an object, the Cut and Delete functions are grayed out.

2. Select Edit ➤ Cut (FIGURE 4-8) in the SyMON main console window.

A dashed line is displayed around the selected object. (The object does not

immediately disappear. This allows objects, such as processes which should not be

interrupted, to continue running until they are pasted into a new location.) The

object remains visible until it has been successfully pasted.

Note – You can cancel a Cut operation by clicking on the object a second time.

1. SyMON 2.0 does not support drag and release as an operation for moving objects.
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FIGURE 4-8 Cut, Copy, and Paste Options

If the Cut operation succeeds, the object is removed, and this message is displayed at

the bottom of the SyMON main console window:

3. Navigate to the destination location in the topology view.

4. Select Edit ➤ Paste. The object is displayed in this location and is removed from
the previous location.

Cut successful
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Deleting Objects

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The Edit ➤ Delete command removes an object completely. To move an object to

another location, see “To Copy an Object” on page 65 or “To Cut and Paste Objects”

on page 70.

For more information on the SyMON main console window, see Chapter 6.

▼ To Delete Objects

Note – To delete a domain, use the delete command in the Domain Manager

window; see “Deleting Domains” on page 42.

1. Select an existing object in the topology view.

If you have not selected an object, the Delete function is grayed out.

2. Select Edit ➤ Delete Object/Connection from the top of the SyMON main console
window (FIGURE 4-9).

You are prompted to confirm or cancel the deletion.

If the Delete operation succeeds, the object is removed, and this message is

displayed at the bottom of the SyMON main console window:

Delete successful
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FIGURE 4-9 Delete Option
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CHAPTER 5

Discovery Manager

You can use the Discovery Manager to populate automatically domains that you

have created. For example, automatically populating domains is very useful if you

have a large network. To add members manually with the Create Topology Object

window, see Chapter 4.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The following topics are covered in this chapter:

■ To Start the Discovery Requests Window

■ To Initiate a Discovery Request

■ To Customize a Discovery Request

■ To Modify a Discovery Request

■ To Start, Stop, or Delete a Discovery Request

The Discovery Manager can find or “discover” hosts, routers, networks, and subnets

(see “IP Routing” on page 351) in a local server context. The Discovery Manager

cannot discover objects where a SyMON agent is configured to a different server

context (see “SyMON Server Context” on page 256).

You can create one or more discovery requests. Each request runs as a separate

process and populates the domain with the objects that it has discovered.

You can also schedule requests to run periodically and look for new hosts.
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Starting the Discovery Requests Window

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

▼ To Start the Discovery Requests Window

Start the Discovery Requests window in one of three ways:

■ When you create a domain in the Create Domain dialog (FIGURE 3-7) the Populate

Now option is selected by default.

If you click Create in the Create Domain dialog while the Populate Now option is

selected, a dialog window enables you to start the discovery process immediately.

For more information on creating domains, see Chapter 3.

■ Select the domain in the SyMON Administrative Domains pull-down menu.

■ Select Tools ➤ Discover in the SyMON main console window (FIGURE 5-1).

FIGURE 5-1 Tools Pull-down Menu

The Discovery Requests window is displayed (FIGURE 5-2).

Pull-down menu
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FIGURE 5-2 Discovery Requests Window
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The Discovery Requests Window displays information containing the fields in

TABLE 5-1.

The Discovery Requests window has the buttons listed in TABLE 5-2.

TABLE 5-1 Discovery Requests Window Fields

Field Description

RequestId A number assigned by SyMON to the discovery request for tracking

purposes

Name A unique name which you create for the request

Scheduled “Yes” if the request is scheduled, “No” if not scheduled

Status Reflects the current state of the discovery request. The states may

be:

1. New. A new request was added but has never been processed.

2. Queued. A request has been sent to the SyMON server but

processing has not yet started.

3. Running. The request is currently being processed.

4. Succeeded. The request has been successfully processed.

5. Failed. Processing of the request has failed.

6. Stopped. The user has stopped the process.

7. 0 Host found. The request did not find any hosts that passed the

filter limits.

TABLE 5-2 Discovery Requests Window Buttons

Button Description

Add Click this button to create a new Discovery Request through the

New Discover Request window (FIGURE 5-2).

Modify Select a Discovery Request and click this button to make changes.

Duplicate Select a Discovery Request and click this button to create a copy of

the request.

Delete Select a Discovery Request and click this button to delete the

request.

Start Select a Discovery Request that is not running and is not scheduled

to run at a different time, and click this button to start the request.

Stop Select a Discovery Request that is running and click this button to

stop the request.

Log Select a Discovery Request and click this button to see a log of the

results generated from the selected discovery request runs.
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Initiating a Discovery Request

You can discover hosts using the ping command or by using routing tables.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Note – Currently the Discovery feature is supported only for domains and not for

any subordinate groups. You can add requests only for a domain.

Note – Read Appendix E before initiating a discovery request using routing tables.

Appendix E explains the basic concepts of routing, network classes, and netmasks.

▼ To Initiate a Discovery Request

1. Click the Add button in the Discovery Requests window.

The New Discover Request window is displayed (FIGURE 5-3). The Discover tab is

highlighted by default.

Tip – You can copy an existing discovery request by highlighting the existing

request and clicking the Duplicate button. To edit the settings for the new discovery

request, see “Modifying a Discovery Request” on page 89.
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FIGURE 5-3 New Discover Request Window

2. (Optional) Type a new name for your discovery request in the Request Name
field.

Multiple requests are listed in the Discovery Requests window, enabling you to

select a request and edit the related search pattern.
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3. In the Discover Using field, select the method that should be used for discovering
the network (Ping or Routing Table).

■ If you selected Ping, type the start and end IP addresses and netmask (FIGURE 5-3).

The discovery process uses the Ping command and searches for hosts and routers

in the specified IP address range. It then places the hosts in the appropriate

networks and subnets based on the netmask.

■ If you selected Routing Table, type the number of hops (the number of routers a

packet goes through before reaching its destination).

The discovery process starts from the Topology manager/SyMON server host and

goes through the specified number of hops to report subnets and hosts N hops

away. The number of hops limits the “distance” of destination hosts from the host

on which the Topology manager or SyMON server is running.

Note – Routing Table discovery requests require that you run an SNMP agent at

port 161. This can be a SyMON agent, snmpdx , or any SNMP agent provided by

your network management package.

For more information on routing tables, see Appendix E.

4. Click the OK button to start the discovery process, or go to the other tabs in this
window to customize your discovery request. See “Customizing Your Discovery
Request” on page 82.

When you start the discovery process:

■ The discover process discovers all nodes that are running the SyMON 2.0 agent,

when the nodes are all located in the same SyMON server context. The discovery

process does not include SyMON agent nodes that belong to another SyMON

server context. That is, nodes that running SyMON agents in a remote SyMON

server context are ignored.

■ Nodes that are not running a SyMON agent are listed as ping hosts.

■ The discover process discovers all nodes running an SNMP agent, where the

nodes are not connected to any SyMON server. The information gathered for

SNMP agents is very limited.

Note – Each discovery request is assigned a Request ID. This ID is an unique

SyMON internal identifier of the request. Therefore, the Request IDs are not in

sequential order.

Note – If a host is extremely busy, a discovery process that is gathering data for that

host may time out. If a timeout occurs for a host which is a SyMON agent, the host

is reported incorrectly as a ping host.
Chapter 5 Discovery Manager 81



5. If a SyMON server or agent is incorrectly reported to be a ping host:

a. Delete the icon with the Edit ➤ Delete Object/Connection function in the
SyMON main console window.

b. Create a new icon, by one of two methods:

■ Re-run discovery with larger timeout and retry values.

■ Add the icon manually by creating a node. See “Creating a Node” on page 53.

Customizing Your Discovery Request

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

You can customize your new discovery request by clicking on one of the four tabs on

the Discover Requests window. The tabs are labelled Discover, Preferences, Filters,

and Scheduling. TABLE 5-3 summarizes the tabs and the options for these tabs. (If you

want to change an existing Discovery Request, see “Modifying a Discovery Request”

on page 89).

TABLE 5-3 Summary of Discovery Variables

Variable Definition

Discover

Request Name Descriptive name for this request, for example, “My Lab.” This name is

optional.

Discover Using Ping: Sweeps all addresses within the range specified by Start IP Address

and End IP Address. Alternatively, you can supply the value of the

netmask and let the Discovery Manager calculate the end address, using

Start IP Address and End IP Address.

Routing Table: Discovery Manager consults the routing table of the

SyMON server and determines its address, subnet address, and router(s).

It proceeds from there to discover more routers, networks and subnets.

Start IP Address

End IP Address

These parameters apply to ping discovery requests. They specify the

address range within which the Discovery Manager tries to find hosts and

routers.
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Netmask This parameter applies to ping discovery requests. It is used to segment

networks into subnets. If you supply the netmask but not the end IP

address, the subnet address is calculated, and the end address is set to the

last address within that subnet.

To find out if your network is subnetted and the value of the netmask,

check the /etc/netmasks file or the name service maps if you are using

NIS (network information service) or DNS (domain name service).

Port Port 161 is the default setting for SyMON objects. The Discovery Manager

also tries an alternate port that you can specify in the Also Check Port

field. If neither port responds, the Discovery Manager concludes that the

object is not running a SyMON agent.

Preferences

Logging

Log discover request progress? Setting this flag enables logging for that request. The discovery process

places the log files in the /var/opt/SUNWsymon/cfg/discover
directory. There is one log file per user-domain. Currently, this directory is

used for debugging only.

PING

Timeout (sec.) Amount of time (in seconds) that the Discovery Manager should wait for a

response to a ping request before timing out.

Retries Number of times the Discovery Manager should send a ping request

before giving up.

SNMP

Timeout (sec.) Amount of time that the Discovery Manager should wait for a response to

a SNMP request before timing out.

Retries Number of times the Discovery Manager should attempt a SNMP request.

Community String One or more strings separated by the pipe (|) character. The default value

is public.

General

Maximum Hosts Maximum number of hosts that should be discovered.

Maximum Time (sec.) Maximum amount of time (in seconds) of the discovery process in real

time.

TABLE 5-3 Summary of Discovery Variables (Continued)

Variable Definition
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▼ To Customize a Discovery Request

You can specify limits for the New Discover Request window through the

Preferences and Filters tabs. You can also schedule the New Discover Request to run

periodically through the Scheduling tab.

1. Click the Preferences tab.

The New Discover Request Preferences window is displayed (FIGURE 5-4).

Filters

Criteria

Select Filter Criteria

Host Names

Operating System

Platform Type

Filter by host name, operating system, or platform type. Filtering uses the

grep command to search for the supplied value.

Filters This field remains blank until you select a filter criteria. The contents of

this field vary according to your selection(s). You can choose to either

include or exclude values in the filtering process. For host names, you

specify names and wildcard characters. For operating systems and

platform types, you select from pull-down menus.

Scheduling

Scheduling

Discover new hosts periodically? If selected, then the specified discovery request is scheduled to run at the

specified start time and frequency.

Settings

Start Time (hh:mm) Specify the time (between 00:00 and 23:59) when discovery should be

started.

Frequency In the pull-down menu, select Hourly, Daily, Weekly, or Monthly.

Day of Week In the pull-down menu, select the day when discovery should run.

Day of Month (1..31) Specify the (numerical) day of the month when discovery should run. You

cannot enter a day unless you have selected Monthly as the frequency.

TABLE 5-3 Summary of Discovery Variables (Continued)

Variable Definition
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FIGURE 5-4 New Discover Request Preferences Window

2. Type your selections in the Logging, PING, SNMP, and General fields.

TABLE 5-3 lists the variables in the New Discover Preferences window.
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3. Click the Filters tab.

The New Discover Request Filters window is displayed (FIGURE 5-5).

FIGURE 5-5 New Discover Request Filters Window
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4. Click one or more boxes for host names, operating system, or platform type.

By default, the Filters area is blank. As you select each box, the Filters area adds new

fields. These fields enable you to include or exclude items in the discover search, and

to specify the host names, operating systems, and platform types to be included or

excluded.

5. Click the Scheduling tab.

The New Discover Request Scheduling window is displayed (FIGURE 5-6).
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FIGURE 5-6 New Discover Request Scheduling Window

6. If you want to schedule automatic discoveries, click the button for Periodically
discover new hosts?, and customize the settings in the Settings area of the
window.
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Note – If you select 30 or 31 for day of the month, the Discovery Manager will not

perform a search in February.

7. When you have finished your edits, click OK to save the new discovery request, or
click Cancel to cancel your changes.

If you click OK and you have not selected Periodically discover new hosts in the

Scheduling tab, a pop-up dialog is displayed, offering several choices for running

the new discovery request.

■ To save the discovery request and begin running it periodically at the scheduled

times, click Yes.

■ To save the discovery request, but not schedule it to run, click No.

■ To cancel the new discovery request without saving it, click Cancel.

8. Click Close to exit the window.

Modifying a Discovery Request

If you have previously created a periodic discovery request, you can change the

search patterns for that discovery request through the Discovery Requests window

(FIGURE 5-2).

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

▼ To Modify a Discovery Request

1. Select Tools ➤ Discover in the SyMON main console window (FIGURE 5-1).

The Discovery Requests window is displayed.

2. Find and select the name of the discovery request you want to modify.

3. Click the Modify button.

The Edit Discover Request window is displayed. As confirmation, the top bar of the

window displays the ID of the request and the Description field displays the name

of the request.

4. Select the Discover, Preferences, Filters, and Scheduling tabs and in turn, change
settings as needed.
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5. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Cancel to cancel your request.

If you click OK, a pop-up dialog is displayed, offering several choices for running

the new discovery request.

6. Exit from the window:

■ To start the discovery request and run it immediately, click Yes.

■ To schedule the discovery request, but not run it immediately, click No.

■ To cancel the running of the discovery request entirely, click Cancel.

Starting, Stopping, or Deleting a
Discovery Request

If you have previously created a discovery request, you can start, stop, or delete it

through the Discovery Requests window (FIGURE 5-2).

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

▼ To Start, Stop, or Delete a Discovery Request

1. Select Tools ➤ Discover in the SyMON main console window (FIGURE 5-1).

The Discovery Requests window is displayed.

2. Select the name of the discovery request you want to modify.

3. Click the Start, Stop, or Delete button to start, stop, or delete a request,
respectively.
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CHAPTER 6

SyMON Main Console Window

The SyMON main console window (FIGURE 6-1) has the following regions:

■ Main Console Window

■ Domain View

■ Hierarchy View

■ Topology View

■ Menu Bar

■ Navigation Buttons

■ SyMON Administrative Domains Pull-Down Menu

■ Help Button

■ Domain Status Summary

Main Console Window

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The SyMON main console window (FIGURE 6-1) is the primary user interface. It

provides:

■ Visual representations of the managed objects (for example, hosts and networks)

■ Ability to manipulate attributes and properties associated with the managed

objects (for example, create alarm threshold conditions).

The features shown in FIGURE 6-1 are described in this chapter.
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FIGURE 6-1 SyMON Main Console Window

Domain View

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Once you have created a domain and have populated it with objects (groups and

hosts, and so forth), you can see the domain and its objects in the hierarchy (tree)

view and the topology (regional) view of this domain.

Menu bar

Domain view
(hierarchy)

Topology view

Navigation Domain status summary
About

SyMON
administrative
domains
(pull-down menu)

Search

Help
(license information)

buttons
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The domain view enables you to build collections of objects that support your

monitoring and management tasks. You can group your host sets by buildings,

subnets, or other group objects. You can selectively view all objects (such as hosts,

routers, and servers) in the domain, or selected objects (such as the servers) that

support a specific function that interests you.

The Domain view shows you the objects contained in a domain; the domain itself,

and any groups and hosts contained in that domain.

FIGURE 6-2 illustrates an example of a domain. In this example, Headquarters

represents a domain that consists of all the host machines in the headquarters office.

The host machines are found in one geographic (campus) site. The campus has two

buildings, and each building contains a network, subnet, two groups, and host

machines.

You may choose to create a similar type of domain, and you can group your

machines by subnet, rather than by building. You should create a domain and its

subordinate groups in a hierarchy that best supports your monitoring activities.

For more information on domains, see Chapter 3.

The SyMON main console window (FIGURE 6-2) displays two views of a domain and

its members. The left side of the domain view is the hierarchy (tree) view and the

right side is the topology view.

■ Hierarchy tree

The hierarchy tree view displays the relationship between a domain and its

members. Some objects in the hierarchy view contain other objects which can be a

group of objects or a single object. Some objects are both.

In FIGURE 6-2, Building B is an object contained in the domain named

Headquarters, but is also a group itself. Building B contains the network

194.150.151.52, the subnet mpk12-238-n, GroupA, and hosts machineA and

machineB.

For more information, see “Hierarchy View” on page 94.

■ Topology view

The topology view displays the member(s) of an object selected in the hierarchical

tree.

In FIGURE 6-2, the selected object in the hierarchy tree is MachineA.

For more information, see “Topology View” on page 96.
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FIGURE 6-2 SyMON Main Console Window With Hierarchy and Topology Views

Hierarchy View

Two types of windows contain hierarchy views:

■ Domain view in the SyMON main console window (FIGURE 6-1)

■ Browser view in the Details window (FIGURE 10-2)

The domain hierarchy view displays the domain and its members.

Hierarchy view (hierarchical tree)
Topology view
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The host hierarchy view displays the host and its modules. This view is part of the

Browser Details window (Chapter 7).

Both the domain hierarchy view and the host hierarchy view behave in the same

manner. In both windows, the hierarchy view is on the left side of the window.

The mouse actions in the hierarchy view are summarized in TABLE 6-1.

▼ To Obtain Specific Information About the Hierarchy View

If an object has a light-colored circle next to it, there are additional levels of

information that are hidden. You can obtain more information about the object by

examining its subordinate objects. To obtain specific information about subordinate

objects, complete the step in one of the following methods.

Method 1

● Click on the circle next to the object to “unroll” the tree branch.

The circle changes to a darker color, and the subordinate objects are displayed.

Method 2

● Double-click with the left mouse button on the object icon or the label.

TABLE 6-1 Mouse Actions in the Hierarchy View

Mouse Action Result

Click with left or right mouse button on the circle next

to the object

“Unrolls” (opens) details or “rolls” (closes) details of

the selected object.

Double-click with the left mouse button on object icon For a host object, starts the Details window or moves

the Details window to the foreground if it is already

open. For a domain or group object, unrolls or rolls

details of the selected object. Also, the topology view

is updated with the members of the selected object.

Click with the left mouse button on object icon Displays the members of the selected object in the

topology view. However, if the object icon is a host

(in the main console window), then the Details

window is displayed.

Click with the right mouse button and hold on the

object label

Pop-up menu is displayed. See “Pop-up Menu” on

page 97 for more information.
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▼ To Obtain General Information About the Hierarchy View

If an object has a dark-colored circle next to it, lower levels of the hierarchy are

currently displayed (in most cases). You can obtain information about the container

object by “rolling up” (hiding) the lower levels. To obtain general information about

a container object, complete the step in one of the following methods.

Method 1

● Click on the circle next to the object to “roll up” the tree branch.

The circle changes to a lighter color, and the group (container) object is displayed.

Method 2

● Double-click with the left mouse button on the object icon or the label.

Topology View

The topology view displays the members of the object selected in the hierarchy view.

There are two types of windows that contain topology views:

■ Domain view in the SyMON main console window (FIGURE 6-1).

■ Browser contents view in the Details window (Chapter 7).

Both the domain and browser contents views behave in the same manner.

The mouse actions in the topology view are summarized in TABLE 6-2.

TABLE 6-2 Mouse Actions in the Topology View

Mouse Action Result

Double-click with the left mouse

button on the icon

Opens details about the selected object. However, if the object is a

host (in the main console window), then the Details window is

displayed.

Click with the left mouse button on the

icon

Selects icon.

Click with the right mouse button and

hold on the icon

Pop-up menu is displayed. See “Pop-up Menu” on page 97 for more

information.
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Tool Tip Balloon

As you move the mouse over various areas in the main console window, tool tip
balloons are displayed momentarily. A tool tip is a description of the selected object

or a description of a property and value column of any data property table. Property

tables provide information about the monitored property and are described in

Appendix C.

▼ To See a Tool Tip Balloon

● Place your mouse over an object.

After a brief delay, a tool tip is displayed that provides a short description of that

object (FIGURE 6-3).

FIGURE 6-3 SyMON Tool Tip Balloon

Pop-up Menu

Pop-up menus are available for all objects in the hierarchy and topology views. The

contents of a menu varies according to the capability of the object selected.

Tool tip
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▼ To Access a Pop-Up Menu

1. Click the right mouse button on the object.

The pop-up menu is displayed.

2. Click the left button to select a menu item (TABLE 6-3).

The following table lists common items in the approximate order in which they are

displayed in the pop-up menus. Some items are not displayed in all menus.

Note – Depending on the object you selected, all the pop-up menu items listed in

TABLE 6-3 may not be displayed.

Menu Bar

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The menu bar is at the top of the SyMON main console window (FIGURE 6-4).

TABLE 6-3 Common Pop-Up Menu Items

Menu Item Description

Cut Cuts the selected object. The cut object is enclosed in a dashed box

until it is pasted into a new location. To cancel the cut operation,

click on the object.

Copy Copies the selected object.

Rename Displays the Rename Object window.

Modify Displays the Modify Object window

Attribute Editor Displays the Attribute Editor. For information about editing a

domain, see Chapter 3. For information about editing a host, see

Chapter 7. For information about editing a module, see Chapter 8.

For information about editing security, see Chapter 11.

Load Module Displays the Load Module dialog. For more information on the

Load Module dialog, see “To Load a Module” on page 184.

Details Displays the Details window. For more information on the Details

window, see Chapter 10.
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FIGURE 6-4 SyMON Menu Bar

Select (highlight) an object by clicking it in the hierarchy or topology view, then click

a menu name (File, Edit, View, Go, or Tools). If a menu name is grayed out, that

option is not available for the object that you have selected.

▼ To Use the SyMON Main Console Window

Menu Bar

The menus are of the pull-down style.

1. Click an entry in the menu bar to display a pull-down menu.

2. Click an entry in the pull-down menu to initiate that action.

The menus in the menu bar are described below.

Menu bar
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File Menu Options

Edit Menu Options

TABLE 6-4 Options for the File Menu

Option Description

Domain Manager The Domain manager enables you to create your domain(s).

For more information on Domain manager, see Chapter 3.

Remote Domain Manager For more information on Remote Domain manager, see

Chapter 3.

Set Home Domain Sets your home domain.

SyMON-Console Messages Opens the SyMON-Console Messages window. The window

displays messages generated by the Sun Enterprise SyMON

program, but does not include general UNIX messages.

Exit Exits the current console session and all related SyMON

windows. A pop-up dialog asks you to confirm the exit

request.

TABLE 6-5 Options for the Edit Menu

Option Description

Create an Object Creates a group, a node, or a network segment in the domain

that is currently highlighted in the console window. See

Chapter 4.

Create a Connection Connects two objects in the topology view. You may choose the

type of connection to be General, RS-232, T1, or T3. The

connection is represented by a line between the objects.

Delete Object/Connection Deletes the highlighted object or connection. A dialog asks you

to confirm the deletion request.

Rename Enables you to rename the highlighted object. Displays a dialog

for you to enter the new name.

Modify Brings up the Modify Object menu. For more information on

the Modify Object menu, see “Modifying Objects” on page 67.

Cut Displays a dashed line around the selected object. The object is

not removed until you paste it into a new location.

Copy Copies the selected object into a temporary buffer.
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View Menu Options

Paste Pastes the cut or copied object into the domain or group that is

currently displayed in the hierarchy or the topology view.

Paste Into Pastes the cut or copied object into the selected domain or

group.

Select All Selects all objects in the topology view.

TABLE 6-6 Options for View

Option Description

Topology Layouts Enables you to change the style of display in the topology view. The

styles are:

Network,

Grid (square grid pattern),

List (single vertical list),

Bus,

Star (equidistant lines connected to a center),

Spoked Ring (equidistant lines in a circle).

Set Topology

Background

Displays the Set Topology Background window. You can add a

background image to a topology view by selecting from a list of

graphics files. (The list may not be in alphabetical order.) You can

also use this window to remove a background image by clicking the

Unset button.

TABLE 6-5 Options for the Edit Menu (Continued)

Option Description
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Go Menu Options

Tools Menu Options

TABLE 6-7 Go Menu Items

Menu Item Action

Back Takes you to the previous console view.

Forward Takes you to the next console view (if applicable).

Home Takes you to the top of your home domain in the hierarchy view.

Up Takes you up one level in the hierarchy view.

History Lists recent locations that you have viewed in the current console

session. Select an entry to return to that location.

Search Opens the Topology Search window to search for the object label

that you specify. If one or more objects are found, the full path or

paths are displayed.

TABLE 6-8 Tools Menu Items

Menu Item Action

Details Enables you to see detailed information (if available) for a selected

object. For more information about the Browser Details window, see

Chapter 7. For more information about the Details Alarm window,

see Chapter 9. For more information about the remaining categories

in the Details window, see Chapter 10.

Attribute Editor Displays the Attribute Editor. For information about editing a

domain, see Chapter 3. For information about editing a host, see

Chapter 7. For information about editing a module, see Chapter 8.

For information about editing security, see Chapter 11.

Graph Displays the Open Graph window. You can select from a list of

saved graphs. For information on the graphing function, see

Chapter 7.

Discover Enables you to search for objects in a geographical location. For

information about the Discovery Requests window, see Chapter 5.

Load Module Enables you to load a SyMON module for a selected object. For

information about the Load Module window, see Chapter 8.
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Navigation Buttons

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

As you move through different domains and through different levels within the

domains, the domain views are stored in memory. The Navigation buttons

(FIGURE 6-5) in the main console window help you move back and forth between

these views.

FIGURE 6-5 SyMON Navigation Buttons

Note – The SyMON navigation buttons perform the same function as the Go menu

items.

TABLE 6-9 Navigation Buttons

Button Description

Forward Button The forward button is represented by an arrow facing right

(FIGURE 6-5). Clicking this button displays the next screen.

Back Button The back button is represented by an arrow facing left (FIGURE 6-5).

Clicking this button displays the previous screen.

Home Button The home button is represented by a house (FIGURE 6-5). Clicking

on this button returns you to the highest level of the domain.
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SyMON Administrative Domains
Pull-Down Menu

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The SyMON Administrative Domains pull-down menu is shown in FIGURE 6-6. This

menu displays the current list of domains and enables you to switch from one

domain to another. Clicking on the domain updates and displays the selected

domain.

The default domain is the domain that is always displayed whenever the SyMON

main console is started.

FIGURE 6-6 SyMON Administrative Domains Pull-Down Menu
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▼ To View the Current List of Domains

1. In the SyMON main console window, click the SyMON Administrative Domains
button.

The pull-down menu with the current list of domains is displayed.

2. Click the domain that you want to view.

The main console window is updated and displays the selected domain. The

SyMON Administrative Domains button changes to display the name of the domain

you have selected.

Help Button

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Clicking the Help button (FIGURE 6-7) displays the online SyMON user’s guide.

FIGURE 6-7 Help Button

Domain Status Summary

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Help button
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The domain status summary displays the number of managed objects that have at

least one unacknowledged open alarm of that severity in the selected SyMON

Administrative Domain (FIGURE 6-8).

Note – If a host has multiple alarms at several different severity levels, the host is

represented at only one severity level (the highest severity level for that host).

For more information on the domain status summary, see “Seeing Alarms in Domain

Status Summary” on page 209.

FIGURE 6-8 Domain Status Summary
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CHAPTER 7

Browser

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

This chapter covers the following topics:

■ To Start the Details Window

■ To Set Security for a Host or Module

■ To Display a Data Property

■ To Add a Row

■ To Refresh Displayed Data

■ To Probe a Property

■ To Graph A Monitored Data Property

■ To Graph Two Data Properties

■ To Save Graphing Parameters

■ To Open a Graph

■ To Apply a Graph Template

■ To Open the Attribute Editor

■ To Create an Alarm

■ To Send an Email

■ To Set a Refresh Interval

■ To Set a History Interval

■ To Create a Timex Expression Using the Cyclic and Comparison Tabs

■ To Create a Timex Expression Using the Absolute and Cron Tabs

■ To Create an Alarm Schedule Using the Comparison Tab
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Details View

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The details view is a subset of the Domain view. The highest hierarchical object in a

details view is the host machine or module (if you have created a module object).

For more information, see “To Create a Module Object” on page 59. Unlike the

domain view, the details view enables you to see modules and the various

monitored properties and statistics contained in the modules.

The host contains four subordinate groups: hardware, operating system, local

applications, and remote systems. The Sun Enterprise SyMON modules belong to

one of these four categories.

SyMON software monitors hosts by using modules. Modules are software

components that monitor data pertaining to the health indicators and resources of

systems, applications, and network devices.

FIGURE 7-1 is an example of the host view for MachineB . The left side of the host

view is the hierarchy (tree) view and the right side is the contents view. The host

hierarchy view displays the relationship between the host and its modules. In this

example, the loaded operating system modules are the MIB-II Instrumentation and

the Kernel Reader modules.

By using the Browser Details window, you can set alarm thresholds and view and

graph monitored data properties for your host.
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FIGURE 7-1 Browser Details Window

Host view

Contents
view
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Using the Details Window

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

You can start the Details window from the SyMON main console window.

The Details window provides you with detailed information about that individual

host. This window has several tab buttons:

■ Info

■ Browser

■ Alarms

■ Processes

■ Logview

■ Configuration

Note – The tab buttons that are displayed in the Details window are dependent on

the type of object selected. In addition, the Configuration tab is missing if the

Config-Reader module is not supported on your system.
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Each tab button, as described in the following table, updates the window with a new

panel consisting of information represented by that tab button.

For more information on these buttons, see Chapter 10.

▼ To Start the Details Window

● Proceed with one of the following:

■ Click the right mouse button on the selected object and highlight Details from the

pop-up menu in the hierarchy view (FIGURE 7-2) or the topology view.

■ With your left mouse button, double-click on the selected host icon in the

hierarchy view or the topology view.

■ In the SyMON main console window, select the object then select Tools ➤ Details

(FIGURE 7-3).

Be sure to select a managed object, not a domain, as the Details window is not

available for domains.

The Details window (with the browser tab pre-selected) is displayed.

TABLE 7-1 Details Window Tab Buttons

Tab Button Description

Info Provides general information about the host including host name,

IP address, polling type, and so on. This information is collected at

the time the object is created.

Browser Enables you to navigate through the hierarchy and contents views

of the host, set alarm thresholds, and view and graph monitored

data properties. This is the default view when the Details window

opens.

Alarms Displays the alarms for this host. Enables you to acknowledge or

delete alarms.

Processes Displays the processes running on the host. (You must load the

Solaris Process Details module to see the processes.)

Log View Displays informational messages, including error messages, about

your host. Enables you to search, monitor, and examine system and

Sun VTS log messages.

Configuration Displays configuration information about your host for selected

hardware platforms. Configuration information may include the

physical and logical view of your host. If the hardware platform is

not supported by the Config-Reader module, this tab button is

missing in the Details window.
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FIGURE 7-2 Opening the Details Window from the Pop-Up Menu
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FIGURE 7-3 Opening the Details Window from the Tools Menu

▼ To Exit the Details Window

● Click the Close button located at the bottom of the Details window.
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Browser Tab

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The Browser tab (FIGURE 7-4) contains the hierarchy and contents views for a host.
114 Sun Enterprise SyMON 2.0 User’s Guide • December 1998



FIGURE 7-4 Light-Colored Circles “Unroll” to Provide Additional Levels of Detail

Tip – You may be able to see more information by holding the mouse pointer over

the object for several seconds. A pop-up balloon (tool tip) is displayed, showing

additional information about the object. These tool tips are also displayed for data

property table cells and are useful if information in a table cell is too long to display

completely.

Circle
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Tip – If the hierarchy view has a light-colored circle (FIGURE 7-4), you can click the

circle or double-click the icon next to the circle to “unroll” and display more levels of

detail.

Each host contains categories for Hardware, Operating System, Local Applications,

and Remote Systems. For more information on modules, see Appendix C.

Hardware

The Hardware category consists of the Config-Reader module, which monitors the

host configuration, including information and status for power supplies, keyswitch,

fans, remote console, the system in general, and so on.

There are different Config-Reader modules for different hardware platforms. If your

system is supported by a Config-Reader module, it is automatically loaded during

installation.

Operating System

The Operating System category includes modules that monitor the operating

environment of the host:

■ Directory Size Monitoring

■ File Monitoring

■ Kernel Reader

■ MIB-II Instrumentation

■ NFS File Systems

■ NFS Statistics

■ Solaris Process Details

Local Applications

The Local Applications category includes modules that monitor the local

applications on the host:

■ Agent Statistics

■ Data Logging Registry

■ Dynamic Reconfiguration

■ File Scanning

■ Health Monitor

■ Print Spooler
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■ Process Monitoring

Remote Systems

The Remote Systems category includes modules that monitor remote systems:

■ MIB-II Proxy Monitoring module

■ HP JetDirect module (monitors HP printers equipped with a JetDirect card)

Browser Buttons

The Browser Details window includes a row of buttons at the top of the panel.

TABLE 7-2 Browser Buttons

Menu Item Definition

Module FIGURE 7-5

Load Module Enables you to add a module to the host. The host must be selected

or this option is grayed out. For more information, see “To Load a

Module” on page 184.

Edit Module Enables you to edit module parameters. The module must be

selected or this option is grayed out. For more information, see “To

Edit Module Parameters” on page 193.

Enable Module Enables you to enable a module. The module must be selected or

this option is grayed out. For more information, see “To Enable a

Module” on page 195.

Disable Module Enables you to disable a module. The module must be selected or

this option is grayed out. For more information, see “To Disable a

Module” on page 195.

Unload Module Enables you to unload a module from the host. The module must be

selected or this option is grayed out. For more information, see “To

Unload a Module” on page 196.

Options FIGURE 7-6

Copy Enables you to copy a module. You may paste the copied module in

the topology or hierarchy view of the main console. This enables

you to monitor the module properties without having the Details

window open. For more information, see “To Create a Module

Object” on page 59.

Copy To Graph Enables you to add a variable to a graph. See “To Graph Two Data

Properties” on page 132.
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Note – The browser buttons are grayed out when the command is not appropriate

for the selected object.

FIGURE 7-5 Module Menu Options in Details Window

Add Row Adds a row to a data property table. See “To Add a Row” on

page 125.

Enable Row Enables a row (that has been disabled) in a data property table.

Disable Row Disables a row in a data property table.

Edit Row Enables you to edit information for a row in a data property table.

Delete Row Deletes a row in a data property table.

Attributes Displays the attribute editor for the selected object. The Attribute

Editor provides additional information about the selected object

and the rules governing its behavior. Use the Attribute Editor to

edit information about the object.

Graph Graphs the selected monitored data property.

Probe Enables you to run selected commands on the monitored data

property.

Refresh Now Refreshes the information in the displayed data property table.

TABLE 7-2 Browser Buttons (Continued)

Menu Item Definition
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FIGURE 7-6 Options Menu Options in Details Window

Host Security

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

In the Details window, SyMON offers security at two levels: the host itself and at the

module level. If you want, you may set security at the host level only. In this case,

anyone with the appropriate security can load modules, set alarm thresholds,

acknowledge alarms, and so on.

You may also set security permissions at the module level. In this case, only those

users with the appropriate module permissions can perform actions on the module.

Module security can be used as a “subset” of host security.

For example, at the host level, you can set security permissions so that users A, B,

and C can load modules and create alarm thresholds. User A loads the Health

Monitor module and creates customized alarm thresholds. However, users B and C

can change user A’s work unless security permissions have also been set at the

Health Monitor module level, enabling only user A to set alarm thresholds.
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Note – In the case where security is set at both levels, the security permissions at

the module level take precedence over the security permissions at the host level.

Consequently, only user A can create alarm thresholds for the Health Monitor

module.

For more information on security, see Chapter 11.
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FIGURE 7-7 Attribute Editor for a Host or Module

▼ To Set Security for a Host or Module

1. Open the Attribute Editor for a host or module by proceeding with one of the
following:
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■ Click the right mouse button on the host or module and highlight Attribute

Editor from the pop-up menu.

■ Click the Attributes button.

2. Click the Security tab (FIGURE 7-7).

3. Type the name(s) of user and administrator groups in the appropriate fields.

For more information on the security fields, see Chapter 11.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.

Monitoring Data Properties

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Using your mouse, you can navigate through the hierarchy (tree) view in the Details

window to view the monitored properties.

The lowest-level object in the host hierarchy is the monitored property. SyMON

software provides both tabular and graphical information about a monitored

property.

Once the data has been displayed, you can refresh the data. In addition, you can

graph up to five data properties simultaneously. These actions are described in the

following sections.

▼ To Display a Data Property

Note – The following example uses the Kernel Reader module.
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1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the Kernel Reader icon in the contents view or single click in the
light-colored circle next to the Kernel Reader icon in the hierarchy view.

The Kernel Reader statistics are displayed.

3. Double-click on the System Load Statistics icon in either the hierarchy or the
contents view (FIGURE 7-8).

The monitored properties are displayed in a property table.
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FIGURE 7-8 System Load Statistics
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Working with Rows

For selected modules, SyMON software enables you to add, delete, enable, or

disable rows for the data property tables (TABLE 7-3). When these modules are

initially loaded, the data property tables are empty. You must “add a row” to

monitor the data property.

▼ To Add a Row

The following example procedure uses the File Monitoring module. If this module is

not loaded, see “To Load a Module” on page 184.

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.

2. Double-click on the File Monitoring icon in the contents view or single click in
the light-colored circle next to the File Monitoring icon in the hierarchy view.

The File Monitoring Status folder is displayed.

3. Double-click on the File Monitoring Status folder in either the hierarchy or the
contents view.

An empty property table is displayed.

TABLE 7-3 SyMON Modules That Require You to Add Rows

Module Name Description

File Monitoring Each added row defines the monitored “file”.

File Scanning Each added row defines the “pattern” which must be matched

within the monitored file. This row is added to the “Scan Table.”

Process Monitoring Each added row defines the “pattern” which must be matched from

all the processes that are running on the agent object.
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FIGURE 7-9 File Monitoring Table

4. Proceed with one of the following:

■ Click the right mouse button in the table row and select the Add Row command

from the pop-up menu (FIGURE 7-9).

■ In the Details window, select Options ➤ Add row.

The Row Adder window is displayed (FIGURE 7-10).

5. Type the appropriate information in the text fields.
126 Sun Enterprise SyMON 2.0 User’s Guide • December 1998



FIGURE 7-10 Row Adder Window

6. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the window to the default parameters.

■ Click Cancel to cancel your request.

The added row is displayed in the contents view (FIGURE 7-11).
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FIGURE 7-11 Updated File Monitoring Table

▼ To Refresh Displayed Data

● Proceed with one of the following:

■ Click the right mouse button in the data property table row and select Refresh

from the pop-up menu (FIGURE 7-12).

■ Click the Refresh Now button.

In this example, the System Load Statistics table is updated with the latest

information.

Note – You may also set up a refresh interval and the SyMON software

automatically updates your monitored data at your designated time interval. For

information on accomplishing this task, see “Refresh Tab in the Attribute Editor” on

page 154.
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FIGURE 7-12 Monitored Data Property Pop-up Menu

Probing Properties

On selected properties, SyMON software enables you to run pre-determined UNIX

commands including list files, the vmstat command, and so on. The Probe button is

not grayed out when probe commands are applicable.

The following procedure explains how to probe a property in the Directory Size

Monitoring module. If you have not done so already, load this module by following

the procedure “To Load a Module” on page 184.

▼ To Probe a Property

1. In the Browser Details window, double-click on the Operating System icon in the
hierarchy (tree) view.

The operating system modules are displayed in both the hierarchy and contents

views.
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2. Double-click on the Directory Size Monitoring icon in the contents view or single
click in the light-colored circle next to the Directory Size Monitoring icon in the
hierarchy view.

The Directory Monitoring Status folder is displayed.

3. Double-click on the Directory Monitoring Status folder icon in either the
hierarchy or the contents view.

The monitored data properties are displayed in a property table.

4. Proceed with one of the following:

■ Click the right mouse button in the Directory Monitoring table row and select the

List Files or Recursively List Files command from the pop-up menu (FIGURE 7-13).

■ Click the Probe button (FIGURE 7-14), select the appropriate command, and click

the OK or Cancel button.

FIGURE 7-13 Probe Commands in the Pop-up Menu
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FIGURE 7-14 Probe Select Dialog

Graphing Properties

SyMON software enables you to graph most monitored data properties (FIGURE 7-15).

▼ To Graph A Monitored Data Property

● Proceed with one of the following:

■ Click the right mouse button in any table cell containing a data property you

want to graph, and select Graph from the pop-up menu (FIGURE 7-12).
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■ Select (highlight) the desired data property, and then click the Graph button at the

top of the Details window.

The SyMON graphing window is opened and the values of the property are plotted

as a function of time. The plotting is dynamic and continues even if the graphing

window is iconified on the desktop. Plotting stops, however, if the window is closed.

Note – Placing your cursor and clicking with the right mouse button in a property

row or column displays the pop-up menu for that property.

FIGURE 7-15 Graph of System Load Statistics Average Over the Last Five Minutes

▼ To Graph Two Data Properties

1. Click the right mouse button in the data property table cell.

In this example, the Load Averages Over the Last 1 Minute table cell is selected.

2. Proceed with one of the following:

■ Click the right mouse button in the table cell and select the Copy to Graph

command from the pop-up menu (FIGURE 7-16).
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■ In the Details window, select Options ➤ Copy to Graph.

3. Go to the graphing window in which you want the additional property to be
plotted. Select Graph ➤ Add to Graph (FIGURE 7-17).

The second data property is added (FIGURE 7-18).

FIGURE 7-16 Copying Load Averages Over the Last One Minute to the Graph

Note – You may graph up to 5 datasets at one time on a single graph.
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FIGURE 7-17 Adding Load Averages Over the Last One Minute to the Graph
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FIGURE 7-18 Load Averages Over the Last One and Five Minutes

▼ To Save Graphing Parameters

1. Select Graph ➤ Save Graph Request As or Select Graph ➤ Save Template in the
Graphing window.

The Save Graph Request function (FIGURE 7-19) enables you to save the host name

and the data property or properties that have been graphed. Once saved, a graph of

this property on this host can be pulled up quickly from inside the graphing

window (as shown here) or from the main console window under the Tools menu. A

newly opened graph starts plotting fresh data.

The Save Template function (FIGURE 7-20) enables you to save any custom features

you have added to your graph including axis labeling, headers, footers, legend, and

so on. (For more information see “Graphing Menus” on page 138.)

2. Type the name in the Enter Graph Name or Enter Template Name fields.

3. Click the Save button to save your graph request (template) or click the Cancel
button to cancel your request.
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FIGURE 7-19 Save Graph Request Dialog

FIGURE 7-20 Save Template Dialog

▼ To Open a Graph

1. Select Graph ➤ Open Saved Graph in the Graphing window.

The Open Graph dialog is displayed (FIGURE 7-21).
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FIGURE 7-21 Open Graph Dialog

2. Select (highlight) a saved graph from the list.

3. Click the OK button to open the graph or the Cancel button to cancel your
request.

▼ To Apply a Graph Template

1. Select Graph ➤ Apply Template in the Graphing window.

The Apply Template dialog is displayed (FIGURE 7-22). This dialog enables you to

apply saved custom features to the current graph.

FIGURE 7-22 Apply Template Dialog

2. Select (highlight) a saved template from the list.

3. Click the OK button to apply the template to the current graph or the Cancel
button to cancel your request.
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Graphing Menus

There are five Graphing window menu items:

■ Graph

■ Edit

■ View

■ Tools

■ Help

Graph Menu Items

TABLE 7-4 Graph Menu Items

Menu Item Description

Save Graph Request

as

Saves the host name and data property (properties) that are plotted.

Open Saved Graph Opens a previously saved graph.

Delete Deletes a previously saved graph.

Save Template Saves any custom changes you make on the graph.

Apply Template Applies a saved template to the current graph.

Delete Template Deletes a previously saved graph template.

Add To Graph Adds an additional dataset to an existing graph. Choose this menu

item after selecting a property to “copy to graph.”

Close Closes the graphing window.
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FIGURE 7-23 Graph Menu Items

The SyMON graph utility enables you to customize the look and feel of your graphs

through the edit menu items (TABLE 7-5).

Note – Header, Footer, Axes, and Legend changes are not visible unless the view

option corresponding to that part of the graph is toggled on (TABLE 7-6).
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Edit Menu Items

FIGURE 7-24 Edit Menu Items

TABLE 7-5 Edit Menu Items

Menu Item Description

Chart Type Changes graph type to line, area, or bar graph.

Main Titles Changes the text, font, font style, point size, and orientation of the

header, footer, legend, x-axis or y-axis title. In addition, this dialog

enables you to select and customize the border around the title.

Axes Edits the range and the spacing of the x- and y-axes. This menu

item is suggested for advanced users only (FIGURE 7-25 and

FIGURE 7-26).

Border Determines the border type (including a no border option).
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Note – Editing axes requires some care in choosing the correct values. If you should

choose values for Min and Max that are impossible to plot, the dialog, in most cases,

gives you an error message describing the problem. However, if you simply choose

values that are possible, but result in the plotted points no longer being visible, you

are not warned with an error message.

FIGURE 7-25 and FIGURE 7-26 show the axes dialog for the x-axis and y-axis,

respectively.

FIGURE 7-25 X-Axis Editing Dialog

The SyMON software chooses appropriate default x-axis values using

“Autoscaling”. If you want to change the values, then you must turn off autoscaling

by unchecking the checkbox.

You may then change:

■ Number of minutes to be plotted

■ Positioning of ticks

■ Positioning of grid lines

Note – Ticks are the small lines that mark off intervals on an axis.
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FIGURE 7-26 Y-Axis Editing Dialog

The SyMON software chooses appropriate default y-axis values using

“Autoscaling”. If you want to change the values, then you must turn off autoscaling

by unchecking the checkbox.

You may then change:

■ Minimum and maximum values shown on the y-axis

■ Major tick positions (the interval at which numerical labels are shown)

■ Minor tick positions (showing smaller intervals)

■ Grid spacing
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View Menu Items

FIGURE 7-27 View Menu Items

TABLE 7-6 View Menu Items

Menu Item Description

Live Data Displays the monitored property (properties) data points.

Show Header Displays the header text.

Show Footer Displays the footer text.

Show Axis Titles Displays the x-and y-axes titles.

Show Axes Displays the x-and y-axes.

Show Grids Displays a grid pattern in the graphing window.

Show Legend Displays the legend text.

Rotate Graph Rotates the graph by 90, 180, or 270 degrees.

Flip Flips the graph over (x-axis flips the x-axis, y-axis flips the y-axis).

Reset View Resets rotate and flip options to the default (graph upright) setting.
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Tools Menu Items

FIGURE 7-28 Tools Menu Items

TABLE 7-7 Tools Menu Items

Menu Item Description

Zoom Toggle to turn on the zoom option, which focuses on a selected area

of the graph. Hold down the Shift key while dragging out a

rectangle with the mouse.

Translate Toggle to turn on the translate option, which moves the graphing

window side to side or back and forth. Hold down the Control key

while moving the mouse left-right or up-down.

Restore Removes the effects of the zoom and translate options; undo option.
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Attribute Editor for a Data Property

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The Attribute Editor for a data property provides additional information about the

property and enables you to customize various monitoring criteria. You can use the

attribute editor to set:

■ Alarm thresholds

■ Actions when alarm conditions occur

■ The refresh interval

■ A logging schedule for historical data points

The Attribute Editor consists of a series of one or more tab buttons at the top of the

window that enables you to switch between different panels. The tab buttons for the

System Load Statistics data property are:

■ Info

■ Alarms

■ Actions

■ Refresh

■ History

Note – Each Attribute Editor displays one or more of these tab buttons, depending

on the type of Attribute Editor. The Attribute Editor that is displayed is dependent

on the selected object.
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▼ To Open the Attribute Editor

1. Click the right mouse button and select a data property table cell (FIGURE 7-29).

2. Proceed with one of the following:

■ Click the right mouse button in a table row and select Attribute Editor from the

pop-up menu.

■ Click the Attributes button.

FIGURE 7-29 Selected Data Property
146 Sun Enterprise SyMON 2.0 User’s Guide • December 1998



Information Tab in the Attribute Editor

The Information panel (FIGURE 7-30) provides you with additional information about

the selected object.

FIGURE 7-30 Attribute Editor Info Tab for a Monitored Property
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Alarms Tab in the Attribute Editor

The Alarms panel (FIGURE 7-31) enables you to set alarm thresholds (TABLE 7-8) for

simple alarms only.

Simple alarms are based on thresholds. A monitored data property is greater than,

less than, not equal to, or equal to a single threshold value. By contrast, complex

alarms are based on a set of conditions becoming true. For more information on

alarm rules, see Appendix D.

FIGURE 7-31 Attribute Editor Alarms Tab for a Monitored Property
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TABLE 7-8 shows common simple alarm limits for monitored properties. The alarm

limits are also displayed in the Parameter Description field (FIGURE 7-31). You may

set thresholds for one or more of these alarm limits for selected data properties.

SyMON software offers you the following flexibility in setting your alarms:

■ Determine the thresholds that trigger an alarm of a particular severity

■ Determine when alarms are sounded (for example, only on weekdays)

Note – You need the appropriate security permission to set an alarm threshold. See

Chapter 11 for more information.

TABLE 7-8 Common Simple Alarm Limits in SyMON Software

Alarm Limit Description

Critical Threshold (>) Critical (red) alarm occurs if value exceeds limit entered in this field.

Alert Threshold (>) Alert (yellow) alarm occurs if value exceeds limit entered in this field.

Caution Threshold (>) Caution (blue) alarm occurs if value exceeds limit entered in this field.

Critical Threshold (<) Critical (red) alarm occurs if value is below the limit entered in this field.

Alert Threshold (<) Alert (yellow) alarm occurs if value is below the limit entered in this

field.

Caution Threshold (<) Caution (blue) alarm occurs if value is below the limit entered in this

field.

Alarm Window Alarm occurs only during this time period. For example, if you type

day_of_week=fri , an alarm occurs only if the alarm condition exists on

a Friday. If an alarm condition exists on Tuesday, no alarm is registered.
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▼ To Create an Alarm

The following example illustrates how to create a simple alarm. This example creates

an alarm threshold in the Kernel Reader module.

1. Click the Browser tab button in the Details window.

2. Click the light-colored circle next to the Operating System icon in the hierarchy
tree view.

The Operating System modules are displayed.

3. Click the light-colored circle next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 1 Minute.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click on the Alarms tab button.

The alarm rows are displayed.

8. Type a value in the Critical Threshold (>) field which is less than the current
value.

Entering this value enables you to create a critical alarm.

9. Complete one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.

After some time, the Load Average Over the Last 1 Minute data field in the table

turns red. In addition, red alarm icons are displayed on the following folders and

icons: Operating System, Kernel Reader, and System Load Statistics (unless your

system has an open, unacknowledged severity 1 black alarm).

10. Click the Alarms tab button in the Details window.

The alarm you created should be reflected in the alarms table. See Chapter 9 for

more information on this subject.

11. Acknowledge this alarm.

For more information, see “To Acknowledge and Delete Alarms” on page 217.
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12. Create additional alarm thresholds and familiarize yourself with their operation.

Once you have created these alarms, you can set up security permissions so that

another SyMON user cannot change your alarm thresholds. For more information on

security, see Chapter 11.

Note – You do not need to fill in alarm information for all alarm thresholds. For

example, you may choose to create only a critical alarm threshold.

The preceding example illustrates creating a situation where an alarm is registered if

a value exceeds the alarm limit. TABLE 7-8 lists other common alarm limits in the

SyMON software.

Actions Tab in the Attribute Editor

The actions tab in the Attribute Editor (FIGURE 7-32) enables you to instruct SyMON

software to perform a predetermined action if an alarm occurs. Acceptable actions

include scripts that are stored in the /var/opt/SUNWsymon/bin directory.

Note – These scripts execute with root permissions.

For example, you can enter the name of a script in the critical action field so that an

email is sent to a system administrator whenever a critical alarm is generated for the

Load Average Over the Last Five Minutes data property.

In FIGURE 7-32, you can set separate actions for different alarm conditions or one for

any alarm condition (action on any change).
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FIGURE 7-32 Attribute Editor Actions Tab for a Monitored Property
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▼ To Send an Email

The following example procedure describes how to send an email to a user when a

critical alarm occurs.

1. Click the Browser tab button in the Details window.

2. Click the light-colored circle next to the Operating System icon in the hierarchy
tree view.

The Operating System modules are displayed.

3. Click the light-colored circle next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the Actions tab button.

The action rows are displayed.

8. Type email username in the Critical Action field.

9. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.

The following email is sent to the user whenever a critical alarm occurs.

Date: Wed, 28 Oct 1998 15:25:39 -0800
From: root@MachineB (0000-Admin(0000))
Mime-Version: 1.0

SyMON alarm action notification ... {Critical: System Load
Average> 0.1}
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Refresh Tab in the Attribute Editor

The Refresh panel (FIGURE 7-33) enables you to set the refresh interval for this object.

The refresh interval is the interval between the times when the SyMON agent

samples the monitored property.

FIGURE 7-33 Attribute Editor Refresh Tab for a Monitored Property
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▼ To Set a Refresh Interval

The following example illustrates how to set a refresh interval in the System Load

Statistics module.

1. Click the Browser tab button in the Details window.

2. Click the light-colored circle next to the Operating System icon in the hierarchy
tree view.

The Operating System modules are displayed.

3. Click the light-colored circle next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click on the System Load Statistics icon.

The System Load Statistics properties table is displayed.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the Refresh tab button.

The refresh panel is displayed.

8. Type a value (in seconds) in the Refresh Interval field or click the Advanced
button.

In this example, type 300 in the entry field. The refresh interval is five minutes. For

more information on the Advanced button, see “Timex Editor” on page 159.

9. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.

Whenever the System Load Statistics table is displayed, the values in the table are

refreshed every five minutes.
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History Tab in the Attribute Editor

The history tab in the Attribute Editor enables you to save older data for a

monitored property. In FIGURE 7-34, a history of data points is recorded every 120

seconds (sample interval). This information may either be stored in a disk file or in

the memory cache.

There are two types of disk files: circular (maximum of 1000 lines) and text. These

files are located in the /var/opt/SUNWsymon/log directory.

If you select memory cache, you must also indicate how many data points should be

saved in the Max Size (sample) field.

Note – You may view this data in a graph by opening the graph for this monitored

property. If you have selected memory cache, the graph is displayed with the

historical data.
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FIGURE 7-34 Attribute Editor History Tab for a Monitored Property
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▼ To Set a History Interval

1. Click the Browser tab button in the Details window.

2. Click the light-colored circle next to the Operating System icon in the hierarchy
tree view.

The Operating System modules are displayed.

3. Click the light-colored circle next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

4. Double-click the System Load Statistics icon.

The System Load Statistics properties table is displayed.

5. Click with your left mouse button and select the table cell for Load Averages Over
the Last 5 Minutes.

6. Click the Attributes button.

The Attribute Editor window is displayed.

7. Click the History tab button.

The history panel is displayed.

8. Type a value (in seconds) in the Sample Interval field or click on the Advanced
button.

In this example, type 120 in the entry field. A history data point is collected every

two minutes. For more information on the Advanced button, see “Timex Editor” on

page 159.

9. Click in the check box next to Save History as Disk File or Save History in
Memory Cache.

10. If you decided to save history as a disk file, determine the file type (circular or
text) and type the file name in the Text File Name field (text file only).

A circular disk file is automatically saved under the name history.log .

11. If you decided to save history in memory cache, type the number of history data
points in the Max Size (sample) field.

For example, if you set this field to 1000, only the most current 1000 data points are

stored in the memory cache. Any older data points are discarded. These data points

may be graphed. See “To Graph A Monitored Data Property” on page 131 for more

information.

12. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.
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■ Click Cancel to cancel your request.

Timex Editor

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Use the Timex Editor (FIGURE 7-35) to schedule monitoring activities. For example,

you may want a particular module to be operational only during business hours. Or

you may want to record the history of a monitored property only during peak

activity.

You can use the Timex Editor to set the schedule for a module, for alarms, for a

refresh interval, and for history data collection.

Note – The schedule (set by the Timex Editor) for a module overrides the schedule

for alarms, refresh intervals, and history. If the module is not “on,” the data

properties are not monitored and the alarms, refresh, and history schedules are

meaningless.

FIGURE 7-35 Timex Editor
Chapter 7 Browser 159



There are four basic types of Timex expressions:

■ Cyclic – Periodic events

■ Absolute – Starting at a particular time

■ Comparison – Allowing events at specific times

■ Cron – Allowing events at specified times using cron input format

These Timex expressions can be used separately or in combination.

Note – All four Timex expressions are valid for history sample and refresh intervals.

However, only the comparison tab is valid for alarm and module schedules.

Combining Timex Expressions

The following examples illustrate combining Timex expressions to set a history

interval.

Note – Sampling for the history interval does not occur unless the module is also on

(according to the module schedule).

▼ To Create a Timex Expression Using the Cyclic

and Comparison Tabs

Note – This procedure is also valid for a refresh interval.

1. Click on the Advanced button in the History tab of the Attribute Editor for a data
property.

See “To Set a History Interval” on page 158 for more information.

The Timex Editor is displayed (FIGURE 7-35).

2. If any value is in the Time Expression field, highlight the value and delete it by
clicking the Delete button.

3. Click the Insert button.

The Timex window is displayed with the Cyclic tab selected.
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4. Determine the frequency for the history interval (FIGURE 7-36).

In this example, the history interval is set for every hour. That is, SyMON software

checks the System Load Average Over the Last 5 Minutes every hour.

a. Highlight the number field and click the up or down arrows until the number 1
is displayed.

b. Highlight the units field and click the up or down arrows until hours is
displayed.

FIGURE 7-36 Setting a Cyclic Time of One Hour

5. Click the Apply button.

Cycle(1 hours) is displayed in the Timex Editor (FIGURE 7-37).
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FIGURE 7-37 Timex Editor With Cyclic Time of One Hour

6. Click the Insert button.

The Timex window is displayed with the Cyclic tab selected.

7. Click the Comparison tab.

The Timex window is displayed with the Comparison tab selected.

8. Determine the start of the Time Range (Monday).

The time range determines the time period when the SyMON software checks the

system load average every hour. SyMON software does not check the system load

average outside the time period specified by this window. In this example, the time

range is from Monday to Friday, inclusive.

a. Select Day_of_week from the left pull-down menu.

b. Select Greater than or Equal from the middle pull-down menu.

c. Select Monday from the right pull-down menu.

The Timex expression is displayed in the Current Timex field (FIGURE 7-38).
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FIGURE 7-38 Setting the Start Range to Monday

9. Click the Apply button.

The Timex Editor is updated. The Timex Expression now reads Cycle(1 hours) And

Day_of_week>=Monday. However, the Timex Editor also enables you to select the

Or expression (FIGURE 7-39).
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FIGURE 7-39 Timex Editor Is Updated With a Start Range of Monday

10. Determine the end of the Time Range by clicking the Insert button.

11. Click on the Comparison tab of the Timex window.

The Timex window is displayed with the Comparison tab selected.

12. Determine the end of the Time Range (Friday).

a. Select Day_of_week from the left pull-down menu.

b. Select Less than or Equal from the middle pull-down menu.

c. Select Friday from the right pull-down menu.

The Timex expression is displayed in the Current Timex field (FIGURE 7-40).
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FIGURE 7-40 Setting the End Range to Friday

13. Click the Apply button.

The Timex Editor is updated. The Timex Expression now reads Cycle(1 hours) And

Day_of_week>=Monday And Day_of_week<=Friday (FIGURE 7-41).
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FIGURE 7-41 Timex Editor Showing a Cycle Time of One Hour From Monday to Friday

14. Click the Apply button.

The Sample Interval field in the Attribute Editor is updated. SyMON software will

check the system load average (over five minutes) at every hour, from 12:00 AM

Monday to 12 AM Saturday morning.
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FIGURE 7-42 Updated History Attribute Editor Showing a Cycle Time of One Hour From
Monday to Friday
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▼ To Create a Timex Expression Using the

Absolute and Cron Tabs

Note – This procedure is also valid for a history interval.

1. Click on the Advanced button in the Refresh tab of the Attribute Editor for a data
property.

See “To Set a Refresh Interval” on page 155 for more information.

The Timex Editor is displayed (FIGURE 7-35).

2. If any value is in the Time Expression field, highlight the value and delete it by
clicking the Delete button.

3. Click the Insert button.

The Timex window is displayed with the Cyclic tab selected.

4. Click the Absolute tab.

The Timex window is displayed with the Absolute tab selected.

5. Determine the start time (FIGURE 7-43).

a. Highlight the hour, minute, and if desired, the seconds fields and click the up
or down arrow until the correct time is displayed.

b. Highlight the AM or PM field and click the up or down arrow to display your
choice.

6. Determine the start date. Highlight the month, date, and year fields and click the
up or down arrow until the correct date is displayed.

The starting date and time are displayed in the Current Timex field.
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FIGURE 7-43 Starting Time of 11:39:48 AM on January 1, 1999

7. Click the Apply button.

The starting date and time are displayed in the Timex Editor (FIGURE 7-44).
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FIGURE 7-44 Timex Editor With Starting Time of 11:39:48 AM January 1, 1999

8. Click the Insert button.

9. Click the Cron tab.

The Timex window is displayed with the Cron tab selected.

10. Select the time when the refresh interval is active.

SyMON software does not check the system load average outside the time specified

by this window. In this example, the condition is at 3 AM every Monday through

Friday.

a. Select 0 from the Minute pull-down menu.

b. Select 3rd from the hour pull-down menu.

These first two pull-down menus set the time at 3:00 AM.

c. Select Every from the Day_of_month pull-down menu.

d. Select Every from the Month pull-down menu.

These two pull-down menus set the date for every day.

e. Select Monday from the final pull-down menu.

The Current Timex field reads Cron(03**1). This expression states that the refresh

window is only active at 3 AM every Monday (FIGURE 7-45).
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FIGURE 7-45 Cron Tab Selected With 3 AM Every Monday

11. Type -5 in the Current Timex field so that it reads Cron(03**1-5).

This expression states that the refresh interval is only active at 3 AM every Monday

through Friday (FIGURE 7-46).
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FIGURE 7-46 Cron Tab Selected With 3 AM Every Monday Through Friday

12. Click the Apply button.

The Timex Editor is updated. The Timex Expression now states the starting date and

time And Cron(03**1-5) (FIGURE 7-47).
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FIGURE 7-47 Timex Editor With Starting Time of 11:39:48 AM January 1, 1999 and 3 AM
Every Monday Through Friday

13. Click the Apply button.

The refresh interval field in the Attribute Editor is updated. In this example, the

refresh window is active 3 AM every Monday through Friday after the starting date

and time (FIGURE 7-48).
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FIGURE 7-48 Refresh Interval With Starting Time of 11:39:48 AM January 1, 1999 and 3 AM
Every Monday Through Friday
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▼ To Create an Alarm Schedule Using the

Comparison Tab

Note – This procedure is also valid for a module schedule.

1. Click on the Advanced button in the Alarms tab of the Attribute Editor for a data
property.

See “To Create an Alarm” on page 150 for more information.

The Timex Editor is displayed (FIGURE 7-35).

2. If any value is in the Time Expression field, highlight the value and delete it by
clicking the Delete button.

3. Click the Insert button.

The Timex window is displayed with the Cyclic tab selected.

4. Click the Comparison tab.

The Timex window is displayed with the Comparison tab selected.

5. Determine the start of the Time Range (9 AM).

The time range determines the time period when the SyMON software checks the

system load average. The SyMON software does not check the system load average

outside the time period specified by this window. In this example, the time range is

from 9 AM to 5 PM every day.

a. Select Hour from the left pull-down menu.

b. Select Greater than or Equal from the middle pull-down menu.

c. Select 9 from the right pull-down menu.

The Timex expression Hour>=9 is displayed in the Current Timex field

(FIGURE 7-49).
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FIGURE 7-49 Comparison Tab With Greater Than or Equal to 9 AM

6. Click the Apply button.

The Timex Editor is updated. The Timex Expression now reads Hour>=9. In this

example, both conditions should occur in the alarm window time range. However,

the Timex Editor also enables you to select the Or expression (FIGURE 7-50).
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FIGURE 7-50 Timex Editor With Greater Than or Equal to 9 AM

7. Determine the end of the Time Range by clicking the Insert button.

8. Click on the Comparison tab of the Timex window.

The Timex window is displayed with the Comparison tab selected.

9. Determine the end of the Time Range (Friday).

a. Select Hour from the left pull-down menu.

b. Select Less than or Equal from the middle pull-down menu.

c. Select 17 from the right pull-down menu.

The Timex expression Hour<=17 is displayed in the Current Timex field

(FIGURE 7-51).
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FIGURE 7-51 Comparison Tab With Less Than or Equal to 5 PM

10. Click the Apply button.

The Timex Editor is updated. The Timex expression now reads Hour>=9 And

Hour<=17 (FIGURE 7-52).
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FIGURE 7-52 Timex Editor With Time Interval Between 9 AM and 5 PM

11. Click the Apply button.

The alarm window field in the Attribute Editor is updated. The SyMON software

will check the system load average (over five minutes) from 9:00 AM Monday to 5

PM Friday (FIGURE 7-53).
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FIGURE 7-53 Alarms Attribute Editor With Alarm Window From 9 AM to 5 PM Every Day
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CHAPTER 8

Managing Modules

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

This chapter briefly describes the SyMON modules and explains how to manage

them.

The following topics are covered:

■ Default Modules

■ To Load a Module

■ To Edit Module Parameters

■ To Disable a Module

■ To Enable a Module

■ To Unload a Module

■ To Set a Module Schedule

■ To Set Security Permissions for a Module

SyMON Modules

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Sun Enterprise SyMON modules are responsible for collecting data from specific

monitored resources. These modules can be dynamically loaded, enabled, disabled,

and unloaded into a SyMON agent.
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■ Loading a module adds the module icon to the Browser Details window, defines

the managed object and data properties, and starts data acquisition. The data

properties for the managed object are displayed in the Details window. The data

display is periodically refreshed.

■ Enabling a module restarts data acquisition if the module has been previously

disabled. The data display for the managed object is periodically refreshed in the

Details window.

■ Disabling a module temporarily stops data acquisition for the managed object

until the module is enabled. While a module is disabled, the data is not refreshed.

■ Unloading a module stops data acquisition for the managed object. The managed

object and data properties are undefined and the module icon is removed from

the Browser Details window.

Default Modules

Some or all of the following modules are loaded by default when you install the

SyMON software.

■ Agent Statistics

■ File Scanning

■ MIB-II Instrumentation

■ Kernel Reader

■ Config-Reader (for supported hardware platforms)

Module List

TABLE 8-1 lists SyMON modules that you can load and use.

TABLE 8-1 SyMON Modules

Module Description

Agent Statistics Provides information about the health of the agent installed on a

host by monitoring the objects, processes and execution of processes

by the agent.

Config-Reader Provides the hardware configuration of the host. Both the physical

view and the logical view require that this module be loaded.

Data Logging

Registry

Provides information about data logging in agents including log

destination, module name, logging interval, and buffer length.

Multiple copies of this module can be loaded.
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For more information on modules, see Appendix C.

Directory Size

Monitoring

Enables you to isolate and monitor the size of any directory and its

subdirectories on a host where a SyMON agent is installed. Multiple

copies of this module can be loaded.

Dynamic

Reconfiguration

Enables SyMON users to perform dynamic configuration operations

on DR-enabled monitored hosts.

File Monitoring Monitors selected files on a host. Monitored parameters include file

size and timestamps. Multiple copies of this module can be loaded.

File Scanning Scans files on a host for specified patterns. Multiple copies of this

module can be loaded.

HP JetDirect Monitors the status of HP printers equipped with a JetDirect card.

Multiple copies of this module can be loaded.

Health Monitor Enables you to monitor various resources usage in your host such

as CPU, disk, NFS, and SMNP.

Kernel Reader Provides kernel statistics, such as CPU details, system call, faults,

streams, disk information, and page information.

MIB-II

Instrumentation

Provides the system, interfaces, IP, ICMP (internet control message

protocol), TCP (transmission control protocol), and UDP (user

datagram protocol) MIB-II (management information base) group

information of the monitored host.

MIB-II Proxy

Monitoring

Provides proxy management of hosts that are running non-SyMON

MIB-II SNMP agents. Multiple copies of this module can be loaded.

NFS File Systems Provides information about the NFS file systems on monitored

hosts by monitoring the amount of disk space occupied by mounted

or unmounted file systems and the amount of used and available

space as well as the file system’s remaining total capacity.

NFS Statistics Monitors the number of NFS calls and RPC (remote procedure calls)

received by the server as well as the status of the transaction

activity on the monitored host. Multiple copies of this module can

be loaded.

Print Spooler Monitors the status of the printer daemon and print queue on the

monitored host as well as the printer devices installed on it.

Multiple copies of this module can be loaded.

Process Monitoring Monitors one or more processes on the host. Specifies monitored

processes by matching patterns. Multiple copies of this module can

be loaded.

Solaris Process

Details

Displays detailed information of Solaris processes running on a host

where the SyMON agent has been installed. The Process Details

window requires that this module be loaded.

TABLE 8-1 SyMON Modules (Continued)

Module Description
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Note – The Config-Reader and Dynamic Reconfiguration modules are supported

only on specific hardware platforms. For more information, refer to the SyMON web

site: http://www.sun.com/symon .

Note – Depending on your system hardware, additional modules may be

supported. For more information, refer to the SyMON web site:

http://www.sun.com/symon .

Loading Modules

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

▼ To Load a Module

1. Select the module.

2. Open the Load Module dialog by doing one of the following:

■ Click the right mouse button on the selected host icon and highlight Load Module

from the pop-up menu in the hierarchy view (FIGURE 8-1) or the topology view

(FIGURE 8-2).

■ In the SyMON main console window, select Tools ➤ Load Module (FIGURE 8-3).

■ In the Details window, select Module ➤ Load Module (FIGURE 8-4).
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FIGURE 8-1 Load Module Pop-Up Menu in Hierarchy View
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FIGURE 8-2 Load Module Pop-Up Menu in Topology View

FIGURE 8-3 Load Module Menu in SyMON Main Console Window
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FIGURE 8-4 Load Module Menu in Details Window

The Load Module dialog is displayed (FIGURE 8-5).
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FIGURE 8-5 Load Module Dialog

The Load Module dialog lists all SyMON modules. The number next to the module

name indicates the number of existing instances of that module on your host.

For example, a number 2 next to a module in the Load Module dialog means that

two instances of this module are loaded on your host.

Note – Some modules can have multiple instances loaded on a host.

Note – You must specify a unique name for each instance when multiple instances

of the same module are loaded.

3. Click the name of the module you want to load.
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4. Click the OK button.

The Module Loader dialog is displayed. The contents of the dialog varies with the

module that is selected. FIGURE 8-6 shows a possible example of the dialog.

FIGURE 8-6 Module Loader Dialog
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5. If necessary, type the relevant information into any editable name fields.

For example, the Directory Size Monitoring module requires you to enter the name

of the instance, a description, and the target directory name.

If you do not type in information for a necessary field, the software responds with

an error message and the module is not loaded.

6. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this dialog.

■ Click Reset to undo your changes.

■ Click Cancel to cancel your request.

Note – You can also double-click a module name in the Load Module dialog to load

that module.
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Editing Modules

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The Sun Enterprise SyMON software enables you to edit modules by changing

module parameters and enabling or disabling modules.

FIGURE 8-7 Edit Module Pop-Up Menu in Hierarchy View
Chapter 8 Managing Modules 191



FIGURE 8-8 Edit Module Pop-Up Menu in Contents View
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FIGURE 8-9 Edit Module Menu in Details Window

▼ To Edit Module Parameters

1. Select the selected module.

2. Proceed with one of the following:

■ Click the right mouse button and highlight Edit Module from the pop-up menu in

the hierarchy view (FIGURE 8-7) or the Contents view (FIGURE 8-8).

■ In the Details window, select Module ➤ Edit Module (FIGURE 8-9).

The Module Parameters Editor is displayed.

3. Type the relevant information into the editable fields.

FIGURE 8-10 shows an example. The actual display varies with the module that is

selected.
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FIGURE 8-10 Module Parameter Editor

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Reset to reset the module to the default parameters.

■ Click Cancel to cancel your request.
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▼ To Disable a Module

● Click the right mouse button on the selected module and highlight Disable
Module from the pop-up menu in the hierarchy (FIGURE 8-7) or Contents view
(FIGURE 8-8).

OR

● In the Details window, select Module ➤ Disable Module (FIGURE 8-9).

When the module has been disabled (turned off), the following message is displayed

at the bottom of the Details window (FIGURE 8-11).

FIGURE 8-11 MIB-II Instrumentation Module Is Disabled

▼ To Enable a Module

● Click the right mouse button on the selected module and highlight Enable
Module from the pop-up menu in the hierarchy (FIGURE 8-7) or Contents view
(FIGURE 8-8).

OR

● In the Details window, select Module ➤ Enable Module (FIGURE 8-9).

When the module has been enabled (turned on), the following message is displayed

at the bottom of the Details window.

Module successfully disabled.

Module successfully enabled.

This icon indicates the module is disabled
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▼ To Unload a Module

1. Proceed with one of the following:

■ Click the right mouse button on the selected module and select Unload Module

from the pop-up menu in the hierarchy view (FIGURE 8-7) or the contents view

(FIGURE 8-8).

■ In the Details window, select Module ➤ Unload Module (FIGURE 8-9).

The Confirm Module Unload dialog is displayed (FIGURE 8-12).

FIGURE 8-12 Unload Module Dialog

2. Click the Unload button to remove the module or the Cancel button to cancel this
request.
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Monitoring Modules

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Tip – If you want to monitor one type of module on a number of hosts, you can

create module objects for each host and place all of the objects in a common location

(that is, in the same group or domain). To create a module, see “To Create a Module

Object” on page 59.

Attribute Editor for a Module

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The Attribute Editor for a module provides additional information about the module

and enables you to customize various monitoring criteria. You can use the module

Attribute Editor to set:

■ Module schedules

■ Security permissions

Note – The Attribute Editor consists of a series of one or more tab buttons at the top

of the window that enables you to switch between different panels. The buttons that

are displayed are dependent on the selected object.

Setting a Module Schedule

You may determine when a module should be active and when it should be inactive

by setting a schedule. For example, you can schedule a module to run between 8 AM

and 5 PM every day. At all other times, the module is inactive, whether or not an

alarm condition exists.
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▼ To Set a Module Schedule

1. Open the Attribute Editor for a module by proceeding with one of the following:

■ Click the right mouse button on the selected module icon and highlight Attribute

Editor from the pop-up menu in the hierarchy view (FIGURE 8-1) or the topology

view (FIGURE 8-2).

■ In the Details window, click the Attributes button.

2. Click the Schedule tab (FIGURE 8-13).

3. Click the Advanced button and set the module schedule.

See “Timex Editor” on page 159 for details.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE 8-13 Setting a Module Schedule
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Setting Security Permissions for a Module

You can set security permissions for an individual module.

The security permissions for a module override the default security permissions for

its parent object or host. For example, if a user has administrator privileges for a

module, but only general privileges for the host, the user still retains administrator

privileges for the module. For further information on privileges, see Chapter 11.

▼ To Set Security Permissions for a Module

1. Open the Attribute Editor for a module by proceeding with one of the following:

■ Click the right mouse button on the selected host icon and highlight Attribute

Editor from the pop-up menu in the hierarchy view (FIGURE 8-1) or the topology

view (FIGURE 8-2).

■ In the Details window, click the Attributes button.

2. Click the Security tab (FIGURE 8-14).

3. Type the name(s) of user and administrator groups in the appropriate fields.

4. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Reset to reset the Attribute Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE 8-14 Setting Module Security in the Attribute Editor
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CHAPTER 9

Alarms

This chapter provides details on alarms as they relate to the Sun Enterprise SyMON

version 2.0 product.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The SyMON software monitors your hardware and software and notifies you,

through alarms, when abnormal conditions occur. These alarms are triggered by

conditions falling outside of predetermined ranges, or by SyMON rules. Default

alarm conditions and rules are included in the SyMON modules. In addition, you

may also set up your own alarm thresholds. For a list of SyMON rules, see

Appendix D.

This chapter explains SyMON alarms with the following topics:

■ SyMON Alarms

■ Types of Alarms

■ Creating Alarms

■ Viewing Alarm Information

■ Colored Alarm Icons

■ Seeing Alarms in Domain Status Summary

■ To Access Alarms from the Main Console Window

■ Information on Alarms

■ To Access Alarms from the Alarms Tab in the Details Window

■ Alarm Categories

■ Alarm States

■ To View Alarm Categories

■ To Sort Alarms

■ To Reset the Alarm Table

■ Acknowledging and Deleting Alarms

■ To Acknowledge and Delete Alarms

■ Creating Alarm Conditions

■ To Create Alarm Conditions To Monitor Hosts
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Note – The messages displayed in the Alarms tab of the Details window are always

in English. They are not translated in other languages.

SyMON Alarms

Sun Enterprise SyMON software displays alarm information for managed objects. To

access information on alarms for an object, access the Alarms Details window. This

window displays alarms for a particular object.

Note – The SyMON agent is configured so that only one server receives alarm

information from that agent.

You can acknowledge, delete, and manage the alarms on an object in a domain by

using the Alarms Details window. For more information, see “To Access Alarms

from the Alarms Tab in the Details Window” on page 212.

Types of Alarms

Managed object status is displayed in the Domain Status Summary from the SyMON

main console window (FIGURE 9-1).

FIGURE 9-1 Domain Status Summary in the Main Console Window

Domain Status Summary buttons
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The numbers next to the alarm icons indicate the number of managed objects whose

highest severity open, unacknowledged alarm is represented by the icon. For

example, the number 1 next to the yellow alarm icon indicates that there is a

managed object whose highest severity alarm is yellow (alert). The severity of

alarms are designated by icons. The different icons represent different severities

(FIGURE 9-2).

FIGURE 9-2 Alarm Severities

Down Alarms

A down alarm (severity 1 in FIGURE 9-2) indicates that a service-affecting condition

has occurred and an immediate corrective action is required. An example of this

condition is when a resource defined by a managed object has gone out of service

and that resource is required; for example, a module has gone down (exited).

Down alarms are represented by black alarm icons with a down arrow.
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Critical Alarms

A critical alarm (severity 2 in FIGURE 9-2) indicates that a service-affecting condition

has developed and an urgent corrective action is required. An example of this

condition is when a severe degradation in the capability of an object has occurred

and the object needs to be restored to full capability.

Critical alarms are represented by red alarm icons.

Alert Alarms

An alert alarm (severity 3 in FIGURE 9-2) indicates that a non-service-affecting

condition has developed and a corrective action should be taken in order to prevent

a more serious fault.

Alert alarms are represented by yellow alarm icons.

Caution Alarms

A caution alarm (severity 4 in FIGURE 9-2) indicates the detection of a potential or an

impending service-affecting fault, before any significant effects have occurred.

Action should be taken to further diagnose (if necessary) and correct the problem in

order to prevent it from becoming a more serious service-affecting fault.

Caution alarms are represented by blue alarm icons.

Off/Disabled Alarms

A disabled alarm (severity 5 in FIGURE 9-2) indicates that a resource for a managed

object has been disabled; for example, a module is disabled.

Disabled alarms are represented by white alarm icons with an ‘X’.

Note – Objects with black star icons, that may look like a “splat” on your screen, are

objects with irrational states, not to be confused with alarms, where the status of the

object is unknown or undetermined.

If the black star or splat icon shows up in the main console window, it indicates that

the object is in an irrational state. This means that there has been a data acquisition

failure on that object. The failure does not come out of a rule so there is no alarm

associated with it.

An example of this is presented in FIGURE 9-3.
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FIGURE 9-3 Objects with Irrational States Identified by Black Star or “Splat” Icon

Creating Alarms

SyMON software offers the following flexibility in setting your alarms:

■ Determine the thresholds that trigger an alarm of a particular severity

■ Determine when alarms are sounded (for example, only on weekdays)

For more information on creating alarms, see “To Create an Alarm” on page 150.

Viewing Alarm Information

SyMON uses four methods (FIGURE 9-4) to alert you that an unacknowledged open
alarm condition exists:

■ Relevant row or column is colored in the property table (contents view)

■ Colored icons in the hierarchy (tree) view

■ Colored icons in the topology view

■ Alarms in Domain Status Summary
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Colored Alarm Icons

The type of alarm icon determines the severity of the alarm. For example, a red

alarm icon indicates a critical condition has developed and corrective action is

required right away. By contrast, a blue alarm icon indicates a potential or an

impending service-affecting fault.

In FIGURE 9-4, there is an unacknowledged, open critical alarm in the Swap Statistics

properties table, in the Used KB row. The row is shaded red, which corresponds to

the color of a critical alarm.

The following illustration presents alarms in the Details window.

FIGURE 9-4 Alarms in the Details Window

The colored alarm icons are propagated up the hierarchy tree view, from the

individual module up to the host. For example, in FIGURE 9-4, there is an

unacknowledged, open error condition (critical alarm) in the Swap Statistics icon.

You see this same red alarm icon on the Swap Statistics icon, on the Kernel Reader

icon module, on the Operating System icon, and the host icon.
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In addition, you also see a red alarm icon on the corresponding host, group (if any),

or domain in the SyMON main console window unless an unacknowledged open

black alarm (of higher severity) exists.

Note – Unacknowledged alarms take precedence over acknowledged alarms. If

there are two or more types of alarms in the hierarchy, the color of the more severe

unacknowledged alarm is propagated up the tree. For example, if there is a yellow

unacknowledged alarm in CPU usage, and a red unacknowledged alarm in Disk

Statistics, only the red colored alarm icon is propagated. However, if there is a

yellow unacknowledged alarm in CPU usage, and a red acknowledged alarm in Disk

Statistics, only the yellow colored alarm icon is propagated.

FIGURE 9-5 Alarms in the Contents View

Seeing Alarms in Domain Status Summary

The Domain Status Summary button panel displays the number of managed objects

in the domain that have at least one unacknowledged open alarm of that severity.
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Note – If there are two or more types of alarms in the host, the color of the more

severe unacknowledged open alarm is displayed in the Domain Status Summary.

If the most severe alarm on one host is critical (red) and the most severe alarm on

another host is alert (yellow), then you see the number 1 next to both the red-colored

alarm icon and the yellow-colored alarm icon.

FIGURE 9-6 Domain Status Summary Buttons

▼ To Access Alarms from the Main Console

Window

1. Click on one of the Domain Status Summary buttons in the main console window.
(FIGURE 9-6).

A list of objects which have at least one open, unacknowledged alarm, whose

highest severity is that of the icon on the button, is displayed in the Domain Status

Details window (FIGURE 9-7).

For example, if you click on the button with the yellow alarm icon (alert alarms), the

Domain Status Details window displays a list of objects whose highest severity,

unacknowledged, open alarms are yellow (alert). The number of objects displayed is

equal to the number on the button (within approximately a five second delay

period).

2. Complete this procedure with one of the following actions:

■ Double click on the row in the table.

■ Single click on the row to select it, and then click the Details button.

The Alarms Details window is displayed (FIGURE 9-8).
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FIGURE 9-7 Domain Status Details Window

Information on Alarms

The Alarms tab in the Details window presents a table that contains the statistical

summary of all alarm data for a given managed object.
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▼ To Access Alarms from the Alarms Tab in the

Details Window

1. Click with your right mouse button on the selected host icon in the SyMON main
console window and highlight Details from the pop-up menu.

The Details window is displayed.

2. Click on the Alarms tab button.

The Alarms Details window is displayed (FIGURE 9-8).

FIGURE 9-8 Alarms Tab Data from the Details Window
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Alarm Categories

The Alarms tab presents different categories of detailed alarm information. Some of

this information is always displayed in the alarms table (TABLE 9-1) while additional

information is displayed when an alarm row is highlighted (TABLE 9-2).

Note – Acknowledged alarms are indicated with a green check in the Severity

column.

Alarm States

There are also two different alarm states:

■ Open

■ Closed

An Open alarm is one in which the condition which caused the alarm still exists. A

Closed alarm means the condition no longer exists. Open alarms are “ringing” while

closed alarms are “silent” (FIGURE 9-9).

TABLE 9-1 Alarm Categories Displayed in Table

Category Description

Severity Graphic indicator whose color indicates the severity of the alarm;

black is most severe and white is least severe

Start time Time the alarm first occurred

State Open or closed

Message Abbreviated message that indicates the type of alarm

TABLE 9-2 Alarm Categories Displayed When a Row is Selected

Category Description

Condition began on Date/Time the alarm condition has started

Condition ended on Date/Time the alarm condition has been fixed

Acknowledged on Date/Time the alarm was acknowledged by a particular user

Rule Name that identifies the rule file which caused the alarm (for

example, a rule number). For non-rule based alarms, the name

rCompare is used.
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FIGURE 9-9 Open and Closed Alarms

▼ To View Alarm Categories

The Alarm Details window has an option that enables you to filter a selected alarm

category and show a subset of the alarms.

1. Click on the Show button below the Table actions field.

The Show Specific Alarms window (FIGURE 9-9) is displayed.

2. Click on the appropriate tab to filter your alarm request.

The selected tab is darkened.

Note – If you want to see all the alarms in the alarms table, simply click the Show

All button.

3. Click on the Severity tab (FIGURE 9-2).

The Severity tab enables you to show alarms of the selected severity.

4. Click on the check box next to a severity to show alarms of that severity.

The selected severity has a check in the check box next to its name.
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Note – You may select one or more types of severity to show in the alarms table.

5. Click on the State tab (FIGURE 9-9).

The State tab enables you to show open and closed alarms.

6. Click on Open or Closed to show these types of alarms.

The selected state has a check in the check box next to its name.

Note – You may select open, closed, or both to show in the alarms table.

7. Click on the Acknowledge tab.

The Acknowledge tab enables you to show acknowledged and unacknowledged

alarms.

8. Click on Acknowledged or Unacknowledged to show these types of alarms.

The selected state has a check in the check box next to its name.

Note – You may select acknowledged, unacknowledged, or both to show in the

alarms table.

9. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

▼ To Sort Alarms

You can sort the alarm rows in the table (FIGURE 9-10).
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FIGURE 9-10 Sort Alarm Table

1. Click on the Sort button below the Table actions field.

The Sort Alarm Table window is displayed.

2. Select your sort feature by clicking in the circle next to your selection.

You may sort by starting time (from the newest alarm to the oldest alarm), by

severity (from the most severe to the least severe), or by state (with open alarms

listed first, followed by closed alarms).

The selected sort feature has a darkened circle next to its name.

3. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Apply to apply your changes without closing this window.

■ Click Cancel to cancel your request.

▼ To Reset the Alarm Table

● Click the Reset button.

The alarm table is dynamically updated as new alarms are displayed and some

existing ones close. These changes are part of the alarm data accessed from the

Alarms tab in the Details window, regardless of what is selected as the Show button

viewing options. As these conditions occur over time, the table may no longer reflect

the current Show settings. Clicking the Reset button will update the table to reflect

the current Show settings once again.
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Acknowledging and Deleting Alarms

You may update information about alarms in the Alarms Details window.

▼ To Acknowledge and Delete Alarms

1. Select the alarms you want to update by clicking the selected row(s) in the table.

Clicking the selected row(s) displays additional information associated with that

alarm. The additional information consists of the starting time of the alarm, the

ending time of the alarm, the acknowledgment time and the user who

acknowledged the alarm, and the rule.

Note – You may select several rows at once by holding down your mouse button

and moving the mouse over the selected rows. If, after you selected several rows,

you want to skip a few rows and select other rows, simply hold down the Control

key and select the additional rows.

2. Click the appropriate button under the Alarm actions field.

You may perform the actions listed in TABLE 9-3.

Note – You can delete open alarms, but the potential exists for alarm information in

the Alarms windows to differ from alarm information in the hierarchy view and the

topology view. That is, the alarms are deleted from the alarms table, but the alarm

icons may still be present in the hierarchy and topology views. For example, in the

case of an unloaded module, orphaned alarms may remain in view and need to be

manually deleted.

TABLE 9-3 User Actions That Can Be Performed on Alarms

User Action Description

Acknowledge User and time of acknowledgment is registered. When an alarm is

acknowledged, the alarm icon in the Severity column has a green

check mark beside it.

Delete Deletes all the selected alarms from the table. The deleted alarm(s)

is saved into an archive file on the server.

Delete all Deletes all the closed alarms from the table. The deleted alarm(s) is

saved into an archive file on the server.
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Caution – You should only delete open alarms when there is no other method to

remove these alarms.

Creating Alarm Conditions

SyMON enables you to create alarm conditions that help you to monitor the hosts in

your domain. The main purpose of this section is to help you create alarm conditions

and familiarize yourself with their operation. This will help you control alarm

conditions.

▼ To Create Alarm Conditions To Monitor Hosts

1. Navigate through the Operating System modules until you see the User Statistics
icon (part of the Kernel Reader module).

2. Select Attribute Editor from the pop-up menu.

The Attribute Editor enables you to edit information about this property.

3. Create an alarm condition by following the procedure in “To Create an Alarm” on
page 150.

4. Click on the Alarms tab button in the Details window.

The alarm you created should be reflected in the Alarms table.

5. Acknowledge, then delete this alarm if the alarm is closed.

6. Create additional alarm conditions and familiarize yourself with their operation.

Once you have created these alarms, you can set up security permissions so that

another SyMON user cannot change your alarms. For information on accomplishing

this task, see Chapter 11.
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CHAPTER 10

Details

The Sun Enterprise SyMON Details window provides detailed information about a

selected object.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The following topics are covered in this chapter unless noted otherwise:

■ Starting the Details Window

■ Info Tab

■ Browser Tab (covered in Chapter 7)

■ Alarms Tab (covered in Chapter 9)

■ Processes Tab

■ Configuring the Process Display

■ Process Statistics Window

■ Process Summary Field

■ Log View Tab

■ Filtering Your Messages

■ Finding Specific Log Messages

■ Configuration Tab

■ Resources

■ Physical View

■ Dynamic Reconfiguration

■ Logical View

The Details window displays up to six tab buttons (TABLE 10-1). Clicking a tab button

updates the window with a new panel.
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Note – If a feature (such as configuration details) is not supported for a specific

object, the corresponding tab is not displayed.

TABLE 10-1 Details Window Tab Buttons

Tab Button Description

Info Provides general information such as host name, IP address, and

polling type.

Browser Enables you to navigate through the hierarchy and contents views

of the hardware, operating system, local applications, and remote

systems (for navigation purposes). (The Browser is covered

separately in Chapter 7.)

Alarms Displays alarm status messages and the alarm controls for the host

or node. Enables you to acknowledge or delete alarms. (Alarms are

covered separately in Chapter 9.)

Process Displays information about processes running in the host.

Logview Displays entries from host log files (such as system message logs).

Configuration Displays configuration information (resources, physical view,

logical view, and dynamic reconfiguration status and controls), if

available, for a host.
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Starting the Details Window

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

You can start the Details window from the Sun Enterprise SyMON main console

window.

▼ To Start the Details Window

1. Double click the left mouse button on an object icon in either the hierarchy view
or the topology view.

Be sure to select an object, not a domain, as the Details window is not available for

domains.

The Details window is displayed (FIGURE 10-1).
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FIGURE 10-1 Details Window for a Selected Object

2. Click a tab to view detailed information for that category.

Tip – Some tabs have the ability to display many levels of detail. Double-click icons

in the Details window to see additional levels of information. A category may have

many subcategories.

Tip – If information in a table cell is too long to be displayed in full, you may be

able to see more information by holding the mouse pointer in the cell for several

seconds. A pop-up balloon (tool tip) is displayed, showing the complete text

contained in that cell.
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Tip – If the hierarchy view has a light-colored circle next to an icon (FIGURE 10-2),

you can click the circle or double-click the icon next to the circle to expand the

hierarchy view (“unroll” and display more levels of detail).

FIGURE 10-2 Light-Colored Circles “Unroll” to Provide Additional Levels of Detail

▼ To Close the Details Window.

● Click the Close button located at the bottom of the window.

Circle
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Info Tab

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Clicking the Info tab displays the Properties table.

The general properties are listed in the following table.

TABLE 10-2 General Properties in the Info Tab of the Details Window

Property Description

Entity Desc Label that you selected when you created the node.

Entity Full Desc Optional description you entered when you created the node.

Hostname Machine name.

IP Address IP address.

Netmask Netmask associated with the host.

Operating System Operating system type and version.

Entity Family Hardware architecture.

Entity Trap Destination Host IP address of SyMON server which receives this host’s

trap information.

Entity Event Destination Host IP address of SyMON server which receives this host’s

events information.

Entry IsPolling Indicator True or false.

Entry Polling Type Agent or SNMP.

Target Hostname Host name of the target.

Target IP Address IP address of the target.
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Browser Tab

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The Browser tab displays hierarchy and contents views of the hardware, operating

system, local applications, and remote systems.

See Chapter 7 for detailed information on using the Browser tab.

Alarms Tab

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The Alarms Details window displays the alarms for the host.

See Chapter 9 for detailed information on using SyMON alarms.

Processes Tab

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The Processes tab process viewer (FIGURE 10-3) enables you to view and select

detailed information about processes running on the selected host or node. The

displays are continually updated.

Note – The Solaris Process Details module must be loaded to use the process

viewer. For instructions, see “To Load a Module” on page 184.
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Note – If the Solaris process module is not loaded when you first click the Process

tab, then you must load the module, and close then reopen the Details window to

see the processes. Thereafter, the Solaris Process Details module is unloaded or

loaded dynamically. That is, you no longer need to close and reopen the Details

window to see the processes whenever this module is unloaded or loaded.
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FIGURE 10-3 Processes Tab
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Configuring the Process Display

▼ Selecting Columns for Viewing

1. Click the View Columns button above the Process table to display the View
Columns pull-down menu.

A pull-down menu is displayed (FIGURE 10-4) that enables you to add or remove

columns from the table.

FIGURE 10-4 View Columns Menu
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2. Highlight one or more process properties that you want to display.

The check box next to each selected property is displayed with a check mark

(FIGURE 10-4) and the right side of the Process Viewer window is updated. The new

column or columns are added to the display, to the right of the existing columns.

The total number of processes displayed is listed in the Process Summary field at the

bottom of the Details window.

TABLE 10-3 lists the properties that are available for the Processes view.

TABLE 10-3 Process Viewer Properties

Property Description

PID Process Identifier.

PPID Process ID of the parent.

UID Effective user ID number.

User Effective user login name.

EUser Effective user ID.

Group ID Group ID of the user.

EGroup Effective group ID of the user.

Session ID Process ID of the session leader.

PGroup Process ID of the process group leader.

tty Controlling terminal for the process. A question mark (?) is printed

when there is no controlling terminal.

Start time Starting time of the process, in hours, minutes, and seconds. (The

start time for a process that is more than 24 hours old is given in

months and days.)

Time Cumulative execution time for the process.

State State of the process.

Wait Channel Address of an event for which the process is sleeping. If blank, the

process is running.

Class Scheduling class of the process.

Address Memory address of the process.

Size Size (in pages) in main memory for the image of the swappable

process.

Priority Priority of the process.

Nice Decimal value of the system scheduling priority of the process.
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Sorting Columns

You can sort the processes (rows) by the properties (column headers) in ascending or

descending order. For example, you can sort the CPU% column starting with either

the smallest or the largest value first.

▼ To Sort Columns in Ascending Order

● Click the property (table column header).

The processes (rows) are updated in ascending order for that property.

▼ To Sort Columns in Descending Order

● Click the property (table column header) while holding down the Shift key.

The processes (rows) are updated in descending order for that property.

Moving Columns

You can rearrange the order of columns.

▼ To Reorder Columns in the Table

1. Select a column by clicking and holding down the mouse button on the table
column header.

2. Drag the column to the desired position.

CPU% Ratio of CPU time used recently to CPU time available in the same

period, expressed as a percentage.

Memory% Ratio of the process’s resident set size to the physical memory on

the machine, expressed as a percentage.

Command Command name.

CommandLine Full command name and its arguments, up to a limit of 80

characters.

TABLE 10-3 Process Viewer Properties (Continued)

Property Description
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Process Statistics Window

The Output For Process I.D. window displays statistics for your choice of either

pmap, pstack, pfiles, or pldd for any highlighted process in the Process View

window.

Process Summary Field

The Process Summary field lists statistics for all processes, active or inactive.

TABLE 10-4 Process Statistics

Statistic Description

pmap Prints the address space map of each process.

pstack Prints a stack trace for each lightweight process (lwp) in each

process.

pfiles Reports fstat(2) and fcntl(2) information for all open files in

each process.

pldd Prints dynamic libraries for the process.
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Log View Tab

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The log viewer (FIGURE 10-5) enables you to view system log messages and logged

error messages from SunVTS.
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FIGURE 10-5 Logview Tab

Log File Type Button

You can view two types of messages:

■ System log messages stored in the /var/adm directory

■ SunVTS error messages

File names in the /var/adm directory start with the word “messages”. If Sun VTS is

installed, it writes by default to the /var/opt/SUNvts/logs/Sunvts.err file.
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▼ To View the Log File Messages

● Click the down arrow under the Log file type field and highlight either Syslog or
SunVTS.

The selected type of messages is displayed in the log viewer table.

Note – Click the Reload button to refresh the display and add the latest log

messages.

Filtering Your Messages

You can apply filters to display only those messages that match the date range and

text pattern that you specify.

▼ To Filter Your Log Request

1. Click the Filter button in the log viewer (FIGURE 10-5).

The Message Filter Options dialog is displayed (FIGURE 10-6).
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FIGURE 10-6 Message Filter Options Dialog

Note – If you do not want any filters applied to your log messages, click the “No

Filters” button.

2. Using the down arrows, select the starting date by highlighting the month, day,
and year for the first log message you want to view.

3. Select the starting time by using the down arrows.

Highlight the hour and minute for the first log message you want to view.

4. Select the ending date.

Highlight the month, day, and year for the last log message you want to view.

5. Select the ending time.

Highlight the hour and minute for the last log message you want to view.

6. Type the text pattern to be matched in the field marked “Text pattern to match.”
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Note – Select a text pattern that is unique to the type of message in which you are

interested.

7. Click the Advanced button if you want to further refine your filter request.
Otherwise, skip to Step 10.

The advanced Message Filter Options dialog is displayed (FIGURE 10-7).

FIGURE 10-7 Advanced Message Filter Options Dialog

8. To display filtered messages in ascending or descending order click the circle next
to Forward or Backward.
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9. (Optional) Type the maximum number of log messages that should be matched in
the field marked Maximum matches to report.

If you leave the field empty or if you enter zero (0), all matching messages are

reported.

10. Complete this procedure with one of the following actions:

■ Click OK to filter and reload your log messages and close this window.

■ Click Apply to filter and reload your log messages without closing this window.

■ Click Reset to reset to the default parameters.

■ Click Cancel to cancel your request.

Reload Button

Click the Reload button to refresh and reload filtered messages.

Monitor Button

Monitoring enables you to view new log messages as they occur. The new messages

are displayed in the lower half of the split pane window. With your mouse button,

you can adjust the dividing bar between the upper half and the lower half of the

split pane window to view more of one half than the other. Each new message that

arrives is highlighted.

▼ To Monitor Log Messages

1. Click the Monitor button in the log viewer (FIGURE 10-5).

The Monitor Filter Options dialog is displayed (FIGURE 10-8).
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FIGURE 10-8 Monitor Filter Options Dialog

2. Click the appropriate circle to enable or disable log file monitoring.

The darkened circle indicates your choice.

3. To display only currently monitored log messages, click the check box to clear old
monitored messages.

The check box is displayed with a check mark.

4. Type the text pattern to be matched in the field marked Text pattern to match.

You can use a UNIX regular expression. For information about regular expressions,

refer to the regex(1F) man page.

Note – Select a text pattern that is unique to the type of message in which you are

interested.

5. Complete this procedure with one of the following actions:

■ Click OK to monitor your log messages and close this window.

■ Click Apply to monitor your log messages without closing this window.

■ Click Cancel to cancel your request.

Finding Specific Log Messages

Once a set of filter messages has been loaded into the upper half of the split pane

window, you can search for a specific character sequence within that set of messages.
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Note – No meta characters, including the wildcard asterisk (* ) character, are

supported in the log view find feature.

▼ To Find a Log Message

1. Type the specific character sequence (part of the log message) in the Find field
(FIGURE 10-5).

2. Click Return or the down or up arrow to search the log messages for that
sequence.

The first matching message is highlighted.

3. Click Return or the down or up arrow to continue your search and find additional
occurrences of the matching sequence.

Configuration Tab

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Note – The Configuration tab is grayed out if this feature is not supported on your

system.

The Configuration Details window (FIGURE 10-9) provides three choices for system

information:

■ Resources (default view)

■ Physical View

■ Logical View
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FIGURE 10-9 Configuration Details Window

▼ To View a Configuration

Note – If you load or unload the Config-Reader or Dynamic Reconfiguration

modules while the Details window is open you must close, then reopen the Details

window to see the results.

● Click once to highlight the configuration in which you are interested.

The right side of the window is updated and the selected feature is displayed.
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Resources

The SyMON software displays a table of hardware resources of the selected host

(FIGURE 10-9).

TABLE 10-5 Resources

Resource Description

Total Disks Total number of disks connected to the host

Total Memory Total amount of memory connected to the host

Total Processors Total number of processors connected to the host

Total Tape Devices Total number of tape devices connected to the host
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Physical View

When you select the Physical view, SyMON software displays a photo-realistic

picture of the selected host (FIGURE 10-10), if available. Pictures are not available for

some system types.

FIGURE 10-10 Configuration Physical View

View Points

If a picture of the system is available, it is displayed. For some systems, you can

select alternate front, rear, and side views by selecting entries in the View Points

pull-down menu. Pictures are not available for some system types.
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For some systems, pictures of components such as CPU boards and I/O boards may

also be available. As you move the mouse pointer over various parts of the system

picture, the mouse pointer changes from an arrow to a hand icon when a detailed

picture is available for an individual component. At such times, the individual

component is highlighted, and the path name of the component is displayed in the

Component field at the bottom of the window. You can click a highlighted

component to display the detailed picture of the component (FIGURE 10-11).

FIGURE 10-11 Component Physical View

The arrow buttons below the picture enable you to switch between system and

component views.
Chapter 10 Details 243



Dynamic Reconfiguration

Where available, Dynamic Reconfiguration enables service personnel to add,

remove, or replace hardware units such as system boards while the system is

powered up and running. Dynamic Reconfiguration also enables boards to be

reserved in a powered-up and inactive state for immediate use as spare units. This

feature is only available on systems that have boards and slots designed for

hot-plugging.

If the Dynamic Reconfiguration feature is supported on your system, and if the

SyMON Dynamic Reconfiguration module is loaded, you can click the Dynamic

Reconfiguration button to display the Dynamic Reconfiguration window

(FIGURE 10-12).

FIGURE 10-12 Dynamic Reconfiguration Window

Where applicable, the System Boards field lists all slots in the card cage and shows

the status of all slots and their occupants.

[194.150.151.52]
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The Details field shows the state of a selected slot and its occupant (if any). The

Condition field shows the status of the board occupying that slot. The Information

field shows when the board was installed in the slot. The Board Physical ID field

shows the system designation for the board.

The Configure, Unconfigure, Connect, and Disconnect buttons are grayed out as

required by the condition of the board and slot. For information on the proper use of

these functions, refer to the Dynamic Reconfiguration user’s guide for your system.

Show Details

Clicking the Show Details button (see FIGURE 10-10) displays the Property/Value

view (FIGURE 10-13), which displays text describing the node that is selected in the

View Points view. The button toggles between Show Details and Hide Details.

Clicking the Hide Details button turns off the Property/Value view.

FIGURE 10-13 Property/Value View
Chapter 10 Details 245



Note – Views of external storage devices are not fully supported by the Physical

view at this time. Some devices such as a disk array may be shown as individual

disks.

Logical View

The SyMON software displays a Logical view configuration of a host (FIGURE 10-14)

if the host is monitored by a SyMON agent. (Logical views are not available for ping

hosts.)

FIGURE 10-14 Configuration Logical View
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Search

Clicking the Search button displays the Search window (FIGURE 10-15). Use the

Search window to search for components in the Logical View window.

FIGURE 10-15 Search Window

Tip – The Search function is case-sensitive and can find the term “board” but not

“Board.” The error message “Node not found” is displayed at the bottom of the

Details window if the search does not locate the component in your system.

Tip – The Search function stops at the first instance found. For example, if you enter

the word board , Search always stops at board(0) . To find board #2, enter enough

of the board name. For example, board(2) or just ard(2) are sufficient to identify

the specific target uniquely.

Dynamic Reconfiguration

The Dynamic Reconfiguration feature in the Logical View is the same as is described

in the previous section, “Physical View” on page 242.

Show Details

The Show Details feature in the Logical View is the same as is described in the

previous section, “Physical View” on page 242.
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CHAPTER 11

SyMON Security

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Security in SyMON 2.0 software is based on Java security classes and SNMPv2 usec

(SNMP version 2, user-based security model) security standards. This chapter

discusses SyMON security features, users and groups, and their privileges.

SyMON software offers the following layers of security:

■ Only valid SyMON users can use the SyMON software.

■ SyMON software enables you to set security permissions or access control

categories and provides control at the domain, group, host, and module levels.

■ It authenticates user login and access control for individual managed properties.

This chapter contains the following information:

■ Access Control (ACL) Categories

■ SyMON Users

■ SyMON Groups

■ Admin, Operator, and General Functions

■ Specifying Access Control (ACL)

■ Admin, Operator, and General Access

■ SyMON Remote Server Access

■ Using Access Control (ACL)

■ To Add SyMON Users

■ To Access ACL on a Module

■ To Add a User-Defined Group to an ACL

■ To Delete SyMON Users

■ Default Privileges

■ Topology Manager Default Privileges

■ Other SyMON Component and Module Default Privileges

■ Overriding the Default Privileges

■ To Override Default Privileges
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Access Control (ACL) Categories

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

SyMON software offers the following Access Control (ACL) categories:

■ Admin, like the superuser (root ) in UNIX

■ Operator, as an operator who runs and monitors the system

■ General, like guest access with read-only viewing privileges

To understand ACL categories, we first need to understand SyMON users and

groups. The following sections explain SyMON users and groups.

SyMON Users

SyMON users are valid UNIX users on the server host. As such, the system

administrator has to add valid users into the following file;

/var/opt/SUNWsymon/cfg/esusers.

If a user’s name is not in this file, that user cannot log into SyMON unless the user

logs in as espublic or esmaster since these two user names are part of this file.

(See the following section for more information.)

Note – You need to clean up the /etc/group file if you have a previous version of

the product.

Public and Private Users

During the SyMON server setup, the file /var/opt/SUNWsymon/cfg/esusers is

created and the following users are added to the file automatically:

■ espublic
espublic is comparable to logging into a UNIX system as guest . It enables

users to use SyMON “general” privileges. For example, when a user tries to

access information from a session running in a different SyMON server from their

own, they are given access as espublic and are able to view the information as a

guest only.
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■ esmaster
esmaster is comparable to being superuser in UNIX. It automatically gives

“admin” access privileges to users logging into the SyMON software.

The administrator has to add the additional list of user IDs for all other users who

need to log into SyMON. All users in this file have “general” access privileges, by

default, unless they are given additional privileges using the procedures described

in “Using Access Control (ACL)” on page 257.

Note – The user names espublic and esmaster are not configurable during

installation. They must specifically be defined as espublic and esmaster .

General Users

Any user who is part of the esusers file is known as a “general” SyMON user.

SyMON general users can, by default, perform the following functions:

■ Log into SyMON software

■ View the domains, hosts, and modules that are created

■ View the events

■ Trigger manual refreshes

■ Run ad hoc commands

■ Graph data

SyMON Superuser

Implicitly, the SyMON superuser belongs to all the groups described in the

following sections. SyMON superuser has “admin” privileges as described in

“SyMON ADMinistrators or esadm” on page 252.

SyMON Groups

The following SyMON groups are created by default on the server host during the

SyMON server setup:

■ esops
■ esadm
■ esdomadm

In addition, all the SyMON users belong to a hypothetical group, called ANYGROUP.
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The above groups must be defined on the machine where the SyMON Configuration

manager is running. They do not need to be defined on other machines. These

groups are described in greater detail in the sections that follow.

Note – The preceding groups are defined in the /etc/group file. Note that

although SyMON esmaster and espublic users are configured as members of the

preceding groups, they are not explicitly mentioned in the /etc/group file.

SyMON OPeratorS or esops

SyMON software users belonging to the group esops are usually referred to as

operator users who run, monitor, and to some extent, configure some parameters on

the managed systems. As you can see in the following list, esops can perform

operations, including some that are allowed for SyMON general users:

■ Disable or enable modules

■ Set module active time window

■ Set alarm limits

■ Set rule parameters

■ Run alarm actions

■ Run adhoc commands

■ Set refresh interval

■ Acknowledge, delete, or fix events

■ Enable or disable history logging

■ Set logging history parameters

SyMON ADMinistrators or esadm

SyMON software users belonging to the group esadm can perform “admin”

operations, which are a superset of the operations that can be performed by operator

users as described in “SyMON OPeratorS or esops ” on page 252. In addition to all

the operations that “operator” users (esops ) can perform, these “admin” users

(esadms) can perform the following operations:

■ Load or unload modules

■ Set ACL users and groups

■ View domains, hosts, or modules

SyMON DOMain ADMinistrators or esdomadm

The SyMON users belonging to the group esdomadm can perform the following

“domain administrator” operations:

■ Create domains
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■ Create groups within domains

■ Add objects to groups or domains

■ View domains, hosts, or modules

Note – Other than the privileges listed above, a SyMON user belonging to

“esdomadm” is just a “general” user, unless configured otherwise.

Admin, Operator, and General Functions

TABLE 11-1 contains the different types of functions users can do by default.

This table is general in nature and applies to all modules. Individual modules may

also have specific restrictions, which are under the control of the module.

TABLE 11-1 Domain Admin, Admin, Operator, and General Functions

Function Domain Admin Admin Operator General

Load modules x

Unload modules x

Create domains x

Create groups within domains x x

Add objects to groups or

domains

x x

View domains, hosts or

modules

x x x x

Set ACL users or groups x

Disable or enable modules x x

Set module active time

window

x x

Set alarm limits x x

Set rule parameters x x

Run alarm actions x x

Run adhoc commands x x

Set refresh interval x x

Manually trigger a refresh x x x
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In SyMON software, the above categories maintain inclusive relationships or

privileges. This means that, by default, a user who has esadm privileges can do

anything that a user who has esops privileges can. But an administrator has the

option to change the default permissions so that a user who has esops privileges

can do more than a esadm user. Inclusive relationships means that these three

groups, esops , esadm, and esdomadm, do not have any code enforcement behind

them which makes one group more powerful than the other.

For more information on how to override default privileges, see “Overriding the

Default Privileges” on page 263.

Specifying Access Control (ACL)

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The SyMON administrators (esadm group) can specify ACL features for users and

groups for the following:

■ Domains

■ Groups within domains

■ Hosts

■ Modules

Admin, Operator, and General Access

An ACL specification consists of establishing or defining one or more of the

following:

Enable or disable history

logging

x x

Set logging history parameters x x

Acknowledge, delete or fix

events

x x

View events x x x

TABLE 11-1 Domain Admin, Admin, Operator, and General Functions (Continued)

Function Domain Admin Admin Operator General
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■ Administrator users and administrator groups

A list of users and groups who can perform administrator operations. By default,

they are esadm or esdomadm, wherever applicable.

■ Operator users and operator groups

A list of users and groups who can perform operator operations. By default, they

are esops .

■ General users and general groups

A list of users and groups who can perform general operations. By default, this is

a hypothetical group called ANYGROUP.

■ Communities for administrators (SNMP)

A list of SNMP communities that can perform admin operations using SNMP

protocol.

■ Communities for operators (SNMP)

A list of SNMP communities that can perform operator operations using SNMP

protocol.

■ Communities for general (SNMP)

A list of SNMP communities that can perform general operations using SNMP

protocol.

SyMON Remote Server Access

SyMON users can access and view data from sessions running on remote SyMON

servers. When a user tries to gain access to such information, that user is provided

access as espublic (guest) with read-only privileges. The behavior of SyMON

sessions running on different servers is defined in terms of each session’s server

context. See “SyMON Server Context” on page 256 for more information.

As a user, you can access and set up a different server context for a variety of

reasons:

■ To provide for separate security access privileges so that each server context

could have different users and administrators and yet be accessible to each other

■ To allow for physical separation between elements, as in the context of a wide

area network (WAN)

■ To increase performance since this would allow many hosts to be handled by one

set of central components

By linking to a different server context, you can view the top level status of the

objects in the other server context.
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SyMON Server Context

In SyMON 2.0 software, a server context is defined as agents running on many hosts,

all sharing a single set of the following central components:

■ SyMON server

■ Topology manager

■ Event manager

■ Trap handler

■ Configuration manager

A server context is defined as a collection of SyMON agents and the particular

server layer to which the console is connected. Agents within the same server

context can talk to each other. Agents in remote server contexts can talk using

read-only privileges.

Every SyMON component or agent is configured at installation to know the location

of its Trap handlers and Event managers. SyMON identifies the Trap handlers and

the Event managers by their IP or port addresses. This means that if you want to

determine if you are within your server context or are accessing information from

another server context, you need to know the respective IP or port addresses of the

servers that you access. Different server contexts have different port numbers.

A remote server context refers to a collection of SyMON agents and a particular

server layer with which the remote SyMON agents are associated.

FIGURE 11-1 Remote Server Context

An agent gets its security configuration from the server layer. For example:

Server context 1 Server context 2

SyMON server

SyMON
agent

SyMON
console

SyMON server

SyMON
agent

SyMON
agent
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■ Agents within the same server context can talk to each other.

■ Agents in remote server contexts can talk remotely using read-only privileges.

■ Requests to agents in remote servers are performed as the SyMON espublic
user. This allows successful requests across servers, as long as SyMON sessions

on both servers have the same password for user espublic .

■ Each SyMON server maintains a list of agent IP or port address, to distinguish

objects in its own context from objects on a different SyMON server.

Limitations While Crossing Servers

Some security restrictions apply when a user tries to communicate across server

contexts.

In the current SyMON environment, you can access information from another server

with a few limitations:

■ If you try to access a different or remote server context, the server give you access

with espublic user privileges. Thus you can access data but cannot modify or

use the objects within the different server. You are restricted only to viewing the

remote server objects. Therefore, the following consequences apply:

■ You can access other server contexts as long as the espublic user password is

the same in all contexts.

■ You can view data in another context as user espublic , but you cannot

perform control actions, such as setting alarm thresholds, and other similar

functions.

■ Edit functions work differently in a remote server. For example, you can copy and
paste between contexts but cannot cut and paste between contexts.

Note – From a graphical user interface perspective, it is important to note that it

may not obvious that you are accessing a different server context. To identify if you

are accessing a different server, check the server’s IP port number or address in the

Info tab of the Details window.

Using Access Control (ACL)

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.
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The following sections describe how to perform the following key ACL functions:

■ To Add SyMON Users

■ To Access ACL on a Module

■ To Add a User-Defined Group to an ACL

■ To Grant a User esadm, esops , or esdomadm Privileges

■ To Delete SyMON Users

▼ To Add SyMON Users

1. Become superuser (on the SyMON server host).

2. Edit the file /var/opt/SUNWsymon/cfg/esusers . Make sure that the user name
is that of a valid UNIX user.

3. Add the user name on a new line.

4. Save the file and exit the editor.

Note – By adding a user to the SyMON users list, the user has default privileges.

See “Default Privileges” on page 262 and “Overriding the Default Privileges” on

page 263 for more information.

▼ To Access ACL on a Module

1. Proceed with one of the following:

■ Click the right mouse button on the selected object and highlight Attribute Editor

from the pop-up menu.

■ Select Tools ➤ Attribute Editor in the SyMON main console window.

The Attribute Editor is displayed. The buttons at the bottom of the window are

grayed out, with the exception of the Cancel and Help buttons. The remaining

buttons become active if you modify any field in the window.

2. Select the Security tab within the Attribute Editor window (FIGURE 11-2).

3. Change the values as required.

For example, you may enter data as follows:
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FIGURE 11-2 Example of Security Fields in the Attribute Editor

Note – Use spaces between multiple entries as illustrated in the entries for

“Operator” under “Users.”
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The preceeding example of the Attribute Editor with the Security tab selected

contains the following field entries:

▼ To Add a User-Defined Group to an ACL

1. Become superuser.

2. Create a group:

3. Add users to the newly created group:

a. Edit the /etc/group file.

b. Add users to the group.

c. Save the file and exit the editor.

TABLE 11-2 Security Attributes

Attribute Description

Administrator Users A list of users. jiten is a SyMON user who can perform

administrator operations

Operator Users A list of operators. john and others are SyMON users who can

perform operator operations. Note that their entries are separated

by one or more spaces

General Users A list of general users. Here, nick and richie are SyMON users

who can perform general operations

Administrator

Groups

All the users belonging to esadm and administrators can perform

administrator operations. By default, they are esadm or esdomadm,

as applicable

Operator Groups All users belonging to esops can perform operator operations

General User Groups ANYGROUPis a hypothetical group that can perform general

operations. All SyMON users belong to this hypothetical group

Communities for

Administrators

This field is empty denoting that there is no SNMP community that

can perform admin operations using the SNMP protocol

Communities for

Operators

This field is empty denoting that there is no SNMP community that

can perform operator operations using the SNMP protocol

Communities for

General Users

espublic is an SNMP community that can perform general

operations using the SNMP protocol

# /usr/sbin/groupadd groupname
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4. Add the new group to the ACL of interest.

See “To Access ACL on a Module” on page 258 for more information.

▼ To Grant a User esadm, esops , or esdomadm
Privileges

1. Become superuser.

2. Make sure that the user is a valid SyMON user.

You may do this by adding the user to the /var/opt/SUNWsymon/cfg/esusers
file.

3. Edit the /etc/group file.

4. Add the user to one of the following lines as applicable: esadm, esops , or
esdomadm.

5. Save the file and exit the editor.

▼ To Delete SyMON Users

1. Become superuser on the SyMON server host.

2. Edit the file /var/opt/SUNWsymon/cfg/esusers .

3. Delete the line corresponding to the user name you want to delete.

4. Save the file and exit the editor.

5. Delete the user names from additional SyMON groups.

After a user is deleted from the list of SyMON users, the user can no longer log into

the SyMON server. Make sure to delete that user from all the ACLs.
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Default Privileges

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Domains are manipulated by the Topology manager. This section illustrates the

default privileges for the Topology manager and for other SyMON agents and

modules.

Topology Manager Default Privileges

The default privileges for Topology manager (where domains are maintained) are

listed in the following table.

TABLE 11-3 Default Privileges for Topology Manager

Topology Manager Default Privileges

List of Admin Users

List of Operator Users

List of General Users

List of Admin SNMP Communities

List of Operator SNMP Communities

List of General SNMP Communities public

List of Admin Groups esdomadm

List of Operator Groups esops

List of General Groups ANYGROUP
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Other SyMON Component and Module Default

Privileges

The default privileges for all other SyMON components and modules are listed in

the following table.

The keyword ANYGROUPis not a true UNIX group, but is a special keyword that

means that “any user who can log into SyMON is given general access to the objects.”

Overriding the Default Privileges

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

In SyMON software, only administrators can override default privileges using the

Attribute Editor to modify the ACL lists for that particular object.

The following section illustrates how to override default list privileges.

TABLE 11-4 SyMON Component and Module Default Privileges

SyMON Components/Modules Default Privileges

List of Admin Users

List of Operator Users

List of General Users

List of Admin Groups esadm

List of Operator Groups esops

List of General Groups ANYGROUP

List of Admin SNMP Communities

List of Operator SNMP Communities

List of General SNMP Communities public
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▼ To Override Default Privileges

● Create the following override files in the /var/opt/SUNWsymon/cfg directory:

■ agent-acls-d.dat

■ topology-acls-d.dat

■ event-acls-d.dat

■ cfgserver-acls-d.dat

■ trap-acls-d.dat

The following example creates an admin group wheel for the agent instead of the

esadm. By default, it makes user 1, margot, and user 2, helen , admin users for

that agent.

Note that the lists of names are separated by spaces, such as, helen and margot .

The lines beginning with a pound sign (#) are comment lines and you may ignore

them. They are presented here for reference purposes only.

Note – Remember to create similar files for each component or machine.

#   File:    agent-acls-d.dat
#   Version: %I% %E% %U%
#
#   Copyright (c) 1993-1997 Halcyon Inc.
#
#   e.g.
#       adminUsers =
#       operatorUsers =
#       generalUsers =
#       adminCommunities =
#       operatorCommunities =
#       generalCommunities =
#       adminGroups =
#       operatorGroups =
#       generalGroups =
#
       adminUsers = helen margot
       adminGroups = wheel
       operatorGroups = esops
       generalGroups = ANYGROUP
       generalCommunities = public
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APPENDIX A

Getting Started With SyMON

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

TABLE A-1 is an example of how you can use the SyMON software. This table

includes a summary of some typical tasks and the order in which they should be

done. Each task is referenced to another section in the manual, which provides

detailed, step-by-step directions.

The tasks and the order in which they are included in this table is based on the

assumption that you will explore and learn the software before setting up your

actual monitoring environment.

TABLE A-1 Example Use of SyMON Software

Task For More Information, Go to

Create a domain. “To Create Domains” on page 40

Populate the domain by creating objects. Chapter 4

Populate the domain with the Discovery manager. Chapter 5

Familiarize yourself with the console window. Chapter 6

Navigate through SyMON using the hierarchy (tree view). “Hierarchy View” on page 94

Navigate through SyMON using the topology view. “Topology View” on page 96

Open the Details window. “To Start the Details Window” on page 111

Load other modules. “To Load a Module” on page 184

Disable some modules “To Disable a Module” on page 195

Unload some modules. “To Unload a Module” on page 196

Monitor your system using the modules. Appendix C
265



Explore the different modules. “Browser Tab” on page 114

Explore the process viewer. “Processes Tab” on page 225

Explore the log viewer. “Log View Tab” on page 232

Explore the physical view. “Configuration Tab” on page 239

Explore the logical view. “Configuration Tab” on page 239

View a property table. “Monitoring Data Properties” on page 122

View a graph of a property table. “To Graph A Monitored Data Property” on

page 131

Create an alarm. “To Create an Alarm” on page 150

Watch the alarm go up the hierarchy (tree) view. “To Create an Alarm” on page 150

View the alarm through the Details window. “Viewing Alarm Information” on page 207

View the alarm through the domain status summary. “To Access Alarms from the Main Console

Window” on page 210

Sort the alarms and become familiar with the Alarms window. “Information on Alarms” on page 211

Acknowledge the alarm. “Acknowledging and Deleting Alarms” on

page 217

Delete the alarm. “Acknowledging and Deleting Alarms” on

page 217

Create alarm conditions. “To Create an Alarm” on page 150

Set the refresh interval. “Refresh Tab in the Attribute Editor” on

page 154

Set security. Chapter 11

TABLE A-1 Example Use of SyMON Software (Continued)

Task For More Information, Go to
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APPENDIX B

Miscellaneous SyMON Procedures

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

This appendix documents the following procedures:

■ To Regenerate the Security Keys

■ To Configure a Legacy SNMP Agent as a Subagent of a SyMON Agent

■ To Determine if a Port Is Used

■ To Reconfigure SyMON to Use Nondefault Port Addresses

■ To Reconfigure SyMON SNMP Port Addresses

■ To Reconfigure SyMON RMI Port Address

■ To Create a Server Component as a Monitored Object

■ To Increase the Critical Threshold for the Virtual Size Data Property.

■ To Change the Default Values for Smart Delete in the Event Manager

■ To Use ccat to Read SyMON Log Files

■ To Use ctail to Read SyMON Log Files

Regenerating Security Keys

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The SyMON setup generates the security keys for SyMON components using the

following default settings:

■ Valid SyMON users are espublic and esmaster
■ SyMON superuser is esmaster
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Note – The SyMON software uses an 8-character string as a seed to make the

generated key unique. During setup, you have the option to use the default SyMON

seed or to use one that you create. The same seed must be used for all server and

agent setups in a given server context. For more information on server context, see

Chapter 11.

SyMON setup does not create UNIX accounts for the special SyMON users

espublic and esmaster . You should not need to log into the SyMON console

using these user IDs because they are reserved for internal communication between

processes. However, some troubleshooting activities may require you to log in using

one of these user IDs. If so, you have to create it and assign a password using the

normal UNIX commands useradd and passwd .

The esmaster user ID bypasses normal permission checks, so use it with care. For

normal operation, use an existing login account. Setup provides an opportunity to

specify an existing user as a SyMON administrator. This user ID is added to the

esadm and esdomadm groups as well as the esusers file. For more information on

SyMON security and the SyMON superuser, see Chapter 11.

The security keys for the SyMON components need to be regenerated if one or more

of the following is true:

■ UDP ports of any of the SyMON agents are changed.

■ Host names or IP addresses of the SyMON agent host change.

Note – Changing the host name or the IP address of the SyMON server is not

supported.
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▼ To Regenerate the Security Keys

Note – In these examples, shared_secret stands for a secret string of up to eight

characters that is common to all machines in a server context. It is required as an

argument to the script base-usm-seed.sh . A default (maplesyr ) is provided by

the SyMON software, but you can specify your own password if desired. This secret

string or password is used to generate keys for communication between processes.

-u public is needed to respond to external SNMP requests with public
communities.

1. Log in as root .

2. Depending on your installation, type one of the following.

■ If you installed only the agent layer, type:

■ If you installed only the server layer, type:

■ If you installed both the agent and server layers on one host, type:

3. Restart the SyMON server.

See “To Start the SyMON Software” on page 26.

# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -c agent -u public

# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -c topology -u public
# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -c trap event
cfgserver servers

# /opt/SUNWsymon/sbin/es_run base-usm-seed.sh -s shared_secret -u public
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Configuring a Legacy SNMP Agent as a
Subagent of a SyMON Agent

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

A legacy SNMP agent is a SNMP agent that is not part of the SyMON agent

framework. In real world situations, you may need to configure one or more legacy

agents as subagents of a SyMON agent.

Any legacy SNMP agent can be configured as a subagent of a SyMON Agent

provided that:

■ The legacy agent can run on a port other than 161.

■ The legacy agent configuration supports running that agent as a non-daemon

process.

■ You have the legacy agent MIB definition file.

▼ To Configure a Legacy SNMP Agent as a

Subagent of a SyMON Agent

1. Log in as root .

2. If the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x does not exist,
copy it from the /opt/SUNWsymon/base/cfg directory:

3. In the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x , find the block
that is similar to CODE EXAMPLE B-1.

# cp /opt/SUNWsymon/base/cfg/subagent-registry-d.x /var/opt/SUNWsymon/cfg/

CODE EXAMPLE B-1 Before Editing Registry file

# sa2 = {
#    type             = legacy
#    persist          = false
#    snmpPort         = "20001"
#    errorAction      = restart
#    startCommand     = "/usr/lib/snmp/mibiisa -p %port"
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4. Remove the comment symbol at the beginning of the line (#) so that the code
looks like CODE EXAMPLE B-2:

5. Modify the lines as follows:

a. Change sa2 to the unique subagent name for the agent.

b. type is legacy .

c. persist is false if the subagent is stopped when the SyMON agent exits. If
this value is true , then the SyMON agent does not stop the subagent when the
SyMON agent exits.

d. snmpPort is the UDP port number on which you want to run the subagent.

e. errorAction can be restart , ignore , or kill . If the restart option is
used, then the SyMON agent tries to restart if it encounters an error when
communicating with the subagent. The other options result in the respective
behaviors.

#    stopCommand      = "kill -9 %pid"
#    pollInterval     = 60
#    pollHoldoff      = 60
#    oidTrees         = 1.3.6.1.2.1
#    snmpVersion      = SNMPv1
#    securityLevel    = noauth
#    securityName     = espublic
# }

CODE EXAMPLE B-2 After Removing the Comment Symbol in the Registry file

sa2 = {
    type             = legacy
    persist          = false
    snmpPort         = "20001"
    errorAction      = restart
    startCommand     = "/usr/lib/snmp/mibiisa -p %port"
    stopCommand      = "kill -9 %pid"
    pollInterval     = 60
    pollHoldoff      = 60
    managedTrees     = "mib-2 sun"
#    oidTrees        = 1.3.6.1.2.1
    snmpVersion      = SNMPv1
    securityLevel    = noauth
    securityName     = espublic
 }

CODE EXAMPLE B-1 Before Editing Registry file (Continued)
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f. startCommand is the mandatory command to start the subagent. This
command should contain %port , which is replaced by the value given in
snmpPort .

g. stopCommand is the command to stop the process. %pid can be used to
represent the process ID (PID) of the subagent process.

h. pollInterval defines the time (in seconds) in which the SyMON agent polls
the subagent.

i. pollHoldoff is the time (in seconds) after which the first poll is done on the
subagent after the latter is started by the SyMON agent.

j. oidTrees gives the space-separated list of SNMP OIDs managed by the
subagent.

k. snmpVersion can take values SNMPv1and SNMPv2.

l. securityLevel can be priv , auth , or noauth.

m. securityName is the SNMPv1 community name or SNMPv2 security name to
use.

For more details, refer to the descriptions in the subagent-registry-d.x file.

6. Stop then restart the agent:

Configuring SyMON to Use Different
Port Addresses

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

This section describes how to configure SyMON when there is potential conflict for

port addresses.

# /opt/symon/sbin/es-stop -a
# /opt/symon/sbin/es-start -a
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▼ To Determine if a Port Is Used

● To determine if a specific port number is used in your system, type:

The SyMON server communicates with the SyMON agents and the other server

components (Topology manager, Configuration manager, Event manager, and Trap

handler) using SNMP. By contrast, the SyMON server communicates with the

SyMON consoles using remote method invocation (RMI).

In SyMON 2.0 software, several components require the use of network ports, as

shown in the following table.

Note – The SNMP port definitions for SyMON components are found in two files:

the /var/opt/SUNWsymon/cfg/domain-config.x file, which exists in every

machine running any SyMON component, and the

/var/opt/SUNWsymon/cfg/server-config.x file, which exists on machines

that have the SyMON server component installed.

In the domain-config.x file, there is one configuration block for each of the

SNMP-based SyMON agents. In each configuration block there is (at least) one line

which defines the port address for the corresponding SyMON agent. The default

port definition for the SyMON server is in the server-config.x file.

SyMON setup scripts automatically configure the SyMON components by using the

default port addresses. However, if any of the default ports are being used, then you

must take action to avoid such conflicts in network port addresses.

# /bin/netstat -an|grep port_number

TABLE B-1 SyMON Default Port Addresses

SyMON Layer SyMON Component Default Port Number

Agent SyMON agent 161

Server SyMON Trap handler 162

Server SyMON Event manager 163

Server SyMON Topology manager 164

Server SyMON Configuration manager 165

Server SyMON server 2099
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▼ To Reconfigure SyMON to Use Nondefault Port

Addresses

1. Run the es-setup script to create the domain-config.x and server-config.x
(server configuration setup) files.

2. Edit these files with the new port numbers.

See the next section and “To Reconfigure SyMON RMI Port Address” on page 275

for more information.

▼ To Reconfigure SyMON SNMP Port Addresses

1. Log in as root .

2. Edit the domain-config.x file and change the address port to an unused port.

This example illustrates changing the SyMON agent default port address from 161
to 1161 .

Before:

After:

3. Save the file.

Note – Hosts with SyMON agents using port addresses other than 161 can be added

to the domain manually by using the Create Topology Object window or can be

discovered automatically by specifying the port number in the discovery

parameters. (For more information on the Create Topology Object window, see

Chapter 4. For more information on how hosts are discovered automatically, see

Chapter 5). Since you can only specify one port number in addition to port 161, it is

best to select an alternate port number and use that number for all SyMON agent

installations.

agent = {
      snmpPort = 161

agent = {
      snmpPort = 1161
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▼ To Reconfigure SyMON RMI Port Address

1. Log in as root .

2. Edit the /var/opt/SUNWsymon/cfg/server-config.x file.

3. Search for the block which starts with rmiReceptor .

For example:

4. Uncomment the line that reads property:rmiPort = 2099 by deleting the
pound (#) character.

5. Change the address port to a new unused port number.

For example:

This example illustrates changing the SyMON server default port address from 2099
to 1199 .

6. Save the file.

rmiReceptor = {
    [ use RECEPTORS.RMI ]

#    property:rmiPort = 2099
#    property:rmiHost = localhost

    # 0 means user authentication is disabled
    # 1 means user authentication is enabled
    # property:securityFlag = 1

    # -1 means no limit
    # 0 means make a guess at a limit (base on # of fd's)
    # >0 specifies the exact limit
#
}

property:rmiPort = 1199
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Monitoring Topology Manager and
Event Manager

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

There are five components in the SyMON server layer:

■ SyMON server

■ Topology manager

■ Trap handler

■ Configuration manager

■ Event manager

With the exception of the SyMON server, the other four components are SyMON

agents loaded with specialized modules.

You may want to monitor the Topology manager, Trap handler, Configuration

manager, and Event manager to determine their status. See the next section for more

information.

The Configuration manager and the Trap handler are configured so that you do not

need to perform any maintenance procedures. In addition, the default configurations

of both the Topology manager and the Event manager work for most user

environments. However, you can modify the default configurations for specialized

environments.

The default configuration for the Topology manager and the Event manager (and all

other SyMON agents) is defined by the Agent Statistics module. See “Agent

Statistics Module” on page 328 for more information about this module.

This module includes features that guard against errors that may bring down the

host. The default action is for the SyMON software to terminate the Topology

manager process if predefined thresholds are exceeded.
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▼ To Create a Server Component as a Monitored

Object

1. In the SyMON main console window, select Edit ➤ Create an Object.

The Create Topology Object window is displayed. By default the tab is set to Group.

For more information, see “To Create a Node” on page 54.

2. Click the Node tab.

The window changes to display settings available for nodes.

3. Click the Monitor Via button to see the pull-down menu, then select SyMON
Agent - Host.

4. Type the name of the server component in the Node Label field.

5. (Optional) Enter a description of the node.

6. Enter the name of the SyMON server in the Hostname field.

7. Type the port number for the server component in the Port field (FIGURE B-1).

See TABLE B-1 for the default port values for each of the server components.

8. Complete this procedure with one of the following actions:

■ Click OK to create the server component object and close this window.

■ Click Apply to create the server component object without closing this window.

■ Click Cancel to cancel your request.
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FIGURE B-1 Creating a Server Component as a Monitored Object
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Topology Manager

The Topology manager enables the main console window to present logical objects

in a topology view. It also provides the ability to create a logical object (such as a

group) whose status summarizes the statuses of managed objects residing on

multiple hosts.

Managed objects include networks, hosts, hardware components, and software

components. The total number of objects and the contents of these objects determine

the system resource requirement (for example, Virtual Size) for the Topology

manager. This requirement must be less than the defaults set for the Topology

manager.

If the Virtual Size of the Topology manager exceeds the default value, then the

Topology manager exits with the error message, “error excessive virtual memory

use.” To solve this error, you need to increase the default virtual size by completing

the following procedure after you have carefully evaluated the situation.

▼ To Increase the Critical Threshold for the Virtual

Size Data Property.

1. Create the Topology manager monitored object.

See “To Create a Server Component as a Monitored Object” on page 277.

2. Open the Details window and proceed with one of the following:

■ Click the right mouse button on the Topology manager object icon and highlight

Details from the pop-up menu in the hierarchy view or the topology view.

■ Double-click the left mouse button on the Topology manager icon in the hierarchy

view or the topology view.

■ Select the Topology manager icon in the SyMON main console window, then

select Tools ➤ Details.

3. In the Browser Details window, double-click on the Local Applications icon in the
hierarchy (tree) view.

4. Double-click on the Agent Statistics icon in the contents view or single click in
the light-colored circle next to the Agent Statistics icon in the hierarchy view.

The Agent Statistics folders are displayed.

5. Double-click on the PA Process Statistics folder icon in either the hierarchy or the
contents view.

The monitored properties are displayed in a property table (FIGURE B-2).
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FIGURE B-2 PA Process Statistics Property Table

6. Select the Virtual Size table cell, then proceed with one of the following:

■ Click the right mouse button in the table row and select Attribute Editor from the

pop-up menu.

■ Click the Attributes button.

7. Click on the Alarms tab button.

The alarm rows are displayed (FIGURE B-3).

8. Type the desired value in the Critical Threshold (>) field.

9. Complete this procedure with one of the following actions:

■ Click OK to create a new Critical Threshold value and close this window.

■ Click Apply to create a new Critical Threshold value without closing this

window.

■ Click Cancel to cancel your request.
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FIGURE B-3 Alarms Tab for the Virtual Size Property in the Topology Manager Object

Event Manager

The Event manager communicates with other server components through SNMP

using the default port 163. Similar to the Topology manager, the Event manager is

also loaded with the Agent Statistics module. In addition, the Event manager is

automatically loaded with a specialized Event Management module which is

displayed in the Browser Details window in the Local Applications category.

The Event Management module is responsible for the overall maintenance of the

event database. Its responsibilities include purging deleted events, renaming the

trash file, and “smart delete” (FIGURE B-4).
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FIGURE B-4 Event Management Module Data Properties

Smart delete means that SyMON automatically deletes closed, fixed, and open

events from the event database after a set period of time. By default, the closed or

fixed events are removed from the database after seven days and the open events are

removed after 30 days. You can change these defaults with the following procedure.

▼ To Change the Default Values for Smart Delete

in the Event Manager

1. Create the Event manager monitored object.

See “To Create a Server Component as a Monitored Object” on page 277.

2. Open the Details window by proceeding with one of the following:

■ Click the right mouse button on the Event manager icon and highlight Details

from the pop-up menu in the hierarchy view or the topology view.

■ Double-click the left mouse button on the Event manager icon in the hierarchy

view or the topology view.

■ Select the Event manager icon in the SyMON main console window then select

Tools ➤ Details.

3. In the Browser Details window, double-click on the Local Applications icon in the
hierarchy (tree) view.

4. Select the Event Management module and proceed with one of the following:

For more information, see “To Edit Module Parameters” on page 193.

■ Click the right mouse button and highlight Edit Module from the pop-up menu in

the hierarchy view or the contents view.
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■ In the Details window, select Module ➤ Edit Module.

The Module Parameters Editor is displayed.

5. Type the new time values into the editable fields.

The default time values are displayed in FIGURE B-5.

6. Alternately, you may turn off “smart delete” by selecting Disabled in the
pull-down menu next to the Smart Delete Enabled Switch field.

7. Complete this procedure with one of the following actions:

■ Click OK to accept the changes you have made and close this window.

■ Click Reset to reset the Module Parameter Editor to the default parameters.

■ Click Cancel to cancel your request.
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FIGURE B-5 Module Parameter Editor for the Event Management Module
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Reading SyMON Log Files

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The SyMON server and agents write to various log files in the directory,

/var/opt/SUNWsymon/log .

These files are “circular log files.” A circular log file does not grow in size after a

certain limit. As new messages are logged into the file, the oldest messages are

removed.

Use the es-run interface with the ctail and ccat commands to view these log

files. The es-run interface sets up the proper environment to run SyMON utilities.

The utilities ccat and ctail display only the relevant data, after sorting the data in

chronological order. The ccat and ctail commands are similar to the UNIX cat
and tail commands, but are intended for use with SyMON circular log files.

▼ To Use ccat to Read SyMON Log Files

The ccat command reads the specified log file, sorts the messages in

chronologically ascending order, and writes to the standard output. The ccat
command takes one argument, which is the full path to the circular log file.

● Use the es-run interface with the ccat command:

▼ To Use ctail to Read SyMON Log Files

The ctail command reads the circular log file and by default writes the last 15 lines

of the file to standard output.

# /opt/SUNWsymon/sbin/es-run ccat filename
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The ctail command takes four arguments: filename and the -f , -l , and -n options

where:

The filename argument is the full path name to the circular log file. The filename
argument is mandatory.

-f option is used to monitor the growth of the log file. As the log file grows, the

messages appended to the file are also written to the standard output. The ctail
-f option is similar to the -f option for the UNIX tail command.

-l option is used to print the absolute line number at the beginning of each

message.

-n NumOfLines option is used to change the number of lines displayed. By default

only the last 15 lines are printed.

● Use the es-run interface with the ctail command:

# /opt/SUNWsymon/sbin/es-run ctail [-f, -l, -n NumOfLines] log_filename
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APPENDIX C

SyMON Modules

The Sun Enterprise SyMON software monitors various components of your system,

including your hardware, operating environment, local applications, and remote

systems. This section provides additional explanation for the core SyMON modules

described in Chapter 8 and presents them in their respective categories.

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

This appendix describes the following modules. For more information on other

modules that may be applicable to your particular system, go the SyMON web site:

http://www.sun.com/symon .

■ Hardware

■ Config-Reader Module

■ Operating System

■ Directory Size Monitoring Module

■ File Monitoring Module

■ MIB-II Instrumentation Module

■ Kernel Reader Module

■ NFS Statistics Module

■ Solaris Process Details Module

■ Local Applications

■ Agent Statistics Module

■ Data Logging Registry Module

■ Dynamic Reconfiguration Module

■ Health Monitor Module

■ MIB-II Instrumentation Module

■ Print Spooler Module

■ Process Monitoring Module

■ File Scanning (System Log) Module

■ Remote Systems

■ HP JetDirect Module

■ MIB-II Proxy Monitoring Module
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Most of these modules have default monitoring conditions that generate alarms

when system values fall outside of these conditions. You may alter these default

thresholds by creating your own alarm thresholds, as explained in Chapter 8.

Also, there are three modules that utilize the Add Row operation to define what data

properties to monitor. These modules will come up with empty tables and you have

to execute an Add Row operation to activate the specifics for monitoring the

modules.

The following table lists all modules alphabetically and provides details on those

modules that are automatically loaded and those that can be loaded multiple times.

It also points out those modules that utilize the Add Row utility.

TABLE C-1 Modules Loaded Automatically, Multiple Times, and Use ‘Add Row’ Operation

Alphabetical Listing of Core Modules Module Loads
Automatically

Module Loads
Multiple Times

Module Uses
Add Row Utility

Agent Statistics Module X

Config-Reader Module X

Data Logging Registry Module X

Directory Size Monitoring Module X

Dynamic Reconfiguration Module

File Monitoring Module X X1

1. Each added row defines what file to monitor.

File Scanning (System Log)

Module

X X X 2

2. Each added row defines what pattern within the monitored file to match. The row needs to be added to the
table, Scan Table.

HP JetDirect Module X

Health Monitor Module

Kernel Reader Module X

MIB-II Instrumentation Module X

MIB-II Proxy Monitoring Module X

NFS File Systems Module

NFS Statistics Module

Print Spooler Module X

Process Monitoring Module X X3

3. Each row defines what pattern to match from all the processes that are running on the agent host.

Solaris Process Details Module
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Hardware

The following module, when loaded, is found under the hardware icon:

■ Config-Reader Module (sun4u/sun4d)

This module obtains the physical view and logical view of your host. For more

information on the physical and logical views, see Chapter 10.

Config-Reader Module

The Config-Reader (sun4u/sun4d) module monitors your hardware and alerts you

whenever there is a problem. For example, this module checks for single in-line

memory module (SIMM) errors, monitors board temperatures and power supply

status, and so on.

This section includes the following:

■ Config-Reader Top-Level Property Tables

■ Config-Reader Managed Object Tables

Note – Currently, the Config-Reader module is supported on some Sun hardware

platforms. For information on your particular system, go the SyMON web site at

http://www.sun.com/symon .

Config-Reader Top-Level Property Tables

This section includes the top-level Config-Reader module property tables:

■ Board Table

■ CPU Unit Table

■ SIMM Table

■ Peripheral PS Table

■ Power Supply Table

■ FHC Table

■ AC Table

■ Fan Table

■ Environment Table

■ I/O Controllers Table

■ I/O Devices Table

■ Disk Devices Table

■ Tape Devices Table
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■ Network Devices Table

Board Table

The following table provides a brief description of the properties for Boards:

CPU Unit Table

The following table provides a brief description of the properties for CPU Unit:

TABLE C-2 Board Properties

Property Description

Name Name of the node

Board No Number of the board

FRU Field-replaceable unit

Hot Plugged Whether it is hot-plugged

Hot Pluggable Whether it is hot-pluggable

Memory size Size of the memory

State Status of the node

Temperature Temperature of the board

Type Whether it is in the CPU memory, Sbus, clock, and so on

TABLE C-3 CPU Unit Properties

Property Description

Name Name of the node

Board No Number of the board

Clock Frequency Frequency of timer

Cpu Type Type of system

Dcache Size Size of Dchache in Kbytes

Ecache Size Size of Ecache in Mbytes

Fru Field-replaceable unit

Icache Size Size of Ichache in Kbytes

Model Name of model
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SIMM Table

The following table provides a brief description of the properties for SIMM:

Peripheral PS Table

The following table provides a brief description of the properties for Peripheral PS:

Processor ID Identification number of the processor

Status Online state of board

Unit Identification of the unit

TABLE C-4 SIMM Properties

Property Description

Name Name of the node

Board Reference

Number

Number that references the board

Size Size of SIMM in Mbytes

Slot Number of the slot

Status Status of the node

TABLE C-5 Peripheral PS Properties

Property Description

Name Name of the node

Fru Field replaceable unit

Hpu Hot-pluggable unit

Status Status of the node

Unit No. Unit number

TABLE C-3 CPU Unit Properties (Continued)

Property Description
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Power Supply Table

The following table provides a brief description of the properties for Power Supply:

FHC Table

The following table provides a brief description of the properties for the FHC node,

which is a node inside the I/O unit:

AC Table

The following table provides a brief description of the properties for alternating

current (AC):

TABLE C-6 Power Supply Properties

Property Description

Name Name of the node

Hpu Hot pluggable unit

Status Status of the node

Unit No. Unit number

TABLE C-7 FHC Properties

Property Description

Name Name of the node

Board Num Name of the board

Model Model of the machine

Upa Mid Number of the ultra port architecture unit

Version No. Version number

TABLE C-8 AC Properties

Property Description

Name Name of the node

Bank0 Status Bank0 status

Bank1 Status Bank1 status
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Fan Table

The following table provides a brief description of the properties for Rack Fan:

Environment Table

The following table provides a brief description of the properties for Environment:

I/O Controllers Table

The following table provides a brief description of the properties for I/O

Controllers:

Device Type Device type of the node

Model Model number of the node

Version No Version number of the node

TABLE C-9 Fan Properties

Property Description

Name Name of the node, for example, rack_fan

Status Status of the fan

TABLE C-10 Environment Properties

Property Description

Name Name of the node

Reg Registered property

TABLE C-11 I/O Controllers Properties

Property Description

Name Node name

Board Number Board number

Clock Frequency Frequency of timer

TABLE C-8 AC Properties (Continued)

Property Description
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I/O Devices Table

The following table provides a brief description of the properties for I/O Devices:

Device Type Device type of the node

Instance Number Instance Number

Model Model number

Reg Reg property

UPA Mid UPA M ID

UPA Portid UPA Port ID

Version Number Version number

TABLE C-12 I/O Devices Properties

Property Description

Name Node name

Device Type Device type of the node

Disk Count Number of disks present on this device

Instance Number Instance number

Model Model number

Network Count Number of network interface present on this device

Reg Registered property

Tape Count Number of tap device present on this device

TABLE C-11 I/O Controllers Properties (Continued)

Property Description
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Disk Devices Table

The following table provides a brief description of the properties for Disk Devices:

Tape Devices Table

The following table provides a brief description of the properties for Tape Devices:

TABLE C-13 Disk Devices Properties

Property Description

Name Name of the node

Device Type Device type

Disk Name Name of the disk

Field Replaceable Field replaceable unit

Instance Number Instance number of the disk

Disk Target Disk target number

TABLE C-14 Tape Devices Properties

Property Description

Name Name of the node

Device Type Device Type of the node

Field Replaceable Field replaceable unit

Instance Number Instance number of the tape

Model Model number

Tape Name Tape name

Status Status of the tape device

Tape Target Tape target number
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Network Devices Table

The following table provides a brief description of the properties for Network

Devices:

Config-Reader Managed Object Tables

This section includes the Config-Reader managed object property tables:

■ System Table

■ AC PS Table

■ Hot-Plug Charges Table

■ Auxiliary 5V Table

■ Peripheral 5V, Peripheral 12V, System 3V, and System 5V Table

■ Keyswitch Table

■ Remote Console Table

■ PFA Rules Table

TABLE C-15 Network Devices Properties

Property Description

Name Name of the node

Device Type Device type of this node

Ethernet Address Ethernet address of the interface

Internet Address Internet address of the interface

Interface Name Name of the interface

Symbolic Name Symbolic name of the interface
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The following table lists the properties monitored by this module:

These managed objects and their properties are described in the following sections

and tables.

TABLE C-16 Config-Reader Managed Objects

Property Description

System Machine name, operating environment, system clock

frequency, architecture, host name, platform, time stamp,

number of disks, processors, and tape devices, amount of

memory

AC PS Alternating current power supply

Hot Plug Charges Output of system power supply that is used for hot-

plugging and peripherals

Auxiliary 5v Output of system power supply

Peripheral 5v Output of system power supply

Peripheral 5v Precharge Output of system power supply

Peripheral 12v Output of system power supply

Peripheral 12v Precharge Output of system power supply

System 3v Output of system power supply

System 3v Precharge Output of system power supply

System 5v Output of system power supply

System 5v Precharge Output of system power supply

Keyswitch Position of the keyswitch (standby, on, diagnostics, or lock)

Rack Fan Rack fan information

Remote Console Remote console information

PFA Rules PFA rule information
Appendix C SyMON Modules 297



System Table

The following table provides a brief description of the properties for System:

AC PS Table

The following table provides a brief description of the properties for AC PS:

TABLE C-17 System Properties

Property Description

Name Name of the node

Operating System Operating system running in the machine

Operating System

Version

Operating system version

System Clock Frequency Clock frequency

Architecture Architecture of the machine

Host name Of The

System

Host name of the system

Machine Name Machine name

Serial Number Serial number of the machine

Timestamp Time stamp value

Raw Timestamp Raw time stamp value

Total Disks Total number of disks present in the system

Total Memory Total memory present in the system

Total Processors Total processors present in the system

Total Tape Devices Total tape devices present in the system

TABLE C-18 AC PS Properties

Property Description

Name Name of the node

Status Status of the node
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Hot-Plug Charges Table

The following table provides a brief description of the properties for Hot-Plug

Charges:

Auxiliary 5V Table

The following table provides a brief description of the properties for Auxiliary 5V:

Peripheral 5V, Peripheral 12V, System 3V, and System 5V Table

The following table presents what you see when you load the following modules:

■ Peripheral 5V

■ Peripheral 5V Precharge

■ Peripheral 12V

■ Peripheral 12V Precharge

■ System 3V

■ System 3V Precharge

■ System 5V

■ System 5V Precharge

TABLE C-19 Hot-Plug Properties

Property Description

Name Name of the node

Fru Field-replaceable unit

TABLE C-20 Auxiliary 5V Properties

Property Description

Name Name of the node

Fru Field replaceable unit

Status Status of the node
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Keyswitch Table

The following table provides a brief description of the properties for Keyswitch:

Remote Console Table

The following table provides a brief description of the properties for Remote

Console:

TABLE C-21 Common Peripheral and System Properties

Property Description

Name Name of the node

Fru Field replaceable unit

Status Status of the node

TABLE C-22 Keyswitch Properties

Property Description

Name Name of the node

TABLE C-23 Remote Console Properties

Property Description

Name Name of the node: for example, remote_console

Status The status of the rack fan: enabled or disabled
300 Sun Enterprise SyMON 2.0 User’s Guide • December 1998



PFA Rules Table

The following table provides a brief description of the properties for PFA Rules:

Operating System

The following modules, when loaded, are found under the operating system icon:

■ Directory Size Monitoring Module

■ File Monitoring Module

■ File Scanning (System Log) Module

■ Kernel Reader Module

■ MIB-II Instrumentation Module

■ NFS File Systems Module

■ NFS Statistics Module

■ Solaris Process Details Module

These modules monitor the operating system on your host.

Directory Size Monitoring Module

This module enables you to isolate and monitor the size of any directory and its

subdirectories on a host on which an agent is installed. The subdirectories and links

may be viewed recursively using a window accessible from the modules pop-up

menu.

Note – Any number of directories may be monitored individually by loading

multiple instances of the Directory Size Monitoring module.

TABLE C-24 PFA Rules Properties

Property Description

PFA SIMM Rule SIMM rule value

PFA Disk Rule Disk rule value

Smart/PFA Disk

Rule

Smart PFA disk rule value
Appendix C SyMON Modules 301



Directory Monitoring Status Table

The following table provides a brief description of the properties for Directory Size

Monitoring:

File Monitoring Module

This module enables you to monitor the files on a host. Any file or number of tiles

may be isolated and monitored individually by loading multiple instances of the File

Monitoring module.

File Monitoring Status Table

The following table lists the File Monitoring Status properties and their descriptions:

MIB-II Instrumentation Module

This section presents information on the MIB-II Instrumentation module. It describes

the property tables that belong to the following MIB-II groups:

TABLE C-25 Directory Size Monitoring Properties

Property Description

Directory Name Name of the directory being monitored

Directory Size (KB) Current size of the directory in Kbytes

Rate (KB/sec) Rate at which the directory is changing size in Kbytes per second

TABLE C-26 File Monitoring Properties

Property Description

Name Name of the file being monitored

Description Descriptive name provided for this file when added

Filename File being monitored

Last Modified Date and time the file last changed

File Size (Bytes) Size of the file

Size Rate (Bytes) Number of bytes written per second
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■ MIB-II System Group Table

■ MIB-II Interfaces Group Tables

■ MIB-II IP Group Table

■ MIB-II ICMP Group Table

■ MIB-II TCP Group Tables

■ MIB-II UDP Group Tables

MIB-II System Group Table

The following table provides a brief description of the properties for MIB-II System

Group:

MIB-II Interfaces Group Tables

The following tables provide a brief description of the properties for the MIB-II

Interface group:

■ MIB-II Interfaces Group Table

■ MIB-II Interface Table

TABLE C-27 MIB-II System Group Properties

Property Description

System Description MIB-II system description or the description of the host (read-

write)

System OID Object identifier or the Object ID (OID) of the software system

Time Since System Is Up Time in microseconds since the system is up

System Contact The contact name for this system

System Name The qualified host name on which the agent is running (read-

write)

System Location The physical location of the host (read-write)

System Services Sum integer value indicating the set of services primarily

offered
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MIB-II Interfaces Group Table

The following table provides a brief description of the properties for MIB-II

Interfaces Group:

MIB-II Interface Table

The following table provides a brief description of the properties for MIB-II

Interfaces:

TABLE C-28 MIB-II Interfaces Group Properties

Property Description

Number of

Interfaces

Number of interfaces to the machine, including the loopback

TABLE C-29 MIB-II Interface Properties

Property Description

IF Index Index of the interface in this table

IF Descr Description of the interface

IF Type Type of the interface

IF Largest MTU Size of the largest datagram that can be sent on the interface

IF Speed Bandwidth of the interface

IF Physical Address Physical address of the interface

IF Admin Status Desired state of the interface

IF Oper Status Operational state of the interface

IF Last Change Value of sysUpTime (that is, time when the system is up and

running) when the operational state has changed last time

IF In Octets Octets received on the interface

IF In Unicast Pkts Unicast packets received on the interface

IF In NonUnicast

Pkts

Non-unicast packets received on the interface

IF In Discards Number of packets on the interface that are chosen to be discarded

IF In Errors Number of inbound packets on the interface that contained errors

IF In Unknown

Protos

Number of packets with unsupported protocol that were received

on the interface
304 Sun Enterprise SyMON 2.0 User’s Guide • December 1998



MIB-II IP Group Table

The following tables provide a brief description of the properties for MIB-II IP:

■ MIB-II Group Table

■ IP Address Table

■ IP Route Table

■ IP NetToMedia Table

MIB-II Group Table

The following table provides a brief description of the properties for MIB-II IP

Group:

IF Out Octets Number of octets transmitted out on the interface

IF Out Unicast Pkts Number of unicast packets transmitted out on the interface

IF Out NonUnicast

Pkts

Number of non-unicast packets transmitted out on the interface

IF Out Discards Number of outbound packets on the interface that contained errors

IF Out Errors Number of outbound packets that could not be transmitted because

of errors

IF Out Queue

Length

Length of the output packet queue

IF Specific Reference to the MIB definitions specific to the particular media

TABLE C-30 MIB-II Group Properties

Property Description

IP Forwarding Indicates whether this entity is a gateway

IP Default TTL Default Time-to-Live inserted into the IP headers

IP In Receives Number of datagrams received

IP In Header Errors Number of input datagrams discarded because of errors in IP

headers

IP In Address Errors Number of input datagrams discarded because of errors in

destination IP address

IP Forwarded

Datagrams

Number of forwarded datagrams

TABLE C-29 MIB-II Interface Properties (Continued)

Property Description
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IP Address Table

The following table provides a brief description of the properties for IP Addresses:

IP In Unknown

Protos

Number of locally addressed datagrams that were discarded

because of unsupported protocols

IP In Discards Number of input datagrams that were discarded

IP In Delivers Number of input datagrams that were successfully delivered

IP Out Requests Number of datagrams that were supplied to IP for transmission

IP Out Discards Number of output IP datagrams that were discarded

IP Out No Routes Number of output IP datagrams that were discarded because no

route destination was found

IP Reassemble

Timeouts

Maximum time in seconds for which the received fragments were

held for reassembly

IP Reassemble

Requireds

Number of IP fragments received that required reassembly

IP Reassemble OKs Number of IP datagrams that were successfully reassembled

IP Reassemble Fails Number of failures detected by the reassembly algorithm

IP Fragmentation

OKs

Number of IP datagrams that were successfully fragmented

IP Fragmentation

Fails

Number of IP datagrams that have failed fragmentation

IP Fragmentation

Creates

Number of IP datagram fragments that were generated due to

fragmentation

IP Routing Discards Number of routing entries that were chosen to be discarded

TABLE C-31 IP Addresses Properties

Property Description

IP Address Table IP Address Table

IPAT IP Address IP Address to which this entry’s addressing information pertains

IPAT IfIndex Index in the interface table for the corresponding interface

TABLE C-30 MIB-II Group Properties (Continued)

Property Description
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IP Route Table

The following table provides a brief description of the properties for IP Route:

IPAT Net Mask Subnet mask associated with the IP address

IPAT Broadcast

Address

Value of the least significant bit in the IP broadcast address

IPAT Reassemble

Max Size

Size of the largest IP datagram which can be reassembled by this

entity

TABLE C-32 IP Route Properties

Property Description

IP Route Table Entity’s IP routing table

IP Route Destination Destination IP address of the route

IP Route IfIndex Index of the interface in the interface table through which the next

hop of this route is reached

IP Route Metric1 Primary routing metric for the route that is specific to the routing 1

protocol

IP Route Metric2 Alternate routing metric for the route that is specific to the routing 2

protocol

IP Route Metric3 Alternate routing metric for the route that is specific to the routing 3

protocol

IP Route Metric4 Alternate routing metric for the route that is specific to the routing 4

protocol

IP Route NextHop IP address of the next hop of this route

IP Route Type Type of route

IP Route Proto Routing mechanism through which this route was learned

IP Route Age Number of seconds since the route was last updated

IP Route Mask Mask to be logical and with the destination address before being

compared to the route destination

IP Route Metric5 Alternate routing metric for the route that is specific to the routing 5

protocol

IP Route Info Reference to MIB definitions specific to the routing protocol

TABLE C-31 IP Addresses Properties (Continued)

Property Description
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IP NetToMedia Table

The following table provides a brief description of the properties for IP NetToMedia:

MIB-II ICMP Group Table

The following table provides a brief description of the properties for MIB-II ICMP

Group:

TABLE C-33 IP NetToMedia Properties

Property Description

IPN2M IfIndex Index of the interface in the interface table on which this entry’s

equivalence is effective

IPN2M

PhysAddress

Media-dependent physical address

IPN2M NetAddress IP address corresponding to the physical address

IPN2M Type Type of mapping

TABLE C-34 MIB-II ICMP Group Properties

Property Description

ICMP In Messages Number of ICMP messages received

ICMP In Errors Number of ICMP messages received with errors

ICMP In Dest

Unreachs

Number of ICMP destination unreachable messages received

ICMP In Time

Exceeds

Number of ICMP time exceeded messages received

ICMP In Parameter

Problmes

Number of ICMP parameter problem messages received

ICMP In Src

Quenchs

Number of ICMP source quench messages received

ICMP In Redirects Number of ICMP redirect messages received

ICMP In Echos Number of ICMP echo request messages received

ICMP In Echo Reps Number of ICMP echo reply messages received

ICMP In

Timestamps

Number of ICMP timestamp request messages received

ICMP In Timestamp

Reps

Number of ICMP timestamp reply messages received
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MIB-II TCP Group Tables

The following tables provide a brief description of the properties for MIB-II TCP:

■ MIB-II TCP Group Table

■ TCP Connections Table

ICMP In Address

Masks

Number of ICMP address mask request messages received

ICMP In Address

Mask Reps

Number of ICMP address mask reply messages received

ICMP Out Messages Number of ICMP messages that were attempted to send

ICMP Out Errors Number of ICMP messages that were not send due to problems

ICMP Out Dest

Unreachs

Number of ICMP destination unreachable messages sent

ICMP Out Time

Exceeds

Number of ICMP time exceeded messages sent

ICMP Out

Parameter Problems

Number of ICMP parameter problem messages sent

ICMP Out Src

Quenchs

Number of ICMP source quench messages sent

ICMP Out Redirects Number of ICMP redirect messages sent

ICMP Out Echos Number of ICMP echo request messages sent

ICMP Out Echo

Reps

Number of ICMP echo reply messages sent

ICMP Out

Timestamps

Number of ICMP timestamp request messages sent

ICMP Out

Timestamp Reps

Number of ICMP timestamp reply messages sent

ICMP Out Address

Masks

Number of ICMP address mask request messages sent

ICMP Out Address

Mask Reps

Number of ICMP address mask reply messages sent

TABLE C-34 MIB-II ICMP Group Properties (Continued)

Property Description
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MIB-II TCP Group Table

The following table provides a brief description of the properties for MIB-II TCP

Group:

TABLE C-35 MIB-II TCP Group Properties

Property Description

TCP Retransmission

Algorithm

Algorithm used to determine the timeout value used for

retransmitting unacknowledged octets

TCP Retransmit Min

Timeout

Minimum value permitted by TCP implementation for the

retransmission timeout

TCP Retransmit

Max Timeout

Maximum value permitted by TCP implementation for the

retransmission timeout

TCP Max

Connections

Limit on the number of TCP connections

TCP Active Opens Number of times TCP connections have transitioned to SYN-SENT

from CLOSED state

TCP Passive Opens Number of times TCP connections have transitioned to SYN-RCVD

from LISTEN state

TCP Attempt Fails Number of times TCP connections have transitioned from SYN-

SENT or SYN-RCVD to COLSED state and from SYN-RCVD to

LISTEN state

TCP Established-to-

Resets

Number of times TCP connections have transitioned from

ESTABLISHED or CLOSE-WAIT to CLOSED state

TCP Current

Established

Number of TCP connections for which the current state is

ESTABLISHED or CLOSE-WAIT

TCP In Segments Number of segments received

TCP Out Segments Number of segments sent

TCP Retransmitted

Segments

Number of segments retransmitted

TCP In Errors Number of segments received in error

TCP Out With Reset

Flag

Number of segments sent containing the RST flag
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TCP Connections Table

The following table provides a brief description of the properties for TCP

Connections:

MIB-II UDP Group Tables

The following tables provide a brief description of the properties for MIB-II UDP:

■ MIB-II UDP Group Table

■ UDP Table

MIB-II UDP Group Table

The following table provides a brief description of the properties for MIB-II UDP

Group:

TABLE C-36 TCP Connections Properties

Property Description

TcpConn State State of this TCP Connection

TcpConn Local Address Local IP address for this TCP connection

TcpConn Local Port Local port number for this TCP connection

TcpConn Remote Address Remote IP address for this TCP connection

TcpConn Remote Port Remote port number for this TCP connection

TABLE C-37 MIB-II UDP Group Properties

Property Description

UDP In Datagrams Number of UDP datagrams delivered to UDP users

UDP No Port

Datagrams

Number of received UDP datagrams for which there is no

application at the destination port

UDP In Errors Number of received UDP datagrams that could not be delivered

UDP Out Datagrams Number of UDP datagrams sent
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UDP Table

The following table provides a brief description of the properties for UDP:

Kernel Reader Module

The Kernel Reader module monitors kernel statistics and all kernel information

including CPU statistics, system load statistics, disk statistics, file system usage, and

so on. This section includes properties and their descriptions for all Kernel Reader

managed objects:

■ Disk Statistics Managed Objects Tables

■ File System Usage Table

■ System Load Statistics Table

■ Filesystem Usage Table

■ CPU Statistics Managed Object Tables

■ Memory Usage Statistics Table

■ Swap Statistics Table

■ Streams Statistics Managed Objects Table

■ Software Rules Table

The Kernel Reader module generates a warning alarm if it finds any disk with an

increasing wait queue while busy.

A warning alarm occurs when the disk is over 75% busy and the average queue

length is over 10 with an increasing wait queue. The warning alarm is on until the

disk is not over 70% busy and the average queue length is no longer than 8.

Similarly, this module generates a warning alarm if 90% of swap space is in use. The

alarm remains open until the swap space in use is less than 80% of the total swap

space.

TABLE C-38 UDP Properties

Property Description

UDP Local Address The local IP address for this UDP listener

UDP Local Port The local port number for this UDP listener
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The following table provides default alarm thresholds for applicable Kernel Reader

modules:

Disk Statistics Managed Objects Tables

The following tables provide a brief description of the properties for Disk Statistics:

■ Disk Details Table

■ Disk Service Time Table

The following table provides a brief explanation of what these tables contain:

Disk Details Table

The following table provides a brief description of the properties for Disk Details:

TABLE C-39 Kernel Reader Alarm Thresholds

Alarm Threshold Message Condition

Error If file system kpctUsed is > 98

Warning If file system kpctUsed is > 90

Error If file system inode percentage is > 90

Warning If file system inode percentage is > 80

TABLE C-40 Disk Statistics Parameters

Property Description

Disk Details Details that pertain to the disk

Disk Service Time Average time with relation to the processing of a transaction

TABLE C-41 Disk Details Properties

Property Description

Diskname Name of the disk (sd0 and so on)

Diskalias Name of the disk (c0t0d0 and so on)

Read Operation Per Sec Read operation per sec

Writes Operation Per Sec Writes operation per sec

Operation Per Sec (read +

write)

Operation per sec (read and write)
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Disk Service Time Table

The following table provides a brief description of the properties for Disk Service

Time:

Number Of Bytes Read Number of bytes read

Number Of Bytes Written Number of bytes written

Number Of Bytes

Transferred (r+w)

Number of bytes transferred (read and write)

Average Number Of

Transactions Waiting

Average number of transactions waiting

Average Number Of

Transactions Running

Average number of transactions running

TABLE C-42 Disk Service Time Properties

Property Description

Diskname Name of the disk (sd0 and so on)

Percentage Of Time

There Is A Transaction

Waiting For Service

Percentage of time there is a transaction waiting for service

(wait queue length)

Percentage Of Time The

Disk Is Busy

Percentage of time the disk is busy (transaction running)

Average Wait Service

Time

Average wait service time

Average Run Service

Time

Average run service time

Average Service Time Average service time

TABLE C-41 Disk Details Properties (Continued)

Property Description
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Filesystem Usage Table

The following table provides a brief description of the properties for Filesystem

Usage:

Note – The Solaris Process Details module is required for the process viewer.

User Statistics Table

The following table provides a brief description of the properties for Solaris Use

Statistics:

TABLE C-43 Filesystem Usage Properties

Property Description

Mount Point Mount point for the file system

Disk Name Name of the device (/dev/dsk/... )

Size (KB) Total size of the filesystem in Kbytes

Free (KB) Available disk space in Kbytes

Free KB (Non Root) Available disk space for non-superusers in Kbytes

Percent Used Percentage of Disk Space Used

Total Inodes Total size of the filesystem in Kbytes

Available Inodes Available disk space for the file system in Kbytes

Percentage Of Inodes Used Percentage of Inodes Used

TABLE C-44 Solaris User Statistics Properties

Property Description

Console User User currently logged in on the console

Number Of Users Number of unique users currently logged in

Number Of User Sessions Number of currently active user sessions

Primary User Login name of the primary user
Appendix C SyMON Modules 315



System Load Statistics Table

The following table provides a brief description of the properties for System Load

Statistics:

CPU Statistics Managed Object Tables

The following tables provide a brief description of the properties for CPU Statistics

managed objects:

■ CPU Utilization Table

■ CPU I/O Table

■ CPU Interrupts Table

■ CPU Systemcall Table

■ CPU Misc Table

■ CPU Regwindow Table

■ CPU Pageinfo Table

■ CPU Faults Table

CPU Utilization Table

The following table provides a brief description of the properties for CPU

Utilization:

TABLE C-45 System Load Statistics Properties

Property Description

1 Min Load Average Load average over the last 1 minute

5 Min Load Average Load average over the last 5 minutes

15 Min Load Average Load average over the last 15 minutes

TABLE C-46 CPU Usage Properties

Property Description

CPU Number CPU number

% CPU Idle Time Percentage of time spent by CPU on idle mode

% CPU User Time Percentage of time spent by CPU on user mode

% CPU Kernel Time Percentage of time spent by CPU on kernel mode

% CPU Wait Time Percentage of time spent by CPU on wait mode

% CPU Wait Time On I/O Percentage of time spent by CPU on wait mode for I/O
316 Sun Enterprise SyMON 2.0 User’s Guide • December 1998



CPU I/O Table

The following table provides a brief description of the properties for CPU I/O:

% CPU Wait Time On

Swap

Percentage of time spent by CPU on wait mode for swap

% CPU Wait Time On Pio Percentage of time spent by CPU on wait mode for Pio

Times Idle Thread

Scheduled

Percentage of idle time spent by CPU on threads scheduled

TABLE C-47 CPU I/O Properties

Property Description

CPU Number Central Processing Unit (CPU) number

Physical Block Reads Number of physical block reads

Physical Block Writes Number of physical block writes

Logical Block Reads Number of logical block reads

Logical Block Writes Number of logical block writes

Raw I/O Reads Number of raw I/O reads

Raw I/O Writes Number of raw I/O writes

Bytes Read By Rdwr() Number of bytes read by Rdwr()

Bytes Written By Rdwr() Number of bytes written by Rdwr()

Terminal Input Characters Number of terminal input characters

Chars Handled In

Canonical Mode

Number of chars handled in canonical mode

Terminal Output

Characters

Number of terminal output characters

Physical Block Writes Number of physical block writes

Procs Waiting For Block I/

O

Number of processes waiting for block I/O

TABLE C-46 CPU Usage Properties

Property Description
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CPU Interrupts Table

The following table provides a brief description of the properties for CPU Interrupts:

CPU Systemcall Table

The following table provides a brief description of the properties for CPU Syscalls:

TABLE C-48 CPU Interrupts Properties

Property Description

CPU Number CPU number

Context Switches Number of context switches

Traps Number of traps

Device Interrupts Number of device interrupts

Interrupts As Threads Number of interrupts as threads

Intrs Blkd/Prempted/

Released

Number of interrupts blocked, pre-empted or released

TABLE C-49 CPU Systemcall Properties

Property Description

CPU Number CPU number

System Calls Number of system calls

Read+Readv System Calls Number of read+ready system calls

Write+Writev System Calls Number of Write+Writev system calls

Forks Number of forks

Vforks Number of Vforks

Execs Number of executables

Msg Count Number of message count

Semaphore Ops Count Number of semaphore operation count

Pathname Lookups Number of pathname lookups

Ufs_iget() Calls Number of ufs_iget() calls

Directory Blocks Read Number of directory block reads

Inodes Taken With Attached

Pages

Number of indexes taken with attached pages
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CPU Misc Table

The following table provides a brief description of the properties for CPU

Miscellaneous:

Indoes Taken With No

Attached Pages

Number of indexes taken with no attached pages

Inode Table Overflows Number of Inode table overflows

File Table Overflows Number of file table overflows

Proc Table Overflows Number of process table overflows

TABLE C-50 CPU Miscellaneous Properties

Property Description

CPU Number CPU number

Involuntary Ctx Switches Number of involuntary context switches

Thread_create()s Number of thread_create()s

Cpu Migrations By Threads Number of CPU migrations by threads

Xcalls To Other Cpus Number of Xcalls to other CPUs

Failed Mutex Enters

(adaptive)

Number of failed mutex enters (adaptive)

Rw Reader Failures Number of read/write reader failures

Rw Write Failures Number of read/write write failures

Loadable Module Loaded Number of loadable module loaded

Loadable Module Unloaded Number of loadable module unloaded

Tries To Acquire RW Lock Number of tries to acquire read/write lock

TABLE C-49 CPU Systemcall Properties (Continued)

Property Description
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CPU Regwindow Table

The following table provides a brief description of the properties for CPU

Regwindow:

CPU Pageinfo Table

The following table provides a brief description of the properties for CPU Pageinfo:

TABLE C-51 CPU Regwindow Properties

Property Description

CPU Number CPU number

User Overflows Number of user overflows

User Underflows Number of user underflows

System Overflows Number of system overflows

System Underflows Number of system underflows

System User Overflows Number of system user overflows

TABLE C-52 CPU Pageinfo Properties

Property Description

CPU Number CPU number

Reclaims Number of reclaims

Reclaims From Free List Number of reclaims from free list

Pageins Number of pageins

Pages Paged In Number of pages paged in

Pageouts Number of pageouts

Pages Paged Out Number of pages paged out

Swapins Number of swap ins

Pages Swapped In Number of pages swapped in

Swapouts Number of swap outs

Pages Swapped Out Number of pages swapped out

Pages Zero Filled On Demand Number of pages zero filled on demand

Pages Freed By Daemon Number of pages fixed by daemon
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CPU Faults Table

The following table provides a brief description of the properties for CPU Faults:

Memory Usage Statistics Table

The following table provides a brief description of the properties for Memory Usage

Statistics:

Pages Examined By Pageout

Daemon

Number of pages examined by the pageout daemon

Revolutions Of The Page

Daemon Hand

Number of revolutions of the page daemon hand

Times Pager Scheduled Number of times pager scheduled

TABLE C-53 CPU Faults Properties

Property Description

CPU Number CPU number

Minor Page Faults Via

hat_fault()
Number of minor page faults through

hat_fault()

Minor Page Faults Via as_fault() Number of minor page faults through as_fault()

Major Page Faults Number of major page faults

Copy-on-write Faults Number of copy-on write faults

Protection Faults Number of protection faults

Faults Due To Software Locking Req Number of software locking faults

as_fault() s In Kernel addr Space Number of in kernel addr space

TABLE C-54 Memory Usage Statistics Properties

Property Description

Physical Memory Available (MB) Physical memory available in Mbytes

Physical Memory In Use (MB Physical memory in use

TABLE C-52 CPU Pageinfo Properties (Continued)

Property Description
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Swap Statistics Table

The following table provides a brief description of the properties for Swap Statistics:

Streams Statistics Managed Objects Table

The following section provides the various Streams Statistics properties for the

following managed objects:

■ Streams Head Cache

■ Queue Cache

■ Streams Messages

■ Linkinfo Cache

■ Strevent Cache

■ Synoq Cache

■ Qband Cache

Percent Memory Used Percentage of memory used

Physical Memory Free (MB) Physical memory free

Percent Memory Free Percentage of memory free

TABLE C-55 Swap Statistics Properties

Property Description

Available KB (Anon Memory Not Reserved) Swap available. Total reserved swap

space.

Reserved KB (Anon Memory Reserved But

Not Allocated)

Swap reserved

Allocated KB (Anon Memory Not Free) Swap allocated

Used KB Swap used

Total KB (Used + Available) Swap total

Percent Swap Used Percentage of swap used

Rule 405 Rule number 405

TABLE C-54 Memory Usage Statistics Properties (Continued)

Property Description
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The following table briefly describes the managed objects:

All of the preceding property tables have similar entries. These are listed in the

following table.

All of the Streams Statistics managed objects have the same properties. The

following table presents these common properties:

TABLE C-56 Streams Statistics Managed Objects

Properties Description

Stream Head Cache Kernel statistics for streams head cache

Queue Cache Kernel statistics for queue cache

Streams Msgs Kernel statistics for streams messages

Linkinfo Cache Kernel statistics for link information cache

Strevent Cache Kernel statistics for streams event cache

Syncq Cache Kernel statistics for synoq cache

Qband Cache Kernel statistics for qband cache

TABLE C-57 Streams Statistics Table Properties

Property Description

The Name Of The Cache Name of the cache

Current Usage (total - avail) Cache’s current usage

Maximum Capacity Maximum capacity of the cache

Cumulative Total Of Allocations Number of total cache allocations

Number of Allocation Failures Number of allocation failures

Percent Used Percentage of cache used
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Software Rules Table

The following table provides a brief description of the properties for Software Rules:

NFS Statistics Module

This section presents property tables for NFS Statistics:

■ RPC Information Table

■ NFS Information Table

Using the NFS Statistics module, statistical information on the Remote Procedure

Calls (RPC) and Sun’s distributed computing file system (NFS) calls may be

monitored. The number of RPC and NFS calls received by the server and made by

the client are monitored and displayed in the main console window along with the

status of the transaction activity on the local host. The following tables list some of

the properties monitored by this module with both the server and the client

statistics.

RPC Information Table

The following table provides a brief description of the properties for RPC

Information:

TABLE C-58 Software Rules Properties

Property Description

Rule rknrd105 Software rule (refer to rule rknrd105 in Appendix D)

Rule rknrd106 Software rule (refer to rule rknrd106 in Appendix D)

TABLE C-59 RPC Server and Client Information Properties

Property Description

RPC Calls Total number of RPC calls made by the host

Bad RPC Calls Total number of calls rejected by the RPC layer

Bad RPC Calls % Percentage of rejected calls compared to the total number of calls

made (bad RPC Calls/RPC calls)

RPC Call Rate Number of RPC calls made per second
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NFS Information Table

The following table provides a brief description of the properties for NFS

Information:

Solaris Process Details Module

The Solaris Process Details module parameters are listed in the following table. This

table is seen when you try to load the module.

The following section presents the Solaris Process property table.

TABLE C-60 NFS Server and Client Information Properties

Property Description

NFS Calls Total number of NFS calls sent by the host

Bad NFS Calls Total number of NFS calls rejected

Bad NFS Calls % Percentage of rejected NFS calls compared to the total number of

calls sent (bad NFS calls/NFS calls)

NFS Call Rate Number of NFS calls sent per second

TABLE C-61 Solaris Process Details Parameters

Property Description

Module Name Name of the module (this is not editable)

Module Description Description of the module (this is not editable)

Version Version of the module (this is not editable)

Enterprise SNMP enterprise in which the module is loaded (this is not editable)

Module Type Type of the module (this is not editable)

Number of

Processes

Number of processes that is obtained by the module based on the

following selection criteria. One of the given numbers can be

selected by the user.

Selection Criteria Selection criteria by which the processes are sorted and selected. For

example, the user can select the top 10 processes using this function.
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Process Table

The following table provides a brief description of the properties for Solaris Process:

TABLE C-62 Process Properties

Property Description

PS Process ID Process ID of this process

PS Parent Process ID Process ID of the parent of this process

PS User ID Login ID of the user of this process

PS User Name Login name of the user of this process

PS Effective User ID Effective user ID of this process

PS Group ID Real group ID of this process

PS Effective Group

ID

Effective group ID of this process

PS Session ID Process ID of the session leader of this process

PS Process Group ID Process ID of the process group leader of this process

PS TTY Controlling terminal for this process

PS Start Time Starting time of this process

PS Time Cumulative execution time of this process

PS State State of this process

PS Wait Channel Address of an event for which this process is waiting

PS Scheduling Class Scheduling class of this process

PS Address Memory address of this process

PS Size Total size of this process in virtual memory

PS Priority Priority of this process

PS Nice Nice value of this process, which is used for priority computation

PS Percent CPU

Time

Percent CPU time

PS Percent Memory Percent memory

PS Command Base name of the executable file for this process

PS Command Line Full command name of this process, including the arguments
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NFS File Systems Module

The NFS File Systems module enables you to monitor the NFS file systems on hosts

running the Solaris 2 and Solaris 7 operating environments. The NFS File Systems

module monitors the amount of disk space occupied by mounted or unmounted file

systems: the amount of used and available space as well as the remaining total

capacity.

When loading the NFS File Systems module, you may define which file systems you

want to monitor by using pattern matching. Patterns may be used to filter which

NFS file systems are monitored by file system or mount point.

File System Usage Table

The following table provides a brief description of the properties for NFS Filesystem

Usage:

Local Applications

The following modules, when loaded, are found under the local applications icon:

■ Agent Statistics Module

■ Data Logging Registry Module

■ Dynamic Reconfiguration Module

■ File Scanning (System Log) Module

■ Health Monitor Module

TABLE C-63 Filesystem Usage Properties

Property Description

NFS Filesys Name of the NFS filesystem

Size Total size of the NFS filesystem in Kbytes

Used Used disk space for the NFS file system in Kbytes

Available Available disk space for the NFS file system in Kbytes

% Used Percentage of NFS disk space used

Rate Percentage capacity change per second

Mount Point Mount point for the NFS filesystem

Entry Number Entry number of the NFS filesystem
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■ Process Monitoring Module

■ Print Spooler Module

Agent Statistics Module

This section presents the following information on Agent Statistics:

■ Object Statistics Table

■ Commands Executed Table

■ Transactions Performed Table

■ PA Process Statistics Table

■ PA Total Process Statistics Table

The Agent Statistics module monitors the health of the agent installed on a host.

This module monitors the objects, processes, and execution of processes by the

agent.

The following table provides a brief description of the Agent Statistics managed

objects:

TABLE C-64 Agent Statistics MainSections

Agent Statistics Tables Description

Object Section Displays data on the objects loaded onto the agent. Status field displays th
current status of the TOE and binary objects loaded into and used by the
agent.

Execution Section Displays data on the number of TCL or TOE commands invoked by the
agent interpreter. Also displays data on the number of asynchronous
transactions initiated by the agent. Status field displays a brief description
of the current status of the objects listed.

TABLE C-65 Agent Statistics Section Properties

Property Description

Object Statistics TOE Count - Number of TOE objects loaded into the agent bob

Count - Number of binary object buffers used by the agent

Commands Executed Total - Total number of commands that have been executed by the

agent

Rate (#/sec) - Number of commands executed by the agent per

second
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The following lists default alarm thresholds for applicable Agent Statistics modules:

The following sections describe the property tables for Agent Statistics.

Object Statistics Table

The Objects section displays data on the Objects loaded on to the agent. The Status

field displays the current status of the TOE and binary objects loaded into and used

by the agent.

Transactions

Performed

Total - Total number of transactions performed by the agent

Rate (#/sec) - Number of transactions performed by the agent per

second

PA Process Statistics Process statistics pertaining to the PA

PA Total Process

Statistics

Total process statistics pertaining to the PA

TABLE C-66 Agent Statistics Alarm Thresholds

Agent Statistics Condition

Error If toeCount > 6000

Warning If toeCount > 5000

Error If bobcount > 1200

Warning If bobcount > 1000

Warning If commands rate > 6000

Warning If transactions rate > 8

Error If process size > 35000

Warning If process size > 30000

Error If rss > 25000

Warning If percentage cpu time > 90

Warning If totalstats.count > 15

Error If totalstats.size > 40000

Warning If totalstats.size > 35000

Warning If totalstats.rss > 35000

TABLE C-65 Agent Statistics Section Properties (Continued)

Property Description
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The following table provides a brief description of the properties for Object

Statistics:

Commands Executed Table

The following table provides a brief description of the properties for Commands

Executed:

Transactions Performed Table

The following table provides a brief description of the properties for Performed

Transactions:

TABLE C-67 Object Statistics Properties

Property Description

Total TOE Objects Number of TOE objects loaded into the agent

Total Bobs Number of binary object buffers used by the agent

TABLE C-68 Executed Commands Properties

Property Description

Total Commands Total number of commands that have been executed by the agent

Rate (/sec) Number of commands executed by the agent per second

TABLE C-69 Transactions Performed Properties

Property Description

Total Transactions Total number of transactions performed by the agent

Transaction Rate

(/sec)

Number of transactions performed by the agent per second
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PA Process Statistics Table

SyMON software monitors the PA process statistics. The following table provides a

brief description of the properties for PA Process Statistics:

TABLE C-70 PA Process Statistics Properties

Property Description

Process ID Identification number of the process

Process Unique Id Unique identification number of the process

Process Name Name of the process

Process Status Status of the process

Process State State of the process

User ID User ID of the process

Virtual Size Total size of the process

Resident Set Size Resident size of the process

Elapsed Time Startup time of the process in seconds since January 1, 1970

Start Date Startup date of the process

Start Time Startup time of the process

CPU Time CPU time used by the process

Percent CPU Time Percentage of CPU time used by the process

Context Switches Context switches of the process

System Calls System calls made by the process

Command Line Command line of the process
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PA Total Process Statistics Table

SyMON software monitors the total PA process statistics.

The following table provides a brief description of the properties for Total PA

Process Statistics:

Data Logging Registry Module

The SyMON Data Logging Registry consists of the registry table.

Registry Table

The following table provides a brief description of the properties for Data Logging

Registry:

TABLE C-71 Total PA Process Statistics Properties

Property Description

Number of Processes Number of agent and child processes

Total Virtual Size Total virtual size of agent and children

Total Res Size Total resident set size of agent and children

TABLE C-72 Data Logging Registry Properties

Property Description

Log Destination

State

State of the log file destination

Module Name Module name for data value (data from this module is logged in the

registry)

Instance Name Name of the instance

Property Name Property name for data value

Logging Interval Logging interval for data value

File Logging Name of the logged file

Data Cache Cache data

Cache Size (samples) Cache size samples
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Dynamic Reconfiguration Module

SyMON monitors the dynamic reconfiguration (DR) properties.

Dynamic Reconfiguration Table

The following table provides a brief description of the properties for Dynamic

Reconfiguration:

Health Monitor Module

The Health Monitor module monitors the health of your host. When alarm

conditions occur, this module offers suggestions, if necessary, on how to improve the

performance of the system.

For example, this module monitors the swap space that is available, reserved,

allocated, and used. Sample alarm messages, from lowest to highest severity,

include:

■ No Worries: sufficient swap space available

■ There is lots of unused swap space

TABLE C-73 Dynamic Reconfiguration Properties

Property Description

Unique Ap_Id Unique attachment point ID

Receptacle An attachment point defines two unique elements, which are

distinct from the hardware resources that exist beyond the

attachment point. One of the two elements of an attachment point is

a receptacle. Configuration administration supports the physical

insertion and removal operations as well as other configuration

administration functions at an attachment point.

Occupant The other element of the attachment is an occupant physical

insertion or removal of hardware resources. This occurs at

attachment points and results in a receptacle gaining or losing an

occupant.

Condition Condition or status

Information Date of operation

Type Type affected, for example, CPU, disk, memory, or other if known

Busy State: whether busy or not

Phys_Id Directory path or physical address
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■ Not much swap left: perhaps add some more

■ Swap space shortage: add some more now

■ Dangerous swap space shortage: add more immediately

This section describes properties of the following Health Monitor module managed

objects:

■ Swap Table

■ Kernel Contention Table

■ NFS Table

■ CPU Table

■ Disk Table

■ RAM Table

■ Kernel Memory Table

■ Directory Cache Table

The Health Monitor module tracks the system properties for the above as described

in the following table:

Swap Table

The following table provides a brief description of the properties for Swap:

TABLE C-74 Health Monitor Properties

Property Description

Swap Details the swap space

Kernel Contention Monitors the kernel contention (mutex) properties

NFS Provides NFS client information

CPU Provides information on the power of the CPU

Disk Presents the disc IO information

RAM Random Access Memory (RAM) information

Kernel Memory Information on kernel memory

Directory Cache Cache of the directory

TABLE C-75 Swap Properties

Property Description

Swap Available KB Swap space value available

Swap Reserved KB Swap space value reserved
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Kernel Contention Table

The following table provides a brief description of the properties for Kernel

Contention (mutex):

NFS Table

The following table provides a brief description of the properties for NFS client

information:

Swap Allocated KB Swap space value allocated

Swap Used KB Swap space value used

Swap Rule Rule for swap

TABLE C-76 Kernel Contention Properties

Property Description

Spins On Mutexes Spins on mutexes (lock not acquired on first try) - Sum for all CPUs

Number Of CPUs Number of CPUs

Spins On Mutexes Rule Spins on mutexes (lock not acquired on first try) - Sum for all CPUs

TABLE C-77 NFS Client Information Properties

Property Description

Calls Total number of RPC calls received

Badcalls Total number of calls rejected by the RPC layer

Retrans Call retransmitted due to a timeout

Badxids Reply from server not corresponding to any outside call

Timeouts Call timed out while waiting for a reply from server

Newcreds Number of times authentication information was refreshed

Badverfs Calls failed due to a bad verifier in response

Timer Call timed out while waiting for a reply from server

TABLE C-75 Swap Properties

Property Description
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CPU Table

The following table provides a brief description of the properties for the central

processing unit (CPU):

Disk Table

The following table provides a brief description of the properties for Disk:

Nomem Failure to allocate memory

Can't Send Failure to send NFS/RPC rule

NFS/RPC Rule Value of the NFS/RPC rule

TABLE C-78 CPU Properties

Property Description

Processes In Run

Queue

Number of processes in run queue

Processes Waiting Number of processes blocked for resources

Processes Swapped Number of processes runnable but swapped

CPU Power Rule CPU power rule

TABLE C-79 Disk Properties

Property Description

Disk Name Name of the disk

Disk Alias Name of the disk (for example, c0t0d0 )

Percent Disk Wait Average number of transactions waiting for service

Percent Disk Busy Percent of time disk is busy

Service Time (ms) Average service time in milliseconds

Disk Rule Disk rule

TABLE C-77 NFS Client Information Properties (Continued)

Property Description
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RAM Table

The following table provides a brief description of the properties for random access

memory (RAM):

Kernel Memory Table

The following table provides a brief description of the properties for Kernel

Memory:

Directory Cache Table

The following table provides a brief description of the properties for Directory

Cache:

TABLE C-80 RAM Properties

Property Description

Handspread Value of hand spread (one of kernel parameters) pages

Scan rate Page scan rate

Real Memory rule Real memory rule

TABLE C-81 Kernel Memory Properties

Property Description

Total Kernel Allocation

Fails

Value of kernel allocation failure

Physical Memory Free Value of free physical memory

Kernel Memory Rule Value of kernel memory rule

TABLE C-82 Name Cache Statistics Properties

Property Description

Cache Hits Number of times a previously accessed page is found

Cache Misses Number of times a previously accessed page is missed

DNLC Rule DNLC (Directory Name Lookup Cache) rule
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Print Spooler Module

The Print Spooler module monitors the status of the printer daemon and print queue

on the local host as well as the printer devices installed on it.

■ Printer LPsched Table

■ Printer Devices Table

■ Printer Queues Table

The following table describes the print spooler managed objects:

Printer LPsched Table

The printer daemon section displays data on the LP Request Scheduler. The

following table provides a brief description of the properties for the Line Printer’s

Schedule (LPsched):

Printer Devices Table

The Printer Devices table lists the network printers installed on a network printer

server(s). The instance name or alias of the printer is displayed in the Name field

followed by the name of the host on which it is installed, displayed in the Machine

field. If you are running a console displaying data monitored by an agent on a print

server host, the path name of the printer device is displayed in the Device field.

TABLE C-83 Print Spooler Properties

Property Description

Lpsched Status Status of the lpsched process

Printer Devices Table lists information about the printer devices

Printer Queues Table lists information about the printer queue

TABLE C-84 Printer LPsched Properties

Property Description

LPsched state Current status of the pinter.
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The following table provides a brief description of the properties for Printer Devices:

Printer Queues Table

The Print Queues table lists the print queues on the local host and displays the

status of each queue.The following table provides a brief description of the

properties for Printer Queues:

Process Monitoring Module

The following section describes the Process Monitoring module parameters and their

property descriptions.

TABLE C-85 Printer Devices Properties

Property Description

Printer name Name of the printer device

Host name Name of the host to which the device is attached

Device name Alphanumeric device name

TABLE C-86 Printer Queues Properties

Property Description

Queue Name Name of the printer

Queue State Current status of the printer queue

Total Number of

Queue Jobs

Total number of jobs in the queue

Total Number of

Current Printer Jobs

Number of jobs currently spooled in the queue

Printer Queue Size Total size (in Kbytes) of the jobs currently spooled in the queue
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Process Statistics Table

The following table provides a brief description of the properties for Process

Statistics:

File Scanning (System Log) Module

The File Scanning module scans files on a host for user-specified patterns. Multiple

instances of the File Scanning module may be loaded to scan multiple files.

The File Scanning module has the following managed objects:

■ File ID Table

■ File Statistics Table

■ Scan Table

The following table provides a brief description of the properties for File Scanning:

TABLE C-87 Process Statistics Properties

Property Description

Entry Name Name of the entry

Name Pattern Name regular expression pattern

Argv Pattern Argv (argument to the program) regular expression pattern

User Specification User specification

Entry Description Description of the entry

Monitoring State Monitoring state of the entry

Process Command Process command name

% CPU Usage Percentage CPU used by the processes

Virtual Size Total size of the processes

Resident Set Size Resident size of the processes

Process Count Number of the processes

TABLE C-88 File Scanning (System Log) Properties

Property Description

File ID Name given by you to the pattern used in the file scan

File Stats State of the pattern listed

Scan Table Name given by you to the pattern used in the file scan
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File ID Table

The following table provides a brief description of the properties for File ID:

File Statistics Table

The File Statistics table displays summary information on the file that is to be

scanned. The following table provides a brief description of the properties for File

Statistics:

Scan Table

The following table provides a brief description of the properties for Scan:

TABLE C-89 File ID Properties

Property Description

Filename Full pathname of the file to be scanned

Scan Mode Mode in which the file is being scanned

Start Time Time the file scan was first started

TABLE C-90 File Statistics Properties

Property Description

Modification Time Date and time when the file was last modified

File Size Size of the file in bytes

Number of Lines Number of lines contained in the file

Lines Per Second Rate at which the file is changing in lines per second

TABLE C-91 Scan Table Properties

Property Description

Pattern Name Name given by you to the pattern used in the file scan

Pattern Description Name of the pattern entry to be displayed in the name field of the

Scan Results section

Regexp Pattern Regular expression pattern to be used when scanning the file for

entries
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Remote Systems

SyMON software enables you to monitor remote systems, such as HP printers

equipped with a JetDirect card.

The following modules, when loaded, are found under the local remote system icon:

■ MIB-II Proxy Monitoring Module

■ HP JetDirect Module

MIB-II Proxy Monitoring Module

The MIB-II Proxy Monitoring module monitors the MIB-II parameters for remote

systems. The various categories that monitor the MIB-II parameters on remote

systems are listed in the following sections, which list MIB-II group tables:

■ MIB-II System Group Table

■ MIB-II Interfaces Group Tables

■ MIB-II IP Group Table

■ MIB-II ICMP Group Table

■ MIB-II TCP Group Tables

■ MIB-II UDP Group Tables

For more information on the properties of these parameters, see Section “MIB-II

Instrumentation Module” on page C-302, which lists the properties for local systems.

The same functionality is applied on remote systems by the MIB-II Proxy Monitoring

module. For more information on the definition of MIB-II, see the standards

documentation RFC1213 (Request For Comments 1213).

Pattern State State of the pattern listed (on/off). The off state indicates that the

pattern listed will not be used in the file scan

Matches Number of pattern matches found during the file scan

Total Matches Total number of matches in current file

TABLE C-91 Scan Table Properties (Continued)

Property Description
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HP JetDirect Module

Agents can monitor HP printers equipped with a JetDirect card by proxy using the

HP JetDirect module. Multiple HP printers may be monitored by loading multiple

instances of this module.

Printer Status Table

The following table provides a brief description of the properties for Printer Status:

TABLE C-92 General Printer Status Properties

Property Description

Printer Display Printer’s status
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APPENDIX D

SyMON Rules

This appendix lists the Sun Enterprise SyMON rules for the following modules:

■ Config-Reader

■ Kernel Reader

■ Health Monitor

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

A rule is an alarm check mechanism that allows for complex or special purpose logic

in determining the status of a monitored host or node.

There are two types of rules—simple and complex:

■ Simple rules are based on the rCompare rule, in which monitored properties are

compared to the rule. If the rule condition becomes true, an alarm is generated.

For example, a simple rule can be the percentage of disk space used. If the

percentage of disk space used equals or is greater than the percentage specified in

the rule, then an alarm is generated.

■ Complex rules are based on multiple conditions becoming true. For example, one

complex rule states that when a disk is over 75% busy and the average queue

length is over 10 and the wait queue is increasing, then an alert alarm is

generated.

Note – Any user-customized SyMON 1.x rules must be ported to the new

environment before the rules can be used in SyMON 2.0.
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Config-Reader

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

This section includes Config-Reader rules with detailed explanation of those rules

that have critical alarms.

TABLE D-1 Config-Reader Rules

Rule ID Description Type of Alarm

rcr4u201 Precharge status rule

This alarm is generated when the status of the Precharge

voltages is not “OK.”

Critical

rcr4u203 Power supply status rule

This alarm is generated when the status of the Power supply

is not “OK.”

Critical

rcr4u205 Temperature rule

This rule is triggered when the temperature on the system

boards go beyond a threshold value. Depending on the board

temperature, a critical or an alert alarm is generated.

Critical, Alert

rcr4u207 CPU unit status rule

When the CPUs are not “online” this rule is generated.

Critical

rcr4u209 SIMM error rule Alert alarm that is

closed immediately

rcr4u210 Hardware error Alert alarm that is

closed immediately

rcr4u211 Fatal error Alert alarm that is

closed immediately

rcr4u212 CPU detects ECC error on SIMM Alert alarm that is

closed immediately

rcr4u213 Hot-plug removed Alert alarm that is

closed immediately

rcr4u214 Power failing Alert alarm that is

closed immediately

rcr4u215 Hot-plugged Alert alarm that is

closed immediately
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rcr4u216 CPU panic Alert alarm that is

closed immediately

rcr4u217 SCSI tape error Alert alarm that is

closed immediately

rcr4u218 AC status rule

This rule is generated when the AC status is not “OK.”

Critical

rcr4u219 Disk removed Alert alarm that is

closed immediately

rcr4u220 Disk inserted Alert alarm that is

closed immediately

rcr4u221 Redundant power Alert alarm that is

closed immediately

rcr4u222 Testing SunVTS messages rcr4u222 log Alert alarm that is

closed immediately

rcr4u223 Testing SunVTS messages rcr4u223 log Alert alarm that is

closed immediately

rcr4u224 Hot-plug installed Alert alarm that is

closed immediately

rcr4u225 ST status rule

This rule is generated when the status of the tape drive is not

“OK.”

Critical

rpfa300 Complex rule looks for SIMM memory errors in syslog and

makes a predictive failure alarm entry for each error.

Critical

rpfa301 Complex rule looks for disk soft errors in syslog and makes

a predictive failure alarm entry for each error.

Critical

rpfa302 Complex rule looks for disk soft errors in syslog that are

spilled out by a SMART drive.

Critical

TABLE D-1 Config-Reader Rules (Continued)

Rule ID Description Type of Alarm
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Kernel Reader

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The following table lists the Kernel Reader complex rules.

TABLE D-2 Kernel Reader Simple Rules

Property Description

kpctused Percent of disk space used

ipctused Percent of inodes used

TABLE D-3 Kernel Reader Complex Rules

Rule ID Description Type of Alarm

rhltm000 This rule checks whether there is enough swap space. Critical

rknrd100 This rule covers a transitory event and generates an alert

alarm when the disk is over 75% busy, the average queue

length is over 10, and the wait queue is increasing. Alert

alarm stays on until the disk is not over 70% busy and the

average queue length is no longer than 8.

Alert

rhltm001 Each time a CPU has to wait for a lock to become free, it

wastes CPU power; and this event is counted, since the kernel

uses mutually exclusive locks to synchronize its operation and

keep multiple CPUs from concurrently accessing critical code

and data regions.

Critical

rhltm002 This rule is based on the observation that NFS remote

procedure call timeouts may be associated with duplicate

responses after the call is retransmitted. This indicates that the

network is okay but the server is responding slowly.

Critical

rhltm003 Here the run queue length is divided by the number of CPUs.

This is based upon the fact that every CPU takes a job off the

run queue in each time slice.

Critical

rhltm004 A busy or slow disk reduces system throughput and increases

user response times. This rule identifies the disks that are

loaded so that the load can be rebalanced.

Critical
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rhltm005 RAM rule based on residency time for an unreferenced page.

The virtual memory system indicates that it needs more

memory when it scans looking for idle pages to reclaim for

other uses.

Critical

rhltm006 This rule refers to the kernel memory allocation problem. It

shows up when login attempts or network connections fail

unexpectedly. There are two possible causes. Either the kernel

has reached the extent of its address space, or the free list does

not contain any pages to allocate. It is more a sign of a

problem that may otherwise be overlooked.

Critical

rhltm007 There is a global cache of directory path name components

called the directory name lookup cache, or Directory Name

Lookup Cache Rule (DNLC). Missing a cache means that

directory entries must be read from disk and scanned to locate

the right file.

Critical

rknrd102 This rule covers a transitory event and generates an alert

alarm if 90% of swap space is in use. Event causing the alarm

stays open until swap space in use is less than 80% of the total

swap space.

Alert

rknrd103 This rule covers a transitory event and generates an alert

alarm if swapping and paging is high for a given CPU. This

indicates that a CPU may be thrashing. Alert alarm is

generated when CPU exceeds 1 swap-out, 10 page-ins, and 10

page-outs per second. Alert alarm stays on if CPU exceeds 1

swap-out, 8 page-ins, and 8 page-outs per second.

Alert

rknrd104 This rule covers a transitory event and generates an alert

alarm if average CPU load is over 95% and the system run

queue length is over 4 times the number of CPUs on the

system. Alert alarm stays on until either the CPU load is less

than 90%, or the system run queue length is less than 2 times

the number of CPUs on the system.

Alert

rknrd105 File System Full error. This rule looks for a file system full

error message in the syslog (/var/adm/message ).

Alert

rknrd106 No swap space error. This rule looks for a no swap space error

message in the syslog (/var/adm/message).
Alert

rknrd401 This rule checks for disks being busy more than 90% of the file

for x hours. The parameters field holds the last time CPU load

was below 6, and is initialized to some date in the year 2001.

Informational

rknrd402 This rule checks if available swap space drops below 10% for

x hours. The parameters field holds the last time CPU load

was below 6, and is initialized to some date in the year 2001.

Informational xxx

TABLE D-3 Kernel Reader Complex Rules (Continued)

Rule ID Description Type of Alarm
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Health Monitor

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

The following table lists the Health Monitor complex rules.

rknrd403 Test for Meta CPU events. Informational

rknrd404 Test for Meta Disk events. Informational

rknrd405 Test for Meta Swap events. Informational

TABLE D-4 Health Monitor Complex Rules

Rule ID Description Type of Alarm

rhltm000 Virtual Memory - Swap Space - Rule Critical, Alert,

Caution

rhltm001 CPU Mutex Rule Critical, Alert,

Caution

rhltm002 NFS RPC Client Rule Critical, Alert,

Caution

rhltm003 CPU Power Rule Critical, Alert,

Caution

rhltm004 Disk I/O Rule Critical, Alert,

Caution

rhltm005 RAM rule based on residency time for an unreferenced page Critical, Alert,

Caution

rhltm006 Kernel memory allocation rule Critical, Alert,

Caution

rhltm007 Directory Name Lookup Cache Rule Critical, Alert,

Caution

TABLE D-3 Kernel Reader Complex Rules (Continued)

Rule ID Description Type of Alarm
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APPENDIX E

SyMON Discovery Principles

This appendix describes IP Routing.

IP Routing

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

Overview of IP Addressing

Internet protocol (IP) addresses are 32 bits long. Thus, there is a total possibility of

approximately 4 billion addresses for the entire Internet. An IP address is expressed

as a series of octets separated by dots. For example, the address 11111111 00000001

00000101 00001010 is written as 127.1.5.10, or using hexadecimal notation, 7f.1.5.a0.

Because of this vast number of addresses, there was a need to organize the network

hierarchically into domains. This need led to the definition of name domains and

network classes. Since each site can vary in size, IP addresses are divided into three

main types or classes. A large site can reserve a class A address and receive 224

individual addresses, while a small site can reserve a class C address and receive 28

individual addresses.
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Network Classes

Class A uses the first octet for the network address, and the rest for host addresses

within this network. For example, a site whose network address is 129.0.0.0 would

own the 224 addresses between 129.0.0.0 and 129.255.255.255.

Class B uses two octets for the network address, and two for the host address. For

example, a site whose network address is 129.123.0.0 would own the 216 addresses

between 129.123.0.0 and 129.123.255.255.

Class C uses three octets for the network address, and one for the host address. For

example, a site whose network address is 129.123.456.0 would own the 28 addresses

between 129.123.456.0 and 129.123.456.255.

Subnetting

Subnetting is defined as dividing a network into smaller segments, or subnets,

which is imperative for Class A and B networks. Routers do not forward packets

outside a subnet if the destination address is within the same subnet. Thus, network

traffic is decreased dramatically by segmenting a large network. For example, we

have a class B network that is segmented into 255 subnets. Unless a packet

destination is a host outside the subnet, a local packet is sent to 255 hosts instead of

256,000.

Netmasks

The format of the netmask is a series of 1s followed by a series of 0s. By ANDing an

IP address with a netmask, we can get the address of the subnet.

Routers use netmasks to decide whether to forward a packet to an external subnet.

For example, we have a machine with an IP address of 129.123.456.95 that is sending

an e-mail to another machine whose IP address is 129.123.456.100. By ANDing both

Network Host

0xxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx

Network Host

10xxxxxx xxxxxxxx xxxxxxxx xxxxxxxx

Network Host

110xxxxx xxxxxxxx xxxxxxxx xxxxxxxx
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IP addresses with a netmask (255.255.255.00), the result is 129.123.456.0 for both

machines. The router then concludes that both the source machine and destination

machine are in the same subnet. Therefore, the router does not forward the e-mail to

external subnets.

On the other hand, if the destination address is 129.123.567.100, then the resulting

subnet address is 129.123.567.0. The router forwards the e-mail to the external subnet

(129.123.567.0).

Note – Although some of these examples apply to Ethernet links, the principles still

apply regardless of the type of network.
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Glossary

Note – The Sun Enterprise SyMON software version 2.0 is referred to as SyMON

throughout this document.

agent A software process, usually corresponding to a particular local managed host,

that carries out manager requests and makes local system and application

information available to remote users.

alarm An abnormal event, which may be indicative of current or impending

problems, is detected by a SyMON agent. The SyMON agent passes

information about the abnormal event to the SyMON server. The server passes

this information on to the user as an alarm, when the abnormal event matches

a predefined alarm threshold.

alarm
acknowledgment SyMON users can acknowledge alarms, indicating that the alarm does not

represent a serious problem or that the problem is being resolved.

Acknowledged alarms take a lower priority than unacknowledged alarms.

Attribute Editor A window which provides information about the selected object. In addition,

the Attribute Editor enables you to customize various monitoring criteria for

that object. The monitoring criteria are dependent on the type of object. There

are Attribute Editors for domains, hosts, modules, and data properties.

bus A point-to-point network component. Used by SyMON software to represent a

network link to which many other hosts may be connected.

community A string similar to a password that is used to authenticate access to an agent’s

monitored data.

complex alarm A complex alarm is based on a set of conditions becoming true. Unlike simple

alarms, you cannot set thresholds for complex alarms.

Console window A graphical user interface component of SyMON software based on Java

technology that is used to view monitored hosts (and managed objects)

information and status and to interact with SyMON agents.
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Discovery A SyMON tool available from the main console window that is used to find

hosts, routers, networks, and Simple Network Management Protocol (SNMP)

devices that can be reached from the SyMON server.

domain An arbitrary collection of hosts and networks that are monitored by SyMON

software as a single hierarchal entity. Users may choose to divide their

enterprise into several domains, each to be managed by different users.

dynamic loadable
modules A SyMON agent module that can be loaded or unloaded at run time, enabling

monitored properties to be displayed on the SyMON main console window

without having to restart the console or agent.

event A change in the state of a managed object.

file scanning The act of scanning a file (usually a log file) for certain patterns (regular

expressions) that may be indicative of problems or significant information.

SyMON agents use file scanning to assist in the monitoring of systems and

applications when these components do not provide direct access to status

information.

graphical user
interface The graphical user interface, or GUI, is a window that provides the user with a

method of interacting with the computer and its special applications, usually

with a mouse or other selection device. The window usually includes such

things as windows, an intuitive method of manipulating directories and files,

and icons.

hierarchy view A window view that defines objects in a hierarchy or tree relationship to one

another. Objects are grouped depending on the rank of the object in the

hierarchy.

hop The number of routers a packet goes through before reaching its destination.

instance A single word or alpha-character string that is used internally within the

SyMON agent to identify uniquely a particular module or a row within a

module.

manage In SyMON software, manage is defined as being able to monitor, as well as

manipulate the object. For example, management privileges include

acknowledging and closing alarms, loading and unloading modules, changing

alarm thresholds, and so on. Management privileges are similar to read, write,

and execute access.

MIB Management Information Base. A MIB is a hierarchical database schema

describing the data available from an agent. The MIB is used by SyMON

agents to store monitored data that can be accessed remotely.

module A software component that may be loaded dynamically to monitor data

resources of systems, applications and network devices.
356 Sun Enterprise SyMON 2.0 User’s Guide • December 1998



monitor In SyMON software, monitor is defined as being able to observe an object,

view alarms and properties. Monitoring privileges are similar to read-only

access.

node A node is a workstationor server.

object A particular resource (computer host, network interface, software process, and

so on) which is subject to monitoring or management by SyMON software. A

managed object is one that you can manipulate. For example, you can

acknowledge and turn off an alarm condition for an object that you can

manage. A monitored object is one that you can observe but not acknowledge

or otherwise manage.

remote server context A remote server context refers to a collection of SyMON agents and a

particular server layer with which the remote SyMON agents are associated.

request caching The SyMON server consolidates duplicate outstanding requests originating

from multiple consoles and eliminates the execution of redundant requests.

rule A rule is an alarm check mechanism that allows for complex or special purpose

logic in determining the status of a monitored host or node.

seed The SNMPv2u password for the SyMON user group called esmaster . This is

not necessarily a UNIX password.

server The collection of programs and processes (SNMP-based trap, event, topology,

configuration, and Java server) that work on behalf of a SyMON user to help

manage a particular set of networks, hosts and devices. Usually sends requests

to SyMON agents, accepts collected data from them, and passes the data to the

SyMON console for display.

server context See “remote server context.”

simple alarm Simple alarms are based on one condition becoming true. You may set alarm

thresholds for simple alarms.

SNMP Simple Network Management Protocol. A simple protocol designed to allow

networked entities (hosts, routers, and so on) to exchange monitoring

information.

SNMPv2 usec SNMP version 2, user-based security model security standards.

SyMON superuser SyMON superuser is a valid user on a server host. The superuser decides what

the agents are in the context of the server. By default, the superuser password

is used as a seed for security key generation.

SyMON user SyMON users are the members of the symon group in the /etc/group file.

topology view The topology view displays the members of the object selected in the hierarchy

view.

URL Uniform Resource Locator. An URL is a textual specification describing a

resource which is network-accessible.
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Index
A
absolute Timex expression, 160, 168 to 174

AC status, 347

access control, 250, 254

categories, 250

ACL, 250, 254

Actions tab, 151

adding

a row to a data property table, 125 to 128

objects to domains, 75 to 90

row, 118

Address process property, 229

advanced message filtering menu, 236

agent

health, 182

interacting with console and server, 3 to 5

port number, 273

SNMP, 10

Agent Statistics

Configuration manager, 276

Event manager, 276

SyMON server, 276

Topology manager, 276

Trap handler, 276

alarm limits, 149

alarm threshold

creating, 150 to 151

alarm thresholds, 257

alarms

accessing, 212

acknowledged, 209

alert, 346, 347, 348, 349, 350

alert alarm generation, 345

categories, 213

caution, 350

complex, 8 to 9

creating, 207

critical, 346, 347, 348, 349, 350

determining the severity of an alarm, 208

generation, 345

red alarm icon, 208

schedule, 159

seeing, 106

sending email when alarm occurs, 153

setting schedule, 175 to 180

severities, 106

simple, 8 to 9, 148 to 149

simple rules, 345

states, 213

threshold, 148 to 149

types of, 346

unacknowledged, 209

windows, 149

Alarms tab button, 220

Alarms tab in the Attribute Editor, 148 to 149

Attribute Editor, 118

Actions tab, 151

Alarms tab, 148 to 149

definition, 145

History tab, 156

Info tab, 147

module, 197, 201

opening, 146

Refresh tab, 154
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security tab, 258

attributes

changing, 67 to 69

automatic notification of an alarm condition, 153

B
Browser Details window, 108, 111

Browser tab button, 220

buttons

Discovery Request windows, 77 to 78

Domain manager window, 39

Hide Details, 245

Show Details, 245

C
changing attributes about an object, 67 to 69

changing port addresses, 272 to 275

circular log files, 285

class A, B, and C networks, 352

Class process property, 229

client

NFS, 350

RPC, 350

Command process property, 230

CommandLine process property, 230

comparison Timex expression, 160 to 167, 175 to

180

complex

rules, 345

complex alarms, 8 to 9

complex rules

alert alarm generation, 345

Config Reader, 110, 116

special instructions for Details window, 240

Config-Reader

rules, 345

Configuration Details window, 111

Configuration manager, 5, 256

port number, 273

Configuration manager agent statistic, 276

Configuration tab button, 220

configuring legacy agent as subagent, 270 to 272

configuring port addresses, 272 to 275

configuring the Details Process display, 228 to 231

conflict with port addresses, 272 to 275

conflicting port numbers, 18

connecting objects, 64

console, 3

interacting with server and agent, 3 to 5

multiple consoles, 3

console window, 10

copying

groups, 66 to 67

module, 117

objects, 65 to 67

variable to graph, 117

CPU

meta, 350

CPU load, 349

CPU panic, 347

CPU power, 350

CPU thrashing, 349

CPU trashing, 349

CPU unit status, 346

CPU% process property, 230

creating

alarm threshold, 150 to 151

domains, 40

groups, 50 to 53

links between objects, 64

monitored modules, 59 to 61

nodes, 54 to 58

objects with Discovery manager, 79 to 82

segments, 62 to 64

creating a module object, 197

creating alarms, 207

creating server component object, 277

critical

alarms, 346, 347, 348, 349, 350

cron Timex expression, 160, 168 to 174

cutting objects, 70 to 71

cyclic Timex expression, 160, 160 to 167

D
data

displaying, 123
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probing, 129 to 131

refreshing, 128

data property

Attribute Editor, 145

displaying, 123

graphing, 132

monitoring, 159

refresh interval, 155

sampling points, 158

tool tip, 97

data property table

adding row to, 125 to 128

default domain, 35

default privileges

overriding, 263

topology manager

SyMON default security privileges, 262

deleting

discovery request, 90

domains, 39, 42 to 44

objects, 72 to 73

row, 118

deleting events from event database, 282 to 284

Details

alarms, 111

browser, 111

configuration, 111

log view, 111

processes, 111

Details Process display

configuring, 228 to 231

selecting columns, 228 to 230

Details window

Actions tab in the Attribute Editor, 151

Alarms tab button, 220

Alarms tab in Attribute Editor, 148 to 149

browser tab, 108

Browser tab button, 220

Configuration information types, 239

Configuration tab button, 220

disk total, 241

exiting, 113

History tab in the Attribute Editor, 156

Info tab button, 220

Info tab in Attribute Editor, 147

Info tab properties, 224

Logview tab button, 220

memory hardware total, 241

monitoring log messages, 237 to 238

moving columns in Process display, 230

Process Statistics window, 231

Process tab button, 220

Processes tab, 225

processors total, 241

Refresh tab in the Attribute Editor, 154

Solaris Process Details module, 226

sorting columns in Process display, 230

starting, 111, 221 to 223

tab buttons, 111

tape devices total, 241

Directory Name Lookup Cache, 349, 350

Directory Size monitoring

list files, 129 to 131

disabling a module, 195

disabling module, 117

disabling row, 118

discovery

checking part numbers, 83

deleting request, 90

filters, 84

methods of, 81, 82

modifying request, 89 to 90

request ID, 81

scheduling requests, 84

server context, 81

starting, 76 to 78

starting request, 90

status, 77 to 78

stopping request, 90

timeout, 81, 83

Discovery Requests window, 77 to 78

disk

busy, 348, 349

busy state, 345

complex rules, 345

inserted, 347

meta, 350

removed, 347

soft errors, 347

disk load, 348

disk soft errors

spilled out by SMART drive, 347

disks, total in Details window, 241

displaying data, 123

domain
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creating, 40

default, 35

definition, 6, 33

deleting, 39, 42 to 44

hierarchy examples, 34

home, 35 to 37, 39

initiating a discovery request, 79 to 82

listing, 104 to 105

members, 6

multiple, 33

populating, 40 to 41, 75 to 90

referencing, 39

remote, 44 to 46

security, 11, 39

set home domain, 39

switching between, 104 to 105

SyMON Administrative Domains pull-down

menu, 41

Domain manager buttons, 39

domain-config .x file, 273

Dynamic Reconfiguration

definition, 244

special instructions for Details window, 240

Dynamic Reconfiguration module, 14

E
ECC error, 346

Edit menu, 100

editing

graph axes, 141

module, 117

row, 118

editing modules, 191 to 194

EGroup process property, 229

enabling

module, 117

row, 118

enabling a module, 195

Entity Desc property, 224

Entity Event Destination property, 224

Entity Family property, 224

Entity Full Desc property, 224

Entity IsPolling property, 224

Entity Polling Type property, 224

Entity Trap Destination property, 224

error

fatal, 346

esadm, 251, 252, 254, 261

esdomadm, 251, 252, 261

esmaster, 27

esmaster , 250, 251, 252, 267 to 268

esops , 251, 252, 261

espublic , 27, 250, 252, 255, 257, 260, 267 to 268

es-setup  utility, 23

es-start  utility, 25, 27

es-stop  utility, 30, 31

/etc/nsswitch.conf file, 23

EUser process property, 229

Event manager, 5, 256, 281 to 284

port number, 273

Event manager agent statistic, 276

events

deleting from event database, 282 to 284

meta disk, 350

meta swap, 350

exiting Details window, 113

F
fatal error, 346

File menu items, 100

File Monitoring

adding row to table, 125 to 128

File Monitoring module, 125

File Scanning module, 125

file system

full, 349

filtering discovery requests, 84

filtering log messages, 234 to 237

finding specific log messages, 239

G
general group, 50

Go menu items, 102

graph

applying template, 137

copying variable to, 117
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data property, 132

editing axes, 141

historical data, 156

menu items, 138 to 144

multiple data properties, 132

opening, 136

sampling points, 158

saving, 135

group

security, 11

Group ID process property, 229

groups, 34, 251

copying, 66 to 67

creating, 50 to 53

general and IP-based, 50

moving, 66 to 67

pasting, 66 to 67

security, 251

within SyMON, 251

H
hand icon, 243

hardware

modules relating to, 289

pathnames displayed, 243

resources displayed, 241

supported platforms, 14, 15

Config-Reader module, 14

views of, 242

hardware error, 346

hardware monitored by SyMON, 2

Health Monitor

rules, 345

help, 105

pop-up balloon, 115

helpful hints

displaying levels of details, 222, 223

Search function is case-sensitive, 247

searching in multiple instances, 247

using tool tips, 97, 115

viewing long messages in table cells, 222

Hide Details button, 245

hierarchy view, 10, 92

mouse actions, 95

history interval

schedule, 159

setting, 158, 160 to 167, 168 to 174

History tab, 156

home domain, 35 to 37, 39

host

Details window, 108

security, 11, 119

Hostname property, 224

hot-plug

installed, 347

removed, 346

hot-plugged, 346

I
I/O

disk, 350

increasing virtual size, 279 to 281

Info tab

Entity Desc property, 224

Entity Event Destination property, 224

Entity Family property, 224

Entity Full Desc property, 224

Entity IsPolling property, 224

Entity Polling Type property, 224

Entity Trap Destination property, 224

Hostname property, 224

IP Address property, 224

Netmask property, 224

Operating System property, 224

properties, 224

Target Hostname property, 224

Target IP Address property, 224

Info tab button, 220

Info tab in the Attribute Editor, 147

Installation

minimum disk space required, 14

prerequisites, 17

installation

conflicting ports, 18

default domain, 35

of add-on components, 19

package location, 20

post-installation tasks, 23

IP

addresses within server contexts, 256
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IP Address property, 224

IP-based group, 50

J
Java

security classes, 249

K
kernel memory allocation, 349, 350

Kernel Reader

creating alarm, 150 to 151

displaying data, 123

rules, 345

keys, 267 to 268

regenerating, 269

L
legacy agent, 270 to 272

legacy subagents, 18

loading module, 117

loading modules, 184 to 190

local applications

modules relating to, 327

locations of log files, 233

log

SunVTS, 347

log files, viewing, 234

log messages

filtering, 234 to 237

finding specific messages, 239

log view, 111

log viewer, 11

Logview tab button, 220

M
main console window, 10

Management Information Base, See modules, MIB

masking of network addresses, 352

memory hardware, total in Details window, 241

Memory% process property, 230

Menu items, 99

Edit, 100

File, 100

Go, 102

Tools, 102

View, 101

menu items

graph, 138 to 144

menu, View Columns, 228

messages

viewing, 11

meta CPU events, 350

mibiisa  port conflicts, 18

modifying objects, 67 to 69

module

Agent Statistics, 328

copying, 117

creating a monitored module, 59 to 61

Data Logging Registry, 332

definition, 108

Details window, 108

disabling, 117

Dynamic Reconfiguration, 333

editing, 117

enabling, 117

File Scanning, 340

hardware, 289

Health Monitor, 333

HP JetDirect, 343

Kernel Reader, 312

loading, 117

MIB-II Instrumentation, 302

MIB-II Proxy Monitoring, 342

NFS File Systems, 327

NFS Statistics, 324

Print Spooler, 338

Process Monitoring, 339

schedule, 159

security, 11, 119

setting schedule, 175 to 180

Solaris Process Details, 325

unloading, 117

module object

creating, 197

modules

Agent Statistics, 182
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Attribute Editor, 197 to 201

Config Reader, 182

Data Logging Registry, 182

definition, 8

Directory Size Monitoring, 183

disabling, 195

dynamic, 8

Dynamic Reconfiguration, 183

editing, 191 to 194

enabling, 195

File Monitoring, 183

File Scanning, 183

hardware, 289

Health Monitor, 183

HP JetDirect, 183

in alphabetical listing, 288

Kernel Reader, 183

loaded by default, 182

loading, 184 to 190

local applications, 327

MIB, 7 to 8

MIB-II Instrumentation, 183

MIB-II Proxy Monitoring, 183

monitoring, 197

NFS File Systems, 183

NFS Statistics, 183

number of instances loaded, 188

operating system, 301

Print Spooler, 183

Process Monitoring, 183

remote systems, 342

schedule, 197 to 201

security, 197 to 201

security permissions, 200

Solaris Process Details, 183

that load automatically, 288

that load multiple times, 288

unloading, 196

using ’Add Row’, 288

monitored hardware, 2

monitored software properties, 2, 8

monitoring

data property, 159

objects, methods of, 56 to 57

monitoring log messages, 237 to 238

monitoring server components, 277

moving columns in Details Process display, 230

moving groups, 66 to 67

mutex, 350

N
navigating

domains, 104 to 105

main console window, 103

Netmask, 83

netmask ANDing, 352

Netmask property, 224

NFS remote procedure, 348

Nice process property, 229

node

creating, 54 to 58

notifying you when an alarm occurs, 153

O
object

Details window, 108

linking two objects, 64

objects

alarms, 106

copying, 65

creating automatically with Discovery

manager, 79 to 82

cutting and pasting, 70 to 71

delete, 72 to 73

modifying, 67 to 69

pasting, 65

octets in network addressing, 352

opening

Attribute Editor, 146

graphs, 136

operating system

modules relating to, 301

Operating System property, 224

P
pasting

groups, 66 to 67

objects, 65 to 67, 70 to 71

permissions
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security, 249

pfiles process statistic, 231

PGroup process property, 229

physical view, 11

pictures of system hardware, 242

PID process property, 229

ping  command, 81, 82

pldd process statistic, 231

pmap process statistic, 231

populating domains, 40 to 41, 75 to 90

pop-up balloon help, 115

port

addresses within server contexts, 256

port addresses

changing, 272 to 275

within server contexts, 256

port numbers

discovery process, 83

starting console, 26

power, 347

failure, 346

supply, 346

PPID process property, 229

precharge status, 346

printer

monitoring, 183

Priority process property, 229

Process display

configuring, 228 to 231

Process Monitoring module, 125

process property

Address, 229

Class, 229

Command, 230

CommandLine, 230

CPU%, 230

EGroup, 229

EUser, 229

Group ID, 229

Memory%, 230

Nice, 229

PGroup, 229

PID, 229

PPID, 229

Priority, 229

Sesstion ID, 229

Size, 229

Start time, 229

State, 229

Time, 229

tty, 229

UID, 229

User, 229

Wait Channel, 229

Process Statistics window, 231

Process tab button, 220

process viewer, 10

processes, 111

processors, total in Details window, 241

property, See data property

pstack process statistic, 231

Q
queue length

complex rules, 345

R
RAM, 350

rCompare  rule, 9

rcr4u201, 346

rcr4u203, 346

rcr4u205, 346

rcr4u207, 346

rcr4u209, 346

rcr4u210, 346

rcr4u211, 346

rcr4u212, 346

rcr4u213, 346

rcr4u214, 346

rcr4u215, 346

rcr4u216, 347

rcr4u217, 347

rcr4u218, 347

rcr4u219, 347

rcr4u220, 347

rcr4u221, 347

rcr4u222, 347
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rcr4u223, 347

rcr4u224, 347

rcr4u225, 347

referencing domains, 39

refresh data, 128

refresh interval

schedule, 159

setting, 155, 160 to 167, 168 to 174

Refresh tab, 154

regenerating security keys, 269

relationships

inclusive, 254

remote domains, 44 to 46

remote server access, 255

remote server context, 5

remote systems

modules relating to, 342

rhltm000, 348, 350

rhltm001, 348, 350

rhltm002, 348, 350

rhltm003, 348, 350

rhltm004, 348, 350

rhltm005, 349, 350

rhltm006, 349, 350

rhltm007, 349, 350

rknrd100, 348

rknrd102, 349

rknrd103, 349

rknrd104, 349

rknrd105, 349

rknrd106, 349

rknrd401, 349

rknrd402, 349

rknrd403, 350

rknrd404, 350

rknrd405, 350

RMI port address, 275

router forwarding rule, 352

routing tables, 81, 82

row

adding, 118, 125 to 128

deleting, 118

disabling, 118

editing, 118

enabling, 118

rpfa300, 347

rpfa301, 347

rpfa302, 347
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	8. Type a value in the Critical Threshold (>) field which is less than the current value.
	9. Complete one of the following actions:
	10. Click the Alarms tab button in the Details window.
	11. Acknowledge this alarm.
	12. Create additional alarm thresholds and familiarize yourself with their operation.

	Actions Tab in the Attribute Editor
	FIGURE�7�32 Attribute Editor Actions Tab for a Monitored Property

	To Send an Email
	1. Click the Browser tab button in the Details window.
	2. Click the light�colored circle next to the Operating System icon in the hierarchy tree view.
	3. Click the light�colored circle next to the Kernel Reader icon.
	4. Double�click on the System Load Statistics icon.
	5. Click with your left mouse button and select the table cell for Load Averages Over the Last 5 ...
	6. Click the Attributes button.
	7. Click the Actions tab button.
	8. Type email username in the Critical Action field.
	9. Complete this procedure with one of the following actions:

	Refresh Tab in the Attribute Editor
	FIGURE�7�33 Attribute Editor Refresh Tab for a Monitored Property

	To Set a Refresh Interval
	1. Click the Browser tab button in the Details window.
	2. Click the light�colored circle next to the Operating System icon in the hierarchy tree view.
	3. Click the light�colored circle next to the Kernel Reader icon.
	4. Double�click on the System Load Statistics icon.
	5. Click with your left mouse button and select the table cell for Load Averages Over the Last 5 ...
	6. Click the Attributes button.
	7. Click the Refresh tab button.
	8. Type a value (in seconds) in the Refresh Interval field or click the Advanced button.
	9. Complete this procedure with one of the following actions:

	History Tab in the Attribute Editor
	FIGURE�7�34 Attribute Editor History Tab for a Monitored Property

	To Set a History Interval
	1. Click the Browser tab button in the Details window.
	2. Click the light�colored circle next to the Operating System icon in the hierarchy tree view.
	3. Click the light�colored circle next to the Kernel Reader icon.
	4. Double�click the System Load Statistics icon.
	5. Click with your left mouse button and select the table cell for Load Averages Over the Last 5 ...
	6. Click the Attributes button.
	7. Click the History tab button.
	8. Type a value (in seconds) in the Sample Interval field or click on the Advanced button.
	9. Click in the check box next to Save History as Disk File or Save History in Memory Cache.
	10. If you decided to save history as a disk file, determine the file type (circular or text) and...
	11. If you decided to save history in memory cache, type the number of history data points in the...
	12. Complete this procedure with one of the following actions:


	Timex Editor
	FIGURE�7�35 Timex Editor
	Combining Timex Expressions
	To Create a Timex Expression Using the Cyclic and Comparison Tabs
	1. Click on the Advanced button in the History tab of the Attribute Editor for a data property.
	2. If any value is in the Time Expression field, highlight the value and delete it by clicking th...
	3. Click the Insert button.
	4. Determine the frequency for the history interval (FIGURE�7�36).
	a. Highlight the number field and click the up or down arrows until the number 1 is displayed.
	b. Highlight the units field and click the up or down arrows until hours is displayed.
	FIGURE�7�36 Setting a Cyclic Time of One Hour


	5. Click the Apply button.
	FIGURE�7�37 Timex Editor With Cyclic Time of One Hour

	6. Click the Insert button.
	7. Click the Comparison tab.
	8. Determine the start of the Time Range (Monday).
	a. Select Day_of_week from the left pull�down menu.
	b. Select Greater than or Equal from the middle pull�down menu.
	c. Select Monday from the right pull�down menu.
	FIGURE�7�38 Setting the Start Range to Monday


	9. Click the Apply button.
	FIGURE�7�39 Timex Editor Is Updated With a Start Range of Monday

	10. Determine the end of the Time Range by clicking the Insert button.
	11. Click on the Comparison tab of the Timex window.
	12. Determine the end of the Time Range (Friday).
	a. Select Day_of_week from the left pull�down menu.
	b. Select Less than or Equal from the middle pull�down menu.
	c. Select Friday from the right pull�down menu.
	FIGURE�7�40 Setting the End Range to Friday


	13. Click the Apply button.
	FIGURE�7�41 Timex Editor Showing a Cycle Time of One Hour From Monday to Friday

	14. Click the Apply button.
	FIGURE�7�42 Updated History Attribute Editor Showing a Cycle Time of One Hour From Monday to Friday


	To Create a Timex Expression Using the Absolute and Cron Tabs
	1. Click on the Advanced button in the Refresh tab of the Attribute Editor for a data property.
	2. If any value is in the Time Expression field, highlight the value and delete it by clicking th...
	3. Click the Insert button.
	4. Click the Absolute tab.
	5. Determine the start time (FIGURE�7�43).
	a. Highlight the hour, minute, and if desired, the seconds fields and click the up or down arrow ...
	b. Highlight the AM or PM field and click the up or down arrow to display your choice.

	6. Determine the start date. Highlight the month, date, and year fields and click the up or down ...
	FIGURE�7�43 Starting Time of 11:39:48 AM on January 1, 1999

	7. Click the Apply button.
	FIGURE�7�44 Timex Editor With Starting Time of 11:39:48 AM January 1, 1999

	8. Click the Insert button.
	9. Click the Cron tab.
	10. Select the time when the refresh interval is active.
	a. Select 0 from the Minute pull�down menu.
	b. Select 3rd from the hour pull�down menu.
	c. Select Every from the Day_of_month pull�down menu.
	d. Select Every from the Month pull�down menu.
	e. Select Monday from the final pull�down menu.
	FIGURE�7�45 Cron Tab Selected With 3 AM Every Monday


	11. Type -5 in the Current Timex field so that it reads Cron(03**1-5).
	FIGURE�7�46 Cron Tab Selected With 3 AM Every Monday Through Friday

	12. Click the Apply button.
	FIGURE�7�47 Timex Editor With Starting Time of 11:39:48 AM January 1, 1999 and 3 AM Every Monday ...

	13. Click the Apply button.
	FIGURE�7�48 Refresh Interval With Starting Time of 11:39:48 AM January 1, 1999 and 3 AM Every Mon...


	To Create an Alarm Schedule Using the Comparison Tab
	1. Click on the Advanced button in the Alarms tab of the Attribute Editor for a data property.
	2. If any value is in the Time Expression field, highlight the value and delete it by clicking th...
	3. Click the Insert button.
	4. Click the Comparison tab.
	5. Determine the start of the Time Range (9 AM).
	a. Select Hour from the left pull�down menu.
	b. Select Greater than or Equal from the middle pull�down menu.
	c. Select 9 from the right pull�down menu.
	FIGURE�7�49 Comparison Tab With Greater Than or Equal to 9 AM


	6. Click the Apply button.
	FIGURE�7�50 Timex Editor With Greater Than or Equal to 9 AM

	7. Determine the end of the Time Range by clicking the Insert button.
	8. Click on the Comparison tab of the Timex window.
	9. Determine the end of the Time Range (Friday).
	a. Select Hour from the left pull�down menu.
	b. Select Less than or Equal from the middle pull�down menu.
	c. Select 17 from the right pull�down menu.
	FIGURE�7�51 Comparison Tab With Less Than or Equal to 5 PM


	10. Click the Apply button.
	FIGURE�7�52 Timex Editor With Time Interval Between 9 AM and 5 PM

	11. Click the Apply button.
	FIGURE�7�53 Alarms Attribute Editor With Alarm Window From 9 AM to 5 PM Every Day
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	SyMON Modules
	Default Modules
	Module List
	TABLE�8�1 SyMON Modules�


	Loading Modules
	To Load a Module
	1. Select the module.
	2. Open the Load Module dialog by doing one of the following:
	FIGURE�8�1 Load Module Pop�Up Menu in Hierarchy View
	FIGURE�8�2 Load Module Pop�Up Menu in Topology View
	FIGURE�8�3 Load Module Menu in SyMON Main Console Window
	FIGURE�8�4 Load Module Menu in Details Window
	FIGURE�8�5 Load Module Dialog

	3. Click the name of the module you want to load.
	4. Click the OK button.
	FIGURE�8�6 Module Loader Dialog

	5. If necessary, type the relevant information into any editable name fields.
	6. Complete this procedure with one of the following actions:


	Editing Modules
	FIGURE�8�7 Edit Module Pop�Up Menu in Hierarchy View
	FIGURE�8�8 Edit Module Pop�Up Menu in Contents View
	FIGURE�8�9 Edit Module Menu in Details Window
	To Edit Module Parameters
	1. Select the selected module.
	2. Proceed with one of the following:
	3. Type the relevant information into the editable fields.
	FIGURE�8�10 Module Parameter Editor

	4. Complete this procedure with one of the following actions:

	To Disable a Module
	FIGURE�8�11 MIB-II Instrumentation Module Is Disabled

	To Enable a Module
	To Unload a Module
	1. Proceed with one of the following:
	FIGURE�8�12 Unload Module Dialog

	2. Click the Unload button to remove the module or the Cancel button to cancel this request.


	Monitoring Modules
	Attribute Editor for a Module
	Setting a Module Schedule
	To Set a Module Schedule
	1. Open the Attribute Editor for a module by proceeding with one of the following:
	2. Click the Schedule tab (FIGURE�8�13).
	3. Click the Advanced button and set the module schedule.
	4. Complete this procedure with one of the following actions:
	FIGURE�8�13 Setting a Module Schedule


	Setting Security Permissions for a Module
	To Set Security Permissions for a Module
	1. Open the Attribute Editor for a module by proceeding with one of the following:
	2. Click the Security tab (FIGURE�8�14).
	3. Type the name(s) of user and administrator groups in the appropriate fields.
	4. Complete this procedure with one of the following actions:
	FIGURE�8�14 Setting Module Security in the Attribute Editor
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	SyMON Alarms
	Types of Alarms
	FIGURE�9�1 Domain Status Summary in the Main Console Window
	FIGURE�9�2 Alarm Severities
	Down Alarms
	Critical Alarms
	Alert Alarms
	Caution Alarms
	Off/Disabled Alarms
	FIGURE�9�3 Objects with Irrational States Identified by Black Star or “Splat” Icon



	Creating Alarms
	Viewing Alarm Information
	Colored Alarm Icons
	FIGURE�9�4 Alarms in the Details Window
	FIGURE�9�5 Alarms in the Contents View

	Seeing Alarms in Domain Status Summary
	FIGURE�9�6 Domain Status Summary Buttons

	To Access Alarms from the Main Console Window
	1. Click on one of the Domain Status Summary buttons in the main console window. (FIGURE�9�6).
	2. Complete this procedure with one of the following actions:
	FIGURE�9�7 Domain Status Details Window



	Information on Alarms
	To Access Alarms from the Alarms Tab in the Details Window
	1. Click with your right mouse button on the selected host icon in the SyMON main console window ...
	2. Click on the Alarms tab button.
	FIGURE�9�8 Alarms Tab Data from the Details Window


	Alarm Categories
	TABLE�9�1 Alarm Categories Displayed in Table�
	TABLE�9�2 Alarm Categories Displayed When a Row is Selected

	Alarm States
	FIGURE�9�9 Open and Closed Alarms

	To View Alarm Categories
	1. Click on the Show button below the Table actions field.
	2. Click on the appropriate tab to filter your alarm request.
	3. Click on the Severity tab (FIGURE�9�2).
	4. Click on the check box next to a severity to show alarms of that severity.
	5. Click on the State tab (FIGURE�9�9).
	6. Click on Open or Closed to show these types of alarms.
	7. Click on the Acknowledge tab.
	8. Click on Acknowledged or Unacknowledged to show these types of alarms.
	9. Complete this procedure with one of the following actions:

	To Sort Alarms
	FIGURE�9�10 Sort Alarm Table
	1. Click on the Sort button below the Table actions field.
	2. Select your sort feature by clicking in the circle next to your selection.
	3. Complete this procedure with one of the following actions:

	To Reset the Alarm Table

	Acknowledging and Deleting Alarms
	To Acknowledge and Delete Alarms
	1. Select the alarms you want to update by clicking the selected row(s) in the table.
	2. Click the appropriate button under the Alarm actions field.
	TABLE�9�3 User Actions That Can Be Performed on Alarms



	Creating Alarm Conditions
	To Create Alarm Conditions To Monitor Hosts
	1. Navigate through the Operating System modules until you see the User Statistics icon (part of ...
	2. Select Attribute Editor from the pop-up menu.
	3. Create an alarm condition by following the procedure in “To Create an Alarm” on page�150.
	4. Click on the Alarms tab button in the Details window.
	5. Acknowledge, then delete this alarm if the alarm is closed.
	6. Create additional alarm conditions and familiarize yourself with their operation.
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	Details
	TABLE�10�1 Details Window Tab Buttons



	Starting the Details Window
	To Start the Details Window
	1. Double click the left mouse button on an object icon in either the hierarchy view or the topol...
	FIGURE�10�1 Details Window for a Selected Object

	2. Click a tab to view detailed information for that category.
	FIGURE�10�2 Light�Colored Circles “Unroll” to Provide Additional Levels of Detail


	To Close the Details Window.

	Info Tab
	TABLE�10�2 General Properties in the Info Tab of the Details Window

	Browser Tab
	Alarms Tab
	Processes Tab
	FIGURE�10�3 Processes Tab
	Configuring the Process Display
	Selecting Columns for Viewing
	1. Click the View Columns button above the Process table to display the View Columns pull-down menu.
	FIGURE�10�4 View Columns Menu

	2. Highlight one or more process properties that you want to display.
	TABLE�10�3 Process Viewer Properties�


	Sorting Columns
	To Sort Columns in Ascending Order
	To Sort Columns in Descending Order
	Moving Columns
	To Reorder Columns in the Table
	1. Select a column by clicking and holding down the mouse button on the table column header.
	2. Drag the column to the desired position.


	Process Statistics Window
	TABLE�10�4 Process Statistics

	Process Summary Field

	Log View Tab
	FIGURE�10�5 Logview Tab
	Log File Type Button
	To View the Log File Messages
	Filtering Your Messages
	To Filter Your Log Request
	1. Click the Filter button in the log viewer (FIGURE�10�5).
	FIGURE�10�6 Message Filter Options Dialog

	2. Using the down arrows, select the starting date by highlighting the month, day, and year for t...
	3. Select the starting time by using the down arrows.
	4. Select the ending date.
	5. Select the ending time.
	6. Type the text pattern to be matched in the field marked “Text pattern to match.”
	7. Click the Advanced button if you want to further refine your filter request. Otherwise, skip t...
	FIGURE�10�7 Advanced Message Filter Options Dialog

	8. To display filtered messages in ascending or descending order click the circle next to Forward...
	9. (Optional) Type the maximum number of log messages that should be matched in the field marked ...
	10. Complete this procedure with one of the following actions:


	Reload Button
	Monitor Button
	To Monitor Log Messages
	1. Click the Monitor button in the log viewer (FIGURE�10�5).
	FIGURE�10�8 Monitor Filter Options Dialog

	2. Click the appropriate circle to enable or disable log file monitoring.
	3. To display only currently monitored log messages, click the check box to clear old monitored m...
	4. Type the text pattern to be matched in the field marked Text pattern to match.
	5. Complete this procedure with one of the following actions:


	Finding Specific Log Messages
	To Find a Log Message
	1. Type the specific character sequence (part of the log message) in the Find field (FIGURE�10�5).
	2. Click Return or the down or up arrow to search the log messages for that sequence.
	3. Click Return or the down or up arrow to continue your search and find additional occurrences o...



	Configuration Tab
	FIGURE�10�9 Configuration Details Window
	To View a Configuration
	Resources
	TABLE�10�5 Resources

	Physical View
	FIGURE�10�10 Configuration Physical View
	View Points
	FIGURE�10�11 Component Physical View

	Dynamic Reconfiguration
	FIGURE�10�12 Dynamic Reconfiguration Window

	Show Details
	FIGURE�10�13 Property/Value View


	Logical View
	FIGURE�10�14 Configuration Logical View
	Search
	FIGURE�10�15 Search Window

	Dynamic Reconfiguration
	Show Details
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	SyMON Security



	Access Control (ACL) Categories
	SyMON Users
	Public and Private Users
	General Users
	SyMON Superuser


	SyMON Groups
	SyMON OPeratorS or esops
	SyMON ADMinistrators or esadm
	SyMON DOMain ADMinistrators or esdomadm

	Admin, Operator, and General Functions
	TABLE�11�1 Domain Admin, Admin, Operator, and General Functions�


	Specifying Access Control (ACL)
	Admin, Operator, and General Access
	SyMON Remote Server Access
	SyMON Server Context
	FIGURE�11�1 Remote Server Context

	Limitations While Crossing Servers


	Using Access Control (ACL)
	To Add SyMON Users
	1. Become superuser (on the SyMON server host).
	2. Edit the file /var/opt/SUNWsymon/cfg/esusers. Make sure that the user name is that of a valid ...
	3. Add the user name on a new line.
	4. Save the file and exit the editor.

	To Access ACL on a Module
	1. Proceed with one of the following:
	2. Select the Security tab within the Attribute Editor window (FIGURE�11�2).
	3. Change the values as required.
	FIGURE�11�2 Example of Security Fields in the Attribute Editor
	TABLE�11�2 Security Attributes


	To Add a User-Defined Group to an ACL
	1. Become superuser.
	2. Create a group:
	3. Add users to the newly created group:
	a. Edit the /etc/group file.
	b. Add users to the group.
	c. Save the file and exit the editor.

	4. Add the new group to the ACL of interest.

	To Grant a User esadm, esops, or esdomadm Privileges
	1. Become superuser.
	2. Make sure that the user is a valid SyMON user.
	3. Edit the /etc/group file.
	4. Add the user to one of the following lines as applicable: esadm, esops, or esdomadm.
	5. Save the file and exit the editor.

	To Delete SyMON Users
	1. Become superuser on the SyMON server host.
	2. Edit the file /var/opt/SUNWsymon/cfg/esusers.
	3. Delete the line corresponding to the user name you want to delete.
	4. Save the file and exit the editor.
	5. Delete the user names from additional SyMON groups.


	Default Privileges
	Topology Manager Default Privileges
	TABLE�11�3 Default Privileges for Topology Manager

	Other SyMON Component and Module Default Privileges
	TABLE�11�4 SyMON Component and Module Default Privileges


	Overriding the Default Privileges
	To Override Default Privileges
	A
	Getting Started With SyMON
	TABLE�A�1 Example Use of SyMON Software�
	B

	Miscellaneous SyMON Procedures


	Regenerating Security Keys
	To Regenerate the Security Keys
	1. Log in as root.
	2. Depending on your installation, type one of the following.
	3. Restart the SyMON server.


	Configuring a Legacy SNMP Agent as a Subagent of a SyMON Agent
	To Configure a Legacy SNMP Agent as a Subagent of a SyMON Agent
	1. Log in as root.
	2. If the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x does not exist, copy it from the /opt...
	3. In the file /var/opt/SUNWsymon/cfg/subagent-registry-d.x, find the block that is similar to CO...
	CODE�EXAMPLE�B�1 Before Editing Registry file�

	4. Remove the comment symbol at the beginning of the line (#) so that the code looks like CODE�EX...
	CODE�EXAMPLE�B�2 After Removing the Comment Symbol in the Registry file�

	5. Modify the lines as follows:
	a. Change sa2 to the unique subagent name for the agent.
	b. type is legacy.
	c. persist is false if the subagent is stopped when the SyMON agent exits. If this value is true,...
	d. snmpPort is the UDP port number on which you want to run the subagent.
	e. errorAction can be restart, ignore, or kill. If the restart option is used, then the SyMON age...
	f. startCommand is the mandatory command to start the subagent. This command should contain %port...
	g. stopCommand is the command to stop the process. %pid can be used to represent the process ID (...
	h. pollInterval defines the time (in seconds) in which the SyMON agent polls the subagent.
	i. pollHoldoff is the time (in seconds) after which the first poll is done on the subagent after ...
	j. oidTrees gives the space�separated list of SNMP OIDs managed by the subagent.
	k. snmpVersion can take values SNMPv1 and SNMPv2.
	l. securityLevel can be priv, auth, or noauth.
	m. securityName is the SNMPv1 community name or SNMPv2 security name to use.

	6. Stop then restart the agent:


	Configuring SyMON to Use Different Port Addresses
	To Determine if a Port Is Used
	TABLE�B�1 SyMON Default Port Addresses

	To Reconfigure SyMON to Use Nondefault Port Addresses
	1. Run the es-setup script to create the domain-config.x and server�config.x (server configuratio...
	2. Edit these files with the new port numbers.

	To Reconfigure SyMON SNMP Port Addresses
	1. Log in as root.
	2. Edit the domain-config.x file and change the address port to an unused port.
	3. Save the file.

	To Reconfigure SyMON RMI Port Address
	1. Log in as root.
	2. Edit the /var/opt/SUNWsymon/cfg/server-config.x file.
	3. Search for the block which starts with rmiReceptor.
	4. Uncomment the line that reads property:rmiPort = 2099 by deleting the pound (#) character.
	5. Change the address port to a new unused port number.
	6. Save the file.


	Monitoring Topology Manager and Event Manager
	To Create a Server Component as a Monitored Object
	1. In the SyMON main console window, select Edit ‰ Create an Object.
	2. Click the Node tab.
	3. Click the Monitor Via button to see the pull-down menu, then select SyMON Agent - Host.
	4. Type the name of the server component in the Node Label field.
	5. (Optional) Enter a description of the node.
	6. Enter the name of the SyMON server in the Hostname field.
	7. Type the port number for the server component in the Port field (FIGURE�B�1).
	8. Complete this procedure with one of the following actions:
	FIGURE�B�1 Creating a Server Component as a Monitored Object


	Topology Manager
	To Increase the Critical Threshold for the Virtual Size Data Property.
	1. Create the Topology manager monitored object.
	2. Open the Details window and proceed with one of the following:
	3. In the Browser Details window, double�click on the Local Applications icon in the hierarchy (t...
	4. Double�click on the Agent Statistics icon in the contents view or single click in the light�co...
	5. Double�click on the PA Process Statistics folder icon in either the hierarchy or the contents ...
	FIGURE�B�2 PA Process Statistics Property Table

	6. Select the Virtual Size table cell, then proceed with one of the following:
	7. Click on the Alarms tab button.
	8. Type the desired value in the Critical Threshold (>) field.
	9. Complete this procedure with one of the following actions:
	FIGURE�B�3 Alarms Tab for the Virtual Size Property in the Topology Manager Object


	Event Manager
	FIGURE�B�4 Event Management Module Data Properties

	To Change the Default Values for Smart Delete in the Event Manager
	1. Create the Event manager monitored object.
	2. Open the Details window by proceeding with one of the following:
	3. In the Browser Details window, double�click on the Local Applications icon in the hierarchy (t...
	4. Select the Event Management module and proceed with one of the following:
	5. Type the new time values into the editable fields.
	6. Alternately, you may turn off “smart delete” by selecting Disabled in the pull�down menu next ...
	7. Complete this procedure with one of the following actions:
	FIGURE�B�5 Module Parameter Editor for the Event Management Module



	Reading SyMON Log Files
	To Use ccat to Read SyMON Log Files
	To Use ctail to Read SyMON Log Files
	C
	SyMON Modules
	TABLE�C�1 Modules Loaded Automatically, Multiple Times, and Use ‘Add Row’ Operation



	Hardware
	Config-Reader Module
	Config-Reader Top-Level Property Tables
	Board Table
	TABLE�C�2 Board Properties�

	CPU Unit Table
	TABLE�C�3 CPU Unit Properties�

	SIMM Table
	TABLE�C�4 SIMM Properties

	Peripheral PS Table
	TABLE�C�5 Peripheral PS Properties

	Power Supply Table
	TABLE�C�6 Power Supply Properties�

	FHC Table
	TABLE�C�7 FHC Properties�

	AC Table
	TABLE�C�8 AC Properties�

	Fan Table
	TABLE�C�9 Fan Properties

	Environment Table
	TABLE�C�10 Environment Properties�

	I/O Controllers Table
	TABLE�C�11 I/O Controllers Properties�

	I/O Devices Table
	TABLE�C�12 I/O Devices Properties

	Disk Devices Table
	TABLE�C�13 Disk Devices Properties

	Tape Devices Table
	TABLE�C�14 Tape Devices Properties

	Network Devices Table
	TABLE�C�15 Network Devices Properties


	Config-Reader Managed Object Tables
	TABLE�C�16 Config-Reader Managed Objects �
	System Table
	TABLE�C�17 System Properties

	AC PS Table
	TABLE�C�18 AC PS Properties

	Hot-Plug Charges Table
	TABLE�C�19 Hot-Plug Properties

	Auxiliary 5V Table
	TABLE�C�20 Auxiliary 5V Properties

	Peripheral 5V, Peripheral 12V, System 3V, and System 5V Table
	TABLE�C�21 Common Peripheral and System Properties

	Keyswitch Table
	TABLE�C�22 Keyswitch Properties

	Remote Console Table
	TABLE�C�23 Remote Console Properties

	PFA Rules Table
	TABLE�C�24 PFA Rules Properties




	Operating System
	Directory Size Monitoring Module
	Directory Monitoring Status Table
	TABLE�C�25 Directory Size Monitoring Properties


	File Monitoring Module
	File Monitoring Status Table
	TABLE�C�26 File Monitoring Properties �


	MIB-II Instrumentation Module
	MIB-II System Group Table
	TABLE�C�27 MIB-II System Group Properties�

	MIB-II Interfaces Group Tables
	MIB-II Interfaces Group Table
	TABLE�C�28 MIB-II Interfaces Group Properties�

	MIB-II Interface Table
	TABLE�C�29 MIB-II Interface Properties�


	MIB-II IP Group Table
	MIB-II Group Table
	TABLE�C�30 MIB-II Group Properties�

	IP Address Table
	TABLE�C�31 IP Addresses Properties�

	IP Route Table
	TABLE�C�32 IP Route Properties�

	IP NetToMedia Table
	TABLE�C�33 IP NetToMedia Properties


	MIB-II ICMP Group Table
	TABLE�C�34 MIB-II ICMP Group Properties�

	MIB-II TCP Group Tables
	MIB-II TCP Group Table
	TABLE�C�35 MIB-II TCP Group Properties�

	TCP Connections Table
	TABLE�C�36 TCP Connections Properties�


	MIB-II UDP Group Tables
	MIB-II UDP Group Table
	TABLE�C�37 MIB-II UDP Group Properties�

	UDP Table
	TABLE�C�38 UDP Properties



	Kernel Reader Module
	TABLE�C�39 Kernel Reader Alarm Thresholds�
	Disk Statistics Managed Objects Tables
	TABLE�C�40 Disk Statistics Parameters�
	Disk Details Table
	TABLE�C�41 Disk Details Properties�

	Disk Service Time Table
	TABLE�C�42 Disk Service Time Properties�


	Filesystem Usage Table
	TABLE�C�43 Filesystem Usage Properties�

	User Statistics Table
	TABLE�C�44 Solaris User Statistics Properties�

	System Load Statistics Table
	TABLE�C�45 System Load Statistics Properties

	CPU Statistics Managed Object Tables
	CPU Utilization Table
	TABLE�C�46 CPU Usage Properties

	CPU I/O Table
	TABLE�C�47 CPU I/O Properties�

	CPU Interrupts Table
	TABLE�C�48 CPU Interrupts Properties

	CPU Systemcall Table
	TABLE�C�49 CPU Systemcall Properties�

	CPU Misc Table
	TABLE�C�50 CPU Miscellaneous Properties

	CPU Regwindow Table
	TABLE�C�51 CPU Regwindow Properties

	CPU Pageinfo Table
	TABLE�C�52 CPU Pageinfo Properties�

	CPU Faults Table
	TABLE�C�53 CPU Faults Properties�


	Memory Usage Statistics Table
	TABLE�C�54 Memory Usage Statistics Properties�

	Swap Statistics Table
	TABLE�C�55 Swap Statistics Properties

	Streams Statistics Managed Objects Table
	TABLE�C�56 Streams Statistics Managed Objects
	TABLE�C�57 Streams Statistics Table Properties�

	Software Rules Table
	TABLE�C�58 Software Rules Properties


	NFS Statistics Module
	RPC Information Table
	TABLE�C�59 RPC Server and Client Information Properties

	NFS Information Table
	TABLE�C�60 NFS Server and Client Information Properties


	Solaris Process Details Module
	TABLE�C�61 Solaris Process Details Parameters
	Process Table
	TABLE�C�62 Process Properties�


	NFS File Systems Module
	File System Usage Table
	TABLE�C�63 Filesystem Usage Properties�



	Local Applications
	Agent Statistics Module
	TABLE�C�64 Agent Statistics Main Sections�
	TABLE�C�65 Agent Statistics Section Properties�
	TABLE�C�66 Agent Statistics Alarm Thresholds�
	Object Statistics Table
	TABLE�C�67 Object Statistics Properties�

	Commands Executed Table
	TABLE�C�68 Executed Commands Properties�

	Transactions Performed Table
	TABLE�C�69 Transactions Performed Properties�

	PA Process Statistics Table
	TABLE�C�70 PA Process Statistics�Properties�

	PA Total Process Statistics Table
	TABLE�C�71 Total PA Process Statistics Properties�


	Data Logging Registry Module
	Registry Table
	TABLE�C�72 Data Logging Registry�Properties�


	Dynamic Reconfiguration Module
	Dynamic Reconfiguration Table
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